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This application may contain a binary form of the Info-ZIP tool to create .zip files. That source code is provided under
the following license:
This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its
contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the
use of or inability to use this software.
Permission is granted to anyone to use this software for any purpose, including commercial applications, and to
alter it and redistribute it freely, subject to the following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this list of
conditions.

2. Redistributions in binary form must reproduce the above copyright notice, definition, disclaimer, and this list
of conditions in documentation and/or other materials provided with the distribution.

3. Altered versions — including, but not limited to, ports to new operating systems, existing ports with new
graphical interfaces, and dynamic, shared, or static library versions — must be plainly marked as such and
must not be misrepresented as being the original source. Such altered versions also must not be mis-
represented as being Info-ZIP releases — including, but not limited to, labeling of the altered versions with
the names "Info-ZIP" (or any variation thereof, including, but not limited to, different capitalizations), "Pocket
UnZip," "WiZ" or "MacZip" without the explicit permission of Info-ZIP. Such altered versions are further pro-
hibited from misrepresentative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "WiZ," "Pocket UnZip," "Pocket Zip," and
"MacZip" for its own source and binary releases

Copyright

The software described in thismanual is furnished under a license agreement andmay be used or
copied only in accordance with the terms of the agreement.
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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and service
conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any instrument or
defective parts when returned prepaid to us and which our examination discloses to have been defective. The purchaser is
responsible for all transportation charges involving the shipment of materials for warranty repairs. Failure of any instrument
or product due to operator error, improper installation, unauthorized repair or alteration, failure of utilities, or environmental
contamination will not constitute a warranty claim. The materials of construction used in MICROMERITICS instruments and
other products were chosen after extensive testing and experience for their reliability and durability. However, these
materials cannot be totally guaranteed against wear and/or decomposition by chemical action (corrosion) as a result of
normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization to
return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are made by
persons other than its own authorized service personnel unless such work is authorized in writing by MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their respective
brand names or trade names. We, therefore, make no express or implied warranty as to such products. We shall use
our best efforts to obtain from the manufacturer, in accordance with his customary practice, the repair or replacement
of such of his products that may prove defective in workmanship or materials. Service charges made by such man-
ufacturer are the responsibility of the ultimate purchaser. This states our entire liability in respect to such products,
except as an authorized person of MICROMERITICS may otherwise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the discretion of
MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and stems,
seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such items which
perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of manufacturing
defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its products
other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including but not
limited to, the implied warranties of merchantability or fitness for use.

Warranty
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Contact Us

CONTACT US
Micromeritics Instrument Corporation

4356 CommunicationsDrive
Norcross, GA / USA / 30093-2901
Phone: 1-770-662-3636
Fax: 1-770-662-3696

www.Micromeritics.com

---------------

U.S. Inquiries

U.S. Sales Phone: 1-770-662-3636

USSales@Micromeritics.com

---------------

Quotes, Orders, and Customer Satisfaction

Customer Service Phone: 1-770-662-3636

Orders@Micromeritics.com

---------------

U.S. Instrument Service Department

U.S. Service Department Phone: 1-770-662-3666

Service.Helpdesk@Micromeritics.com

---------------

Micromeritics Scientific Services

Customer Support Portal

http://techsupport.micromeritics.com/portal
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ABOUT THIS MANUAL

Log in to your customer portal to access the following:

l Calculations
l Error Messages
l MicroActive AutoChemHP 2950Operator Manual in PDF format

Parts and accessories can be found online at www.Micromeritics.com.

The following iconsmay be found in thismanual:

NOTE - Notes contain important information applicable to the topic.

CAUTION - Cautions contain information to help prevent actions that may damage the
analyzer or components.

WARNING - Warnings contain information to help prevent actions that may cause per-
sonal injury.

About thisManual
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1 ANALYZER COMPONENTS

Component Description
Septum port (Not shown. Located behind the optional CryoCooler.) To inject

gas into an analysis.
A Cold trap dewar and

stand
Allows trapping of condensibles in the gas flowing from the sample
before it reaches the thermal conductivity detector. A delay loop or
dryer may also be attached.

B LED lights Indicates the communication between the analyzer and the
computer.

l Red - Indicates a fault. Illuminateswhen there is no com-
munication with the computer. When the analyzer application is
exited, the red and the Attention! LED illuminate.

l Green - Indicates normal communication.
l Attention! - When blinking, indicates that operator attention is
required. Check the computer screen for instructions. This light
blinks if aWait step requiring operator action was included in
the experiment steps. After performing the requested action,
clickOK. The blinking stops.

C KwikCool Ramps the furnace temperature rapidly to near ambient, reducing
analysis time and increasing throughput.

D CryoCooler Can be used to speed throughput by ramping the furnace tem-
perature rapidly to ambient after an analysis.

E Furnace Controls the temperature of the sample.

F Shelf track Holds a shelf to support the cold trap dewar when a dewar stand is
not used. Shelf is not shown.

1 Analyzer Components

MicroActive AutoChemHP 2950Operator Manual
295-42830-01 (Rev -) — Jan 2018 1 - 1



1 Analyzer Components

Component Description
G Gas exhaust ports For attachment of appropriate exhaust systems tomeet local

safety standards for chemisorption exhaust.
H Mass spectrometer

port
To attach an optional mass spectrometer.

I Gas inlet ports For preparation, carrier, and loop gases.

EQUIPMENT OPTIONS AND UPGRADES
Parts and accessories can be found online at www.Micromeritics.com.

Equipment Option Description
CryoCooler Analyses can be started at subambient temperatures. The CryoCooler

can be used to speed throughput by ramping the furnace temperature
rapidly to ambient after an analysis.

KwikCool The standard version ramps the furnace temperature rapidly to near
ambient, reducing analysis time and increasing throughput. The Vortex
KwikCool version uses compressed air to chill the air for cooling
without a dewar.

GAS REQUIREMENTS
Compressed gases are required for analyses. Gas cylinders or an outlet from a central source
should be located near the analyzer.

Appropriate two-stage regulators which have been leak-checked and specially cleaned are required.
Pressure relief valves should be set to nomore than 30 psig (200 kPag). All gases should be of a
purity of 99.999% or better. Gas regulators can be ordered fromMicromeritics.

Parts and accessories can be found online at www.Micromeritics.com.

1 - 2 MicroActive AutoChemHP 2950Operator Manual
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SPECIFICATIONS FOR THE AUTOCHEM HP 2950

Specification Description
Electrical

Voltage 85 to 265 VAC

Frequency 50 to 60 Hz

Power 1100 VA, operating, maximum

Environment
Temperature 15 to 35 °C, operating

0 to 50 °C, non-operating
Humidity 20 to 80% relative, noncondensing

Gas Delivery
Inlet ports 4 each for preparation gas, carrier gas, and loop (analysis) gas

Temperature control Internal gas lines and valves can be heated up to 150 °C

Gas Flow Rate
All Mass Flow Controllers (MFC)
Manual control 0 - 100 STD cm3/min. for nitrogen. Other gases have a different range.

Automatic analysis 0 - 100 STD cm3/min.

Pressure specifications Atmospheric to 1000 psa
Accurate to 0.1% of full scale

Gases
H2, CO, O2, N2O, NH3 (maximum15%NH3 in helium), and others compatible with 316 SS.

Physical
Height 24.5 in. (62.2 cm)

Width 26.0 in. (66 cm)

Depth 22.75 (58 cm)

Weight 130 lbs (59 kg)

Specifications for the AutoChemHP 2950
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1 Analyzer Components

Specification Description
Sample Tube

Metal FlowThru tubes* For use up to 850 ºC, 316 SS,

Sample size. 0.3 inches diameter (7.5mm) by 1.5 inches (40mm)

Material.Up to 1000 psia
Fused quartz FlowThru
tubes

For use up to 1100 ºC

Sample size.Powders and pellets up to 9mm in diameter

Material.Atmospheric pressure only
* Publishedmaterial specifications, which include design safety factors, limit these tubes to
650 ºC and 1000 psia. However, extensive testing at 850 ºC and 1000 psia of numerous tubes
of identical design andmaterial have resulted in no failures. Additionally, as a safetymeasure,
the tube in operation is enclosed in a clam-shell furnace. The furnace incorporates a limit switch
which cuts the current and releases the pressure if opened to the point of switch actuation.
Reactive gases and reaction products, the nature of which cannot be anticipated by
Micromeritics, can corrode or embrittle any steel. The user is advised to examine each tube
after use and discard any that might appear questionable. It is also essential for maximum
safety that, whenever tubes are at elevated pressure even at ambient temperature, the furnace
be in place and closed should a failure occur.

Temperature System
Range Standard pressure (up to slightly above atmospheric pressure) in

quartz sample tubes:

l -100 to 1100 ºC (with optional CryoCooler)
l Ambient to 1100 ºC (without CryoCooler)

High Pressure (up to 1000 psia) in stainless steel sample tubes:

l -100 to 850 ºC (with optional CryoCooler)
l Ambient to 850 ºC (without CryoCooler)

Selection Digitally set, 1 °C increments

Ramp rates Up to 50 °C per minute within -70 to 500 °C range
Up to 30 °C per minute within 500 to 750 °C range
Up to 10 °C per minute within 750 to 1100 °C range

1 - 4 MicroActive AutoChemHP 2950Operator Manual
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Specification Description
Wetted Materials

Standard System

l Stainless steel
l Gold plated nickel/iron (filaments)
l Kalrez® or Chemraz® (most O-ring seals)
l Quartz (sample tubes, thermocouple sheath)
l Quartz wool (supports sample in tube)
l Inconel® - sheathed sample thermocouple (can be placed outside tube or sheathed in quartz)
l PEEK (Poly Ether Ether Ketone - some ferrules)
l Teflon® tubing (most exhaust lines); TCD exhaust is stainless steel for connection of external
devices

l Copper (gas supply lines and BET delay path)
l Nickel plated brass and steel (gas inlet valves)
l Viton® (seals insidemass flow controllers)
l Polyaryletherketone/PTFE composite (rotary valves seals)
l Silicone/Teflon sandwich (septum)

System with Enhanced Chemical Resistant Option

Same as standard system except stainless steel manifolds are protected from corrosion with vapor
deposited Silcolloy by Silcotek®, Stainless-steel tubing, fittings, ferrules and rotary valves are
replaced byHastelloy-C® versions, Kalrez is used for all O-ring seals and the seals inside themass
flow controllers, stainless-steel grade 316 gas supply lines, stainless-steel gas inlet valveswith
Kalrez or Chemraz seals.

Specifications for the AutoChemHP 2950

MicroActive AutoChemHP 2950Operator Manual
295-42830-01 (Rev -) — Jan 2018 1 - 5



1 Analyzer Components

Specification Description
Computer Requirements

l Operating System. Windows 7 Professional or higher operating system is recommended for
the best user experience.

l Desktop Installation Required. The application should not be installed on a network drive
with shared access. Multiple users cannot operate the application at the same time.

l 10 Base T or 100 Base T Ethernet Port. If the computer is to be connected to a network, two
Ethernet ports are required. If more than one Ethernet based unit is connected to the same com-
puter, an Ethernet switch will also be required.

l Read / Write Permissions. All users of the application will need Read/Write permission to all
directories and subdirectories where the application is installed.

l Drives.CD-ROMdrive and thumb drive.

In keeping with a policy of ongoing product improvement, specifications are subject to change
without notice.

1 - 6 MicroActive AutoChemHP 2950Operator Manual
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2 ABOUT THE SOFTWARE

Report options can be specified when creating the sample file. When running an analysis, data
gathered during the analysis process are compiled into the predefined reports. Reports can also be
defined and generated after an analysis has been run. Each selected report is displayed on its own
tab and reflects data collected during the analysis.

TheMicroActive feature offers aWindows interface with an easyway to collect, organize, archive,
reduce raw data, and store sample files for later use. Scalable and editable graphs, and copy and
paste graphics, are easily generated. Customized reports can be generated to screen, paper, or
exported for use in other programs.

In addition to customizable standard reports, user defined calculations and reports can be created
through the Advanced reports feature (using Python).

Data can bemanipulated and displayed interactively usingMicroActive reports.

PEAK EDITOR FOR DYNAMIC ANALYSIS

See also:

Peak Editor on page 6 - 3

The TCD (Thermal Conductivity Detector) features a Peak Editor which allows the evaluation of
results, peak editing, and reports. Adjusting peak boundaries can be used to eliminate baseline noise
or other undesirable effects. The Peak Editor also allows the separation of composite peaks.

2 About the Software
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2 About the Software

SOFTWARE SETUP

If the computer is to be connected to a network, a second Ethernet port on the computer
must be used for that purpose.

TheSetup program is located on the installationmedia and is used to reinstall the software and
make analyzer changes— such as adding or removing a unit, etc.

SOFTWARE UPDATES
Log in to your customer portal to access and download the latest analyzer software version.

Insert the setupmedia into themedia drive. The setup program starts automatically. If the program
does not start automatically, navigate to the installationmedia drive, locate and double click the
setup.exe file.

UNINSTALL THE SOFTWARE

When the software is uninstalled, only the files required to run the application are removed.
Parameter files, sample files, reports, calibration files, and data files are not removed.

To uninstall the software, double click the uninstall.EXE file located in the software installation
directory, then follow the screen prompts.

2 - 2 MicroActive AutoChemHP 2950Operator Manual
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MENU STRUCTURE
All program functions use standardWindowsmenu functionality. The title bar contains aUnit
Number. If multiple units (analyzers) are installed, ensure the appropriate unit is selected before
continuing.

Option Description
File Use tomanage files used by the application— such as sample files, ana-

lysis conditions files, report options files, etc.
Unit [n] Use to perform analyses, calibrations, and other analyzer operations.Unit

[n] displays on themenu bar for each analyzer attached to the computer.
Reports Use to run reports and view the results.

Options Use to edit the default method, specify system configuration, specify units,
and change presentation options.

Window Use tomanage open windows and display a list of open windows. A check-
mark appears to the left of the active window.

Help Provides access to the online operator manual, theMicromeritics web
page, the analyzer web page, and information about the application.

Main Menu Bar Options

Menu Structure

MicroActive AutoChemHP 2950Operator Manual
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2 About the Software

COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located inmultiple windows throughout the analyzer
application and have the same description or function. Fields and button descriptions not listed in this
table are found in tables in their respective sections.

Field or Button Description
Add Add an item to the list.

Add Log Entry Use to enter information to appear in the sample log report that cannot
be recorded automatically through the application. Click the button
again to enter multiple log entries.

Append Use to insert one row at the end of a table.

Autoscale When enabled on report parameters windows, allows the x- and y-
axes to be scaled automatically.Autoscalemeans that the x- and y-
rangeswill be set so that all the data is shown. If Autoscale is not selec-
ted, the entered range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code Enter bar code reader information if a bar code reader is connected to
the computer’s USB port. If a bar code reader is not used, this alpha-
numeric field can be used to enter additional information about the
sample, such as a sample lot number, sample ID, etc. This field label
may be changed by the user.

Browse Searches for a file.

Cancel Discards any changes or cancels the current process.

Clear Use to clear the table entries and display only one default value.

Close Closes the active window.

Close All Closes all active windows. If changesweremade and not yet saved, a
prompt displays for each changed file providing the option to save the
file.

Comments Enter comments about the sample or analysis. Comments display in
the report header.

Copies Select the number of copies to print. This field is only enabled when
Print is selected.

Delete Whenworking with pressure tables and pressures,Delete removes
the selected information.

Common Fields and Buttons Table
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Field or Button Description
Destination Select the report destination.

Edit Whenworking with report parameters, highlight the item in theSelec-
ted Reports list box and clickEdit to modify the report details.

Exit Exits the application. If a file is open with unsaved changes, a prompt
displays providing the option to save the changes and exit or to exit the
application without saving the changes.

Export Exports data in a sample file as a .REP, .TXT or .XLS file. When saved
to a file, the data can be imported into other applications.

File Select the destination directory. Enter a new file name in the File name
field, or accept the default. Select to save the file as a report system
(.REP), a spreadsheet (.XLS), a portable document format (.PDF), or
an ASCII text (.TXT) file format.

File name Select a file name from the list shown or enter a file name. If the
required file type is not shown, select the type of file from the list.

From / To Whenworking with report parameters windows, enter the From and
To range for x- and/or y-axes.

Insert Use to insert one row above the selected row in the table.

List Creates a list of sample or other type files. The list will contain file
name, date / time the file was created or last edited, file identification,
and file status.

Name column A list of files in the selected directory or library.

Next Click tomove to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double click the file name in the
Name column to open the file.

Prev Click tomove to the previouswindow.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Print Sends the report to the selected destination (screen, printer or file).

Remove Remove the selected file or files from the list.

Replace Click to select another file where the valueswill replace the current
file’s values.

Replace All Click to select another .SMP file where the valueswill replace all val-
ues for the active sample file. The original file will remain unchanged.

Common Fields and Buttons Table (continued)

Common Fields and Buttons
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2 About the Software

Field or Button Description
Report Click to display a window to specify report output options.

Save Saves changes to the active window.

Save As Saves a file in the active window under a different file name.

Start Starts the report, test, analysis, or operation.

Start Date Displays a calendar to select the start date for the report.

View Operation. Use to display the data from the current analysis.

Instrument Log. Use to display recent analyses, calibrations, errors,
or messages.

Instrument Schematic. Use to display a schematic of the analyzer
system.

Common Fields and Buttons Table (continued)
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FILE STATUS, DESCRIPTION, EXTENSION, AND LOCATION
In the File Selectorwindow, theMicDescription column and theMic Status column display file
description and file status. The File Selector incorporates standardWindows features for resizing
windows, reordering and repositioning columns, and right clicking an entry to display amenu of
standardWindows functions.

File Status Description
Analyzing Sample files that are currently being used for analysis.

Complete Sample files used in an analysis that has been completed.

No Analysis Sample files which have not been used to perform an analysis.

File Status and Description Table

File Type File Name
Extension

Default Location

Analysis Conditions .ANC Param directory

Calibration .CAL

Methods .MTH Param directory

Report Options .RPO Param directory

Sample File .SMP Data directory

File Type, Extension, and Location Table

File types available when printing or exporting reports:
Portable document format .PDF

Report .REP

Spreadsheet .XLS

Unicode .TXT

Extensible markup language .XML

File Status, Description, Extension, and Location
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2 About the Software

KEYBOARD SHORTCUTS
Shortcut keys can be used to activate somemenu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of themenu item.

Certain menus or functions can also be accessed using theAlt key plus the underlined letter in the
menu command. For example:

l to access the Filemenu, pressAlt + F, then press the underlined letter on the submenu
l Alt + F opens the Filemenu, then pressO to access the File Selector

If the underscore does not display beneath the letter on themenu or window, press the
Alt key on the keyboard.

Field or Button Description
Alt +[Unit n] Opens the Unit [n]menu.

Alt + F Opens the Filemenu.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to save
changes displays.

Alt + H Opens theHelpmenu.

Alt + I Opens theOptionsmenu.

Alt + R Opens theReportsmenu.

Alt + W Opens theWindowmenu.

Shift + F9 Opens the shortcut menu of (1) selected component on analyzer schematic
whenmanual control is enabled or (2) onscreen reports.

Ctrl + N Opens a new sample file.

Ctrl + O Opens the File Selector.

Ctrl + P Opens the File Selector to start a report from a selected .SMP file.

Ctrl + S Saves the open file.

F1 Opens the online help operator manual.

F2 Displays the File Selectorwindow.

F3 When in the File Selectorwindow, opens the file search box.

F4 When in the File Selectorwindow, opens the address bar.

Keyboard Shortcut Table
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Field or Button Description
F6 Cascades open windows.

F7 Tiles open windows.

F8 Opens the File Selector to start a report from a selected .SMP file.

F9 Closes all open reports.

Keyboard Shortcut Table (continued)

Keyboard Shortcuts
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2 About the Software

OPTION PRESENTATION
Options > Option Presentation
Use to change the way sample files and parameter files display:Advanced, Basic, orRestricted.
Each display option shows sample information and options differently.

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic Displays sample in a single window. This display option is used after

the parameter files have been created. The previously entered or
default parameter files are then accessible using drop-down lists.

Restricted Displays the sample file in a single window similar to theBasic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same passwordmust be entered to
change to theBasic or Advanced display option. This display type is
typically used in laboratories where analysis conditionsmust remain
constant— such as the pharmaceutical industry. TheAdvanced option
is not available at the bottom of the window when using theRestricted
display option.

Always Open Edit View Opens files with aComplete status in tabbed file editor rather than in
the Peak Editor view.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display Table

Specify or change the default option presentation by selectingOptions > Option
Presentation, or selectBasic or Advanced from the drop-down list at the bottom of the
window.
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The following examples show the same sample file inAdvanced andBasic display.Basic and
Restricted displayswill look the same.

A sample file must be created for each analysis. The file can be created prior to or at the
time of analysis. The sample file identifies the sample, guides the analysis, and specifies
report options.

Option Presentation
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2 About the Software

LIBRARIES
Options > Manage Libraries

This feature is available only for Windows 7 and higher operating systems.

The library provides an easyway to locate and open specific analyzer files. Libraries are located
within the File Selectorwindow and can be viewed only within the application.

The library gathers sample and parameter files that are stored inmultiple locations— such as folders
on a C: drive, a network location, a connected external hard drive, or a connected USB flash drive—
providing access to all files. Even though libraries do not store actual sample and parameter files,
folders can be added or removed within each library.

One library can include up to 50 folders. Other items such as saved searches and search connectors
cannot be included.

When removing a folder from a library, the folder and its contents are not deleted from the original file
storage location. However, when deleting files or folders fromwithin a library, they are deleted from
their original file storage location.
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CONFIGURE THE ANALYZER

ENVIRONMENTAL DEFAULTS FOR TCD ANALYZERS

Options > Environmental Defaults

To ensure accurate loop calibration, enter current environmental conditions daily, or whenever there
is a significant change in one or more of the environmental conditions. These values are used in
some calculations to account for the effect of environmental conditions on the analysis. These
parameters are used in the Dynamic Analysis reports.

Saturation pressure (Po) of the adsorbate used by BET analysis is obtained from the
adsorptive properties for the experiment gas specified.

Field or Button Description
Ambient temperature
[text box]

The temperature of the roomwhere the analyzer is located.

Atmospheric pressure
[text box]

The atmospheric pressure of the roomwhere the analyzer is located.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Environmental Defaults Fields and Buttons Table

Configure the Analyzer
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2 About the Software

GAS CONNECTIONS

See also:

Adsorptive Properties on page 4 - 1

Unit [n] > Gas Connections

Use to configure the gas type connected to each analysis port. The gases available in the drop
downs come from the Adsorptive Properties (.ADP) files. ClickOK when done.

SPECIFY UNIT SELECTIONS

Options > Units
Use to specify how data should appear on the application windows and reports. Thismenu option is
not available if usingRestricted option presentation.
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UNIT CONFIGURATION

Unit [n] > Unit Configuration

Fields Description
Configuration
[group box]

Displays the IP address used by the analysis program, serial number,
and type of analyzer.

IP address. Displays the IP address of the analyzer.

Change IP [button]. Click to display theUnit IP Setupwindow. Use to
change the IP address and subnet mask assigned during installation.
Do not edit these fields unless instructed by aMicromeritics service
representative.

Board ID [button]. Click to display information from the electronic
circuit boards in the analyzer. These parameters cannot be edited.

Serial #. Displays the analyzer serial number.

Unit Configuration Fields Table

Unit Configuration
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2 About the Software

Fields Description
Loop volume [text box] Enter the volume of the gas injection loop. Three standard volume

loops are provided with the analyzer. The loop volume is determined
by performing a loop calibration. See Loop Calibration on page 11 -
10.

Options [group box] Displays options installed on the analyzer.

For Temperature controller:

M— indicatesMicromeritics
E — indicates Eurothem.

Software Versions
[group box]

Displays the software versions of theMIC BIOS, controller software,
and analysis program.

Unit Configuration Fields Table (continued)
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INSTRUMENT STATUS

SHOW INSTRUMENT SCHEMATIC

Unit [n] > Enable Manual Control

Unit [n] > Show Instrument Schematic

See also:

l Enable Manual Control on page 10 - 4
l Gas Pathways on page 2 - 21

Icon or Symbol Description
Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve. Whenmanual control is
disabled, closed valves appear white.

Auxiliary I/O. Lists the current auxiliary settings for Digital and RelayOutput
(DOandRO) and Digital Input (DI). The current Auxiliary 1 and Auxiliary 2 sig-
nals are also displayed, if theywere recorded. SeeAuxiliary Inputs and Out-
puts on page C - 1.

Analyzer Schematic Icon Table

Instrument Status
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2 About the Software

Icon or Symbol Description
Auxiliary Port. Used to connect an external detector (such as amass spec-
trometer) to the analyzer. Cannot bemanually controlled.

Calibration Valves. Used during automatic calibration processes. Generally, it
is not necessary to change the state of the calibration valves.

CryoCooler. Displays only if installed. The CryoCooler speed can be set from 0
to 100%.

Detector Heat Zone. The detector heat zone is set by clicking anywhere in the
orange box. The filament temperature is set by clicking the detector rectangle
on the right side of the schematic.

Gas Inlet Valves. The gasmnemonic is displayed by the inlet if one is
assigned. Right click the inlet valve to open or close the valve.

KwikCool. Displays only if installed.

Analyzer Schematic Icon Table (continued)
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Icon or Symbol Description
Mass Flow Controller. Controls the flow of gas into the analyzer. The
MFC target and flow rate are displayed.

l Set Flow Rate. Click to enter a flow rate.
l Stop Flow. Stops the flow of gas through the selectedMass Flow controller.

Rotary Valve. Controls the flow of gas through the cold trap, the sample tube,
and the loop. Right click the valve icon to change the state of the valve. Select
the needed state. From left to right, the valves and their states are:

l Cold Trap. Bypass, Trap
l Analysis. Analyze, Prepare
l Loop. Fill, Inject

Sample Furnace. Controls the temperature of the sample. Click to display the
sample temperature, the target temperature, the furnace temperature, and the
ramp rate. Right click the icon and selectSet Temperature to change theSet
Point and/or theRampRate.
Septum. Used tomakemanual injections of gas into the gas stream.

Analyzer Schematic Icon Table (continued)

Show Instrument Schematic
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2 About the Software

Instrument Schematic Shortcut Menus

Schematic Shortcut
Icon Description

Valve options Close.Closes the selected valve.

Open.Opens the selected valve.

Temperature control
options

SelectSet Temperature to modify the sample furnace set point or
ramp rate temperatures.

Schematic Shortcuts Table
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Gas Pathways

The colored lines that lead from the gas inlets through the analyzer and to the exhaust represent the
current flow path. Each gas source is represented by a different color path:

Pink Loop gas

Blue Carrier gas

Green Preparation gas

Black Blended gas

When a gas valve is opened or the flow path is changed, it takes several minutes for the
new gas tomove through the entire system.

The behavior of the loop valve is one example. When an analysis includes a loop injection, the
schematic shows the path that is available in Fillmode, then in Injectmode. In Fillmode, the analysis
gas is shown entering the loop and excess gas is vented out the exhaust. In Injectmode, the analysis
gas is shown bypassing the loop and exiting the analyzer through the exhaust. At that time, the
carrier gas path is available from the inlet all the way through the loop, through the sample tube, and
past the detector.

When the valve switches to Injectmode, the quantity of analysis gas that is contained in the loop—
one exact unit — is pushed out of the loop and through the sample tube by the carrier gas.When the
application is recording the TCD signal, the loop injection shows as a peak on theResults view of the
Analysiswindow.

The analysis gasmay be dissipated greatly as it travels out of the loop and through the sample tube,
particularly if the carrier gas flow rate is low. Higher carrier gas flow ratesminimize the dispersion of
the loop gas.

SHOW STATUS

Unit [n] > Show Status

If multiple units are attached to the computer, selectShow Status on eachUnit [n]menu. The status
for all units display.

Show Status
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2 About the Software

SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log
Use to display a log of recent analyses, calibrations, errors, or messages.

Field Description
Add Log Entry [button] Use to enter information to appear in the sample log report that cannot

be recorded automatically through the application. Click the button
again to enter multiple log entries.

Analysis/
Calibration/
Message [check box]

Select the logs to display.

Report [button] Click to select print destination and report start date.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Instrument Log Fields and Buttons Table
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METHODS

Options > Default Method

File > Open > [.MTH File]

See also:

Create Sample Files on page 3 - 2

AMethod determines the default sample identification format and sequence number. AMethod is a
template of specifications that go into a newly created sample file. It allows for the definition of
complete sets of parameters for each type of sample commonly analyzed, so that only a single
selection is required for each new sample file created.

TheMethod drop-down list displays only thosemethods applicable to the open sample file type.

Field or Button Description
Sequence Number Specify a default numeric string to be used as a prefix in theSample

field when a new sample file is created. This number increments with
each sample file created.

Sample file name Enter a format for the sample identification. The entry in this field
becomes a part of the saved sample file name. Include the $ symbol to
have the sample file number included as part of the identification.

Sample
Operator
Submitter
Bar Code

These field labelsmay be renamed and the new label becomes a part
of all new sample files.

Default Method Fields and Buttons Table

Methods
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2 About the Software

EXPORT FILES
File > Export

See also:

Exported Data Example on page D - 1

Provides the option to print the contents of one or more sample or parameter files to either the
screen, a printer, or to a file. Data can be exported as a .PDF, .REP, .TXT, or .XLS file format. The
type of data to include or exclude can be selected during the export process.When exported to a file,
the data can be imported into other applications that read these file formats.

LIST FILES
File > List
Provides the option to create a list of sample file information—such as file name, date, time the file
was created or last edited, file identification, and file status.
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ANALYSIS TYPES FOR TCD ANALYZERS
The basic concept for all analyses is the same— the filament detects changes in the gasmixture
flowing past it. The sample, gas selection, and analysis conditions determine what changes occur.

l Pulse Chemisorption Analysis.

SeePulse Chemical Adsorption Analysis on page 11 - 12.

l Temperature ProgrammedDesorption (TPD).

See Temperature Programmed Desorption Analysis on page 11 - 19.

l Temperature ProgrammedOxidation (TPO).

See Temperature Programmed Oxidation Analysis on page 11 - 25.

l Temperature ProgrammedReduction (TPR).

See Temperature Programmed Reduction Analysis on page 11 - 31.

l BET Surface Area Analysis. SeeBET Surface Area Analysis on page 11 - 1.

The BET surface area analysis evaluates total surface area of the catalyst before and after
chemisorption. Pore-plugging phenomena, whichmight occur due to the irreversible adsorbed
species during chemical reactions, as well as the occurrence of sintering1 ) , can be studied.
After outgassing the sample, amixture of nitrogen and helium (typically 5 to 30%N2) flows over
the sample which is immersed in a liquid nitrogen (LN2) bath. Both the adsorption and desorption
of the N2 are recorded. The amount of nitrogen desorbed at LN2 temperatures and the sample
weight are used to calculate total specific surface area.
The entire BET analysis— or even repeat analyses— is performed in situ.

l Langmuir Surface Area Analysis.

The Langmuir surface area analysis allows you to evaluate the total surface area of the catalyst
and is especially useful for adsorbate/adsorbent systems that adsorb only amonolayer. These
materials typically exhibit a Type 1 isotherm and are oftenmicroporous. The Langmuir surface
area analysismay be best applied to zeolites andmicroporous carbons – typically the Langmuir
surface area will exceed the BET surface area for thesematerials and provide amore accurate
estimation of the total surface area.
The Langmuir surface area report may be applied to a wide range of gas concentrations and is
not limited to the typical BET range (5 to 30%N2).

1 ) Sintering is the fusing of small particles (or small features of a sample). Sintering tends to reduce
the active surface area.

Analysis Types for TCD Analyzers
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2 About the Software

l Total Pore Volume Analysis.

The total pore volume is a single-point estimate of the pore capacity of amaterial. The total pore
volume analysis is usually conducted near the saturation pressure of the adsorbate (0.995 P/P0).
The total pore volume of amaterial can be determined on both fresh and usedmaterials, the
difference in pore volumemay indicate pore plugging and directly relate to changes in the
performance of catalysts and adsorbents.

For a high surface area sample (> 100m2/g), a quantity less than 50mg is recommended. The
high sensitivity combined with the large quantity of adsorbed gas allows the use of smaller sample
quantities while maintaining high precision. The reduced sample quantity will also reduce the
likelihood of saturating the high sensitivity detector.

ADDITIONAL USES OF THE TCD ANALYZER

The analyzer may also be used for temperature programmed reactions, catalyst pretreatment, and
isothermal reactions. The tremendous flexibility of the analyzer allows the use of custom
applications.

Temperature Programmed Reaction

A temperature programmed reactionmonitors the products from the reaction between gases and a
catalyst at a specified temperature. The analyzer can be programmed to raise the temperature of a
catalyst bed at a constant ramping rate as the gases flow through the catalyst. At the optimal
temperature, the gases react in the presence of the catalyst, creating products. The products of the
reaction and the excess reactants can be diverted to a gas chromatograph or to amass
spectrometer to be analyzed.

Catalyst Pretreatment

Catalyst pretreatment usually consists of activating a catalyst prior to its use in a chemical reaction.
For example, when a temperature programmed reaction is to be performed, the catalyst must be
reduced under a flow of H2 at a specific temperature. The reduction is necessary to create active
sites, or reduce atoms of activemetals, which are responsible for the activity of a catalyst.

Isothermal Reaction

An isothermal reaction is similar to a temperature programmed reaction except that the catalyst is
kept at a constant temperature (isothermal) to perform the catalytic reaction. Both the product of the
reaction and the excess reactants can be diverted to a gas chromatograph or to amass
spectrometer to be analyzed.
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APPLICATIONS

Catalytic processes that benefit from TPD/TPR analyses include:

l Polymerization
l Hydrogenation
l Catalyst cracking
l Hydrocracking
l Isomerization

l Oxidation
l Dehydrogenation
l Hydrotreating
l Alkylation reforming

Applications
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3 ABOUT SAMPLE FILES
Sample files include the information required by the analyzer to perform analyses and collect data. A
sample file identifies the sample, guides the analysis, and specifies report options andmay be
displayed in either Advanced, Basic, orRestricted presentation displaymode. After data has been
collected, the file will be shown inMicroActivemode or the tabbed file editor. SeeOption
Presentation on page 2 - 10.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either prior to or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, anAnalysis Conditions file containing the recurring conditions
can be created.When the sample file is created, theAnalysis Conditions file can be selected for the
analysis conditions. Once it becomes part of the new sample file, the new file can be edited as
needed without affecting the originalAnalysis Conditions file. SeeAbout Parameter Files on
page 4 - 1.

The analysis application contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method. SeeMethods on page 2 - 23.

Specify or change the default option presentation by selectingOptions > Option
Presentation, or selectBasic or Advanced from the drop-down list at the bottom of the
window.

3 About Sample Files
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3 About Sample Files

CREATE SAMPLE FILES
File > New Sample > [.SMP File]

File > Open > [.SMP File]

See also:

l Active Metals for Chemical Adsorption on page 3 - 5
l Methods on page 2 - 23
l Open a Sample File on page 3 - 4
l Option Presentation on page 2 - 10

Each analysismust be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone.

Specify or change the default display option by selectingOptions > Option Presentation or select
Basic or Advanced from the drop-down list at the bottom of the window.

Sample filesmust be initially created inAdvanced option presentation. After the sample files are
saved, the files are accessible inBasic andRestricted option presentation.

The values specified in the parameter portions of the default method are the defaults for new sample
files. To navigate from one set of parameters to another, select the parameter tab across the top of
the window.
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Field or Button Description
Active Metals [button] Displays a list of activemetals.

Add Log Entry [button] Use to enter information to appear in the sample log report that cannot
be recorded automatically through the application. Click the button
again to enter multiple log entries.

Comments [text box] Enter comments about the sample or analysis. Comments display in
the report header.

Mass [group box] Enter a value for samplemass. Mass can be changed any time before,
during, or after analysis.

Enter.Enables theSamplemass field. Enter a value for the sample
mass.

Calculate.Enables theEmpty tube andSample + tube fields. Enter
the values necessary to calculate the samplemass. Equation used to
calculate samplemass:

Masssample = Masssample+tube –Masstube
Method [drop-down box] Select amethod from the drop-down list.

Operator [text box] Enter operator identification information. This field label may have
been renamed or may not display if modified inOptions > Default
Methods.

Sample [text box] Enter a sample description.

Submitter [text box] Enter submitter identification information. This text boxmay have been
renamed or may not display if modified inOptions > Default Meth-
ods.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Sample File Fields and Buttons Table

Create Sample Files
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3 About Sample Files

OPEN A SAMPLE FILE
File > Open > [.SMP File]

Whenworking with an existing sample file, consider making a copy of the sample file to
maintain the original configuration options.

File Status Displays
No Analysis Tabbed file editor

Complete
Analyzing Peak Editor view
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ACTIVE METALS FOR CHEMICAL ADSORPTION
Options > Active Metals Defaults
(or clickActive Metals on theSample Description tab when using Advanced presentation option)

See also:

Atomic Weights and Cross Sectional Areas on page B - 1

Up to 20 elements can be specified. At least one element must have a non-zero% of sample weight.

Field or Button Description
% of Sample Weight *
[column]

Percentage, byweight, of each element contained in the sample.

% Reduced * [column] The percent of metal reduced during preparation.

Adsorptive [button] Click to display andmodify both the adsorptives and their asso-
ciated stoichiometry factor. Stoichiometry factors for each gas are
metal-specific.

Active Metals Fields and Buttons Table

ActiveMetals for Chemical Adsorption
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3 About Sample Files

Field or Button Description

Stoichiometry Factor. The stoichiometry factor is defined as the
moles of metal species covered per mole of adsorptive.

Atomic Cross Sect. Area
(nm2) [column]

Atomic cross-sectional area of the element.

Atomic Weight [column] Atomic weight of the element.

Density g/cm3 Density of the element.

Element [drop-down box] Select or enter the activemetal.

MxOy, X *
MxOy, Y *
[column]

X and Y values specify the empirical formula for metal and oxygen,
respectively, in ametal oxide.

* Options are shown only when using the Active Metals button on the Sample Description
tab.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Active Metals Fields and Buttons Table (continued)

3 - 6 MicroActive AutoChemHP 2950Operator Manual
295-42830-01 (Rev -) — Jan 2018



4 ABOUT PARAMETER FILES

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, anAnalysis Conditions file containing the recurring conditions
can be created.When the sample file is created, theAnalysis Conditions file can be selected for the
analysis conditions. Once it becomes part of the new sample file, the new file can be edited as
needed without affecting the originalAnalysis Conditions file.

Methods include both analysis conditions and report options, offering themost convenient way to
repeat most analyses.

Predefined parameter files are included with the program and can be edited as needed or new
parameter files can be created.

The following file types can exist as part of the sample file aswell as individual parameter files:

File Type File Extension
Adsorptive Properties .ADP

Analysis Conditions .ANC

Method .MTH

Report Options .RPO

ADSORPTIVE PROPERTIES
File > Open > [.../param/*.ADP]

4 About Parameter Files
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4 About Parameter Files

Field or Button Description
Adsorptive
[drop-down box]

Name of the adsorptive gaswhose properties are being defined.
SeeGas Connections on page 2 - 14.

Mnemonic [text box] Enter themnemonic name for the adsorptive.

Hard-sphere diameter
[text box]

An estimate of molecular size used in calculating the thermal
transpiration correction.

Molecular cross-sec-
tional area [text box]

The area that a single adsorbedmolecule occupies on the surface of
the sample. It is used in surface area calculations.

Molecular weight
[text box]

Themolecular mass is used for the weight % column of the isotherm
tabular report and for the pressure composition isotherm plot.

Thermal conductivity
[text box]

SeeGas Charts on page E - 1.

Mass flow constant
[text box]

Scaling factor for theMass Flow Controller measured flow rate. Applic-
able only for the gas used in the flow prep tasks. The default is preset
for gases provided with the application.

Estimate Thermal Con-
ductivity and Mass
Flow Constant
[group box]

Select if a gas blend will be used for the estimated Thermal
Conductivity andMass Flow Constant. Select the gases to be used in
the blend.

Vapor [check box] Select if vapor is going to be used and enter the vapor defaults.

High-resolution fluid properties.Use to import parameters from a
Fluid Properties (.FPI) file. Changing fluid properties should only be
necessary if an adsorptive is to be used for which no adsorptive
properties are provided. Contact Micromeritics Scientific Services if
new fluid properties are required. SeeContact Us on page ii.

Antoine equation...Enter the Antoine constants.

l A, B, C. Enter the Antoine constants used in the vapor
TCD calibration.

l Min/Max Temperature.Enter the temperature range (in C) in
which the constants are valid.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Adsorptive Properties Fields and Buttons Table
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ANALYSIS CONDITIONS
File > Open > [.ANC File]
Analysis conditions specify the parameters used to guide an analysis.

See also:

Insert Experiment Step on page 4 - 6

Field or Button Description
Analysis Conditions
[drop-down box]

Use to browse for anAnalysis Conditions file that contains analysis
condition parameters to be used in the analysis.

Analysis Conditions Fields and Buttons Table

Analysis Conditions
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4 About Parameter Files

Field or Button Description
Baseline [button] Specifies baseline settings if aWait step depends upon theBaseline.

Establishes theSlope or Acceleration threshold andDuration for
determining what constitutes aStable Baseline, aChange From
Baseline, and aReturn To Baseline. These values control whether a
particular change in the signal is significant to the current experiment—
such as defining a stable baseline.

SomeWait steps are contingent upon the values selected— such as if
the experiment contains aWait until Baseline is stable step, the signal is
compared to these values to determine if a stable baseline has been
established. Lower slope/acceleration values and longer durations
create amore rigorous definition of these factors than higher values and
shorter durations.

Stable Baseline.Detected when the signal slope is below the threshold
for the indicated duration.

Change from Baseline.Detected when the signal acceleration
exceeds the threshold for the indicated duration.

Return to Baseline.Detected when the signal acceleration falls below
the threshold for the indicated duration.

Analysis Conditions Fields and Buttons Table (continued)
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Field or Button Description
Insert [button] Insert a new step into the experiment. Steps can be inserted after the

analysis has started by suspending the analysis.

See Insert Experiment Step on the next page.

To ensure safe operation and reliable results, a chemically inert gas flow
should be inserted between flows of two chemically reactive gases such
as hydrogen and oxygen.

Insert Analysis Condi-
tions [button]

Click to load an entire list of steps, baseline parameters, and peaks
parameters from the selected dynamic analysis conditions file.

Sample tube type
[selection]

Select the type of sample tube to be used.

Step Detail [group box] Displays summary information about the highlighted experiment step.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Analysis Conditions Fields and Buttons Table (continued)

Analysis Conditions
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4 About Parameter Files

INSERT EXPERIMENT STEP

Experiments can be customized to control the analysis reaction. When an experiment is inserted, the
initial conditions are specified first, then the individual steps. On theAnalysis Conditions tab, click
Insert to insert an experiment. Select the experiment step in the box, then clickEdit to modify
settings. An analysis set is created by inserting up to 99 experiments in the sample file.

To edit steps that have not been started, the analysismust be suspended.

l Upcoming steps - display as black or blue
l Current step - step is highlighted and displays as light blue
l Completed steps - display as light green

TheDDE Command step andWait for synchronizationmessage option in theWait step
are no longer supported.

Data from one experiment are not available for editing until the next experiment in the
analysis has begun recording.

Field or Button Description
Change Pressure Do not use quartz sample tubeswith pressures above

1034mmHg. TheO-ringswill not seal and the sample tube
can be released from the fitting.

Experiment Fields and Buttons Table

4 - 6 MicroActive AutoChemHP 2950Operator Manual
295-42830-01 (Rev -) — Jan 2018



Field or Button Description

Use to set target pressures for analysis or preparation, or return to
atmospheric pressure.

Change Valves Sets the rotary valves as specified.

Dose

Injection Type:

l Inject loop gas. Automatically injects the contents of the loop into

Experiment Fields and Buttons Table (continued)

Insert Experiment Step
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4 About Parameter Files

Field or Button Description

the path that leads to the sample. The contents of the loop are pushed
out of the loop by the carrier gas.

l Manual injection.Prompts the user to inject a dose of gas into the
septum using a syringe.

l Get physisorption point.Provides a series of steps necessary to
collect data for a physisorption point. These steps include placing a
dewar of liquid nitrogen around the sample tube, waiting for a return
to baseline, then replacing the dewar with water at room tem-
perature. Repeated points can be taken by placing theDose step
within aRepeat Loop.

After Injection. Specify the conditions for completion of this step.

Baseline. SeeBaseline [button] on page 4 - 4.
Experiment

Experiment description. Description of the experiment.

Type of analysis.SeeAnalysis Types for TCD Analyzers on
page 2 - 25. If Pulse Chemisorption is selected, theStoichiometry
button is enabled.Whenmodifying theActiveMetals table during the
insertion of aPulse Chemisorption experiment, changes to theActive
Metals table on theSample Description tab are not affected. This is
useful when sequencingmultiple experiments and Stoichiometry is
different from one experiment to the next.

Initial Conditions.Description for Zones, Gas Flows, Outputs, and
Peaks buttons are provided elsewhere in this table.

Stoichiometry. Opens theActiveMetals table. Specify the percent of
sample weight of the activemetals in the sample and the stoichiometry
factor. See Active Metals for Chemical Adsorption on page 3 - 5.

Experiment Fields and Buttons Table (continued)
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Field or Button Description
Recording Options

l Include input signal. Allows the use of external electrical input from
an auxiliary port or choose to report an analyzer specific parameter
from the drop-down list. SeeAuxiliary Inputs and Outputs on
page C - 1.

l Zero the TCD signal when recording starts. Zeros the TCD sig-
nal automatically the first time recording starts in an experiment.

l Invert the TCD signal. Inverts the TCD signal. For example, if only
negative peaks are expected, this option can be used to record the
peaks in the positive direction.

Peaks:

Use to control peak detection during analysis.

After analysis, peak detection can be further controlled using the Peak
Editor. SeePeak Editor on page 6 - 3. The TCD detects and records
all deviations from baseline, but only those which satisfy the criteria
established in this window are reported as peaks.

The defaults are usually acceptable. SeePeak Detection
/ Integration Options on page F - 1.

Experiment Fields and Buttons Table (continued)

Insert Experiment Step
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4 About Parameter Files

Field or Button Description
Gas Flow

Use to select the gases for this step, specify the flow rates, specify the
percent of the carrier gasmixture which is composed of the reactive, and
set the state of the rotary valves.

The listed gases are those specified in the Adsorptive Properties file.
SeeAdsorptive Properties on page 4 - 1 andGas Charts on
page E - 1 for gas combinations. SelectNonewhen no gas is to be
flowing (the flow rate is ignored).

Prep Gas, Carrier Gas, Loop Gas. Select the gas for each set of inlet
ports. The gases listed are those with defined adsorptive properties. If
manual injections are to be programmed, the gas to be injectedmust be
selected as Loop or Injection gas.

When an analysis is started, the application verifies that the selected
gases are connected to the appropriate ports. If there is a discrepancy
between a gas selected for the current sample file and the gases
indicated in theGasConfigurationwindow, an error message is
displayed.

Rate. The rate at which gas is to flow.

Active concentration.Specify the percent of the gasmixture which is
composed of the reactive gas versus an inert filler. This value is used for
pulse chemisorption data reduction.

Blend carrier and loop gases.Select to have the carrier and loop
gases blended then enter the percentage for the gases.Whichever field
ismodified, the other field automatically defaults to a percentage totaling
100.

Cold trap valve, Analysis valve, Loop valve, Back pressure valve.

Experiment Fields and Buttons Table (continued)
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Field or Button Description
Select a status for each valve.

Loop Calibration

Use to verify the volume of the loop for use in calculations on analyses
that use the loop. Sample analysis data yield signal vs. temperature data
and peak areas. Associating the sample information file with a loop
calibration file makes it possible for the application to convert sample
data to volume values.

Outputs Use to specify the state of the digital and relay outputs.

Ports are provided for connecting auxiliary inputs and outputs. For
example, the digital outputs can be used to control a mass spectrometer.
SeeAuxiliary Inputs and Outputs on page C - 1.

Start Recording Specifies how frequently the signal reading is recorded. A Stop
Recording step is inserted in the steps automatically when aStart
Recording step is inserted. Multiple steps can be inserted between the
Start Recording andStop Recording steps.

Experiment Fields and Buttons Table (continued)

Insert Experiment Step
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4 About Parameter Files

Field or Button Description

One measurement every [n] seconds. Specify the frequency of
measurements.

If aStart Recording step is immediately followed by a step
that prompts an immediate peak, peak data are recorded
before any baseline readings can be collected. To collect
some baseline data before the first peak, insert a
Wait for [n] minutes step after theStart Recording step but
before the step which causes the peak.

Start Repeat Specifies the duration of the repeat sequence. Automatically inserts a
Start Repeat and aStop Repeat in the list of steps. Multiple experiment
steps can be inserted within theRepeat loop.

Repeat until peaks are equal or [n] times. Stops repeating the steps
within the loop when the last two peaks are equal to within 5% of the
area, or when themaximumnumber of repeats is reached. This option is
useful when performing H2 or COpulse chemical adsorption on
supportedmetal catalysts.

Repeat until peaks are zero or [n] times.Stops repeating the steps
within the loop when the last two peaks are each less than 10% of the
area of the first peak, or when themaximumnumber of repeats is
reached. This option is useful when performing an N2Odecomposition
for characterizing copper catalysts.

Experiment Fields and Buttons Table (continued)
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Field or Button Description
Repeat [n] times. Stops repeating the stepswithin the loop when the
specified number of times is reached.

Repeat until peaks match the first peak or [n] times.Stops
repeating the stepswithin the loop when the last two peaks eachmatch
the first peak to within 10% of its area, or when themaximumnumber of
repeats is reached.

Temperature Ramp Changes the sample temperature.

Temperatures above 850 °C can cause damage to ametal
sample tube

Ramp Type:

l Furnace ramp.Ramps the furnace temperature directly to the
End temperature ignoring the sample temperature.

l Sample ramp. Ramps the sample temperature to theEnd tem-
perature. The actual furnace temperature is adjusted tomeet this
target.

l Sample ramp and equilibrate.Ramps the sample temperature
to theEnd Temperature and waits for it to equilibrate before pro-
ceeding.

l Return to ambient.Allows the furnace temperature only (not the
sample temperature) to return rapidly to a temperature to below
45 °C.

End temperature.  The ending temperature for the ramping procedure.
If the CryoCooler is installed, it is automatically enabled if an ending

Experiment Fields and Buttons Table (continued)

Insert Experiment Step
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4 About Parameter Files

Field or Button Description
temperature below 20 °C is used.

Hold time.How long the sample is to be held at the specified
temperature before beginning to cool down.

Ramp rate. The rate at which the temperature will change while
advancing to the hold temperature.

Enable KwikCool.Select to use the KwikCool to reduce the furnace
temperaturemore rapidly during cool down. If selected and the
KwikCool is not attached to the analyzer when the analysis is started, an
error message is displayed. If the CryoCooler (rather than the
KwikCool) is attached, the cool down operation is performed by the
CryoCooler.

Termination

Return to ambient temperature.Allows the furnace temperature only
(not the sample temperature) to return rapidly to a temperature between
14 °C and 50 °C.

Enable KwikCool. See Enable KwikCool in Temperature Ramp.

Leave the detector enabled after analysis.Several hoursmay be
required for the analyzer to reach thermal stability after the detector is
enabled. This option keeps the detector enabled after analysis, allowing
the analyzer to remain stable.

Gas flow through the detector is required while the detector is enabled
but is not necessary if the detector is disabled. It is recommended to flow
an inert gas to continuously purge the system.

Should the analysis be canceled due to an analyzer error, the detector
will be left enabled if this option is enabled. Should the analysis be
canceled, this option is ignored, and the detector is left enabled.

Experiment Fields and Buttons Table (continued)
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Field or Button Description
Wait Specify a waiting routine.

Wait [n] minutes. Specify the time to wait.

Wait for operator. Enter a description of the operator task. During an
analysis, the enteredmessage displays at the appropriate time. The
analysis continues after the operator clicksOK.

Wait until baseline is stable. Specify if the analysis should wait until
the baseline becomes stable,  then clickBaseline to specify the
settings.

Wait for change from baseline or [n] minutes.Specify the time to
wait, clickOK, then clickBaseline to specify the settings.

Wait for return to baseline.Waits for a return to baseline. If enabled,
clickOK, then clickBaseline to specify the settings.

Wait for digital input number.Enter the number of the digital input
source being awaited, then specify themaximumnumber of minutes to
wait for input. If the digital input is not received before the time elapses,
the analysis will continue, and a warningmessage is displayed. See
Auxiliary Inputs and Outputs on page C - 1.

Experiment Fields and Buttons Table (continued)
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4 About Parameter Files

Field or Button Description
Zones Click to set the heat zone temperatures.

The Filament temperaturemust be set at least 20 °C higher than the
Block zone temperature.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Experiment Fields and Buttons Table (continued)
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REPORT OPTIONS

File > Open > [.RPO File]
(or click theReport Options tab when inAdvanced option presentation)

See:

About Reports on page 6 - 1

Log in to your customer portal to accessMicroActive Report Tutorials and the Calculations
document.

Use to specify report options for data collected from an analysis or manually entered data.Report
Options files also help in customizing report details such as axis scale, axis range, column headings,
and components of thickness curve equations. These filesmay contain tabular reports, plots, or
both, as well as advanced report tables.

Customized report options files can be created then loaded into a sample file, allowing quick
generation of reports.

Report Options
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4 About Parameter Files

Field or Button Description
Edit [button] Select the report in the Selected Reports box. SeeSelected

Reports on page 7 - 1.
Integration [button] SeePeak Detection / Integration Options on page F - 1

Report Options
[drop-down box]

Browse for a .RPO file that contains report options parameters to be
used in the report.

Selected Reports
[group box]

Select the report names to include in the report.

Show graphic [check box] Use to show a graphic on the report header.

Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select and enter a report title to appear on the report header.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Report Options Fields and Buttons Table
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5 PERFORM AN ANALYSIS

ANALYSIS TEMPERATURE GUIDELINES

The guidelines are applicable to all analysis types.

l Starting Temperature.Experiments should be started at a temperature that is lower than that at
which the reaction begins. If the reaction begins below ambient temperature, use the optional
CryoCooler.

l Maximum Temperature. The experiment’smaximum temperature is limited to the temperature
at which the sample sinters.

l Ramp Rate. The recommended ramp rate is 5-10 °C/min, however a different ramp rate can be
specified. For example, if using 500 °C as the starting temperature of the reaction, it ismore
expedient to ramp the temperature rapidly (for example, 50 °C/min.) to a value near 500 °C, then
proceed with the experiment at 5-10 ºC/min.

5 Perform an Analysis
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5 Perform an Analysis

COOLING OPTIONS

The furnacemust cool during temperature programmed analyses if:

l a low temperature is required as part of the analysis, or
l to speed cooling of the furnace to increase sample throughput, or reduce analysis time.

If cooling is required for the analysis, a CryoCooler may be necessary. Cooling options are:

l Allow the temperature to return to ambient over time

If time is not a consideration, allow the furnace to cool over time. It may take two hours or more for
the furnace to cool from 1100 °C to near ambient. Thismay be acceptable when time is not
limited.

l Promote cooling by manually opening the furnace

The furnace coolsmore rapidly when it is open. This option requires the availability of an operator
to open and close the furnace at the appropriate times during analysis.

When it has been used recently, the furnace and/or the sample tubemay be hot. Use
the cotton gloves provided with the analyzer to protect hands.

l Connect a cooling gas or cryogen flow to the inlet on the front of the furnace

A cooling flow of an appropriate gas or cryogen can be connected to the inlet on the furnace.
Read the warning listed above. This option can provide rapid cooling of the sample, but offers no
control of the target temperature or the speed at which it is achieved. The gas or cryogenmust be
nonreactive— such as nitrogen, air, helium, argon, liquid nitrogen, or liquid argon.

l Connect the KwikCool to the inlet in the front of the furnace

The KwikCool allows the furnace temperature to ramp rapidly near ambient, which reduces the
time required to complete analyses and increases throughput. SeeKwikCool on page 9-8.

l Connect the optional CryoCooler to the inlet in the front of the furnace

TheCryoCooler provides control of the sample temperature to temperatures as low as -70 °C.
The CryoCooler is required for accurate analyses that include signal recording below ambient.
Log in to your customer portal to access the CryoCooler Operator Manual.
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SAFE OPERATING GUIDELINES FOR STAINLESS STEEL TUBES

l External cooling of the tube above 200 °C may be assisted only with air not to exceed
3 cfm@ 30 psi.

l External cooling of the tube below 200 °C may be assisted with the CryoCooler at a
rate less than 90 °C/min.

l Do not use other cooling agents below 200 °C because theymay embrittle the
sample tube.

l Do not submerge the tube in water or oil, or spray the tube with water or oil.

Failure to follow these practicesmay cause bodily harm and/or damage to the analyzer
and sample tube. The analyzer has been optimized to use these guidelines for safe
operation.

Safe Operating Guidelines for Stainless Steel Tubes
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5 Perform an Analysis

DEWAR PRECAUTIONS

Always handle glass dewars with care. Any product incorporating a vacuum is a poten-
tial safety hazard and should be treated with caution. If in doubt, contact your safety
officer.

When handling dewars containing liquefied gases or cryogenic liquids:

l Wear protective equipment:
o goggles or face shield
o an insulated or rubber apron
o insulated gloves

l When pouring liquefied gases from one container to another:
o cool the receiving container gradually to minimize thermal shock
o pour the liquified gas slowly to prevent splashing
o vent the receiving container to the atmosphere

FOR GLASS DEWARS

l Use a plastic stirring rod when stirring substances in a dewar containing liquefied gases (or other
materials of extremely low temperature). Do not use a glass or metal stirring rod unless it has a
protective coating.

l Do not handle heavy objects above the dewar. If unavoidable, place a protective cover over the
dewar opening. If an object of sufficient weight is accidentally dropped into the dewar, shattering
may occur.

l If the dewar has a protectivemesh covering, do not remove it. This cover minimizes the risk of fly-
ing particles should the dewar be knocked over, dropped, or broken.
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MIXING AN IPA/LN2 SLURRY

An isopropyl alcohol (IPA) /liquid nitrogen (LN2) slurry is used tomaintain cold trap tem-
peratures of approximately -80 °C. Improperlymixing an IPA/LN2 slurry could cause
injury. If themixture is not stirred continuously, gasmay build up under the surface, caus-
ing the liquids to splash out of the dewar.

1. Chill a 600mL dewar by rinsing it with LN2. Allow a small amount of LN2 to remain in the bot-
tom of the dewar (approximately 1 cm deep).

2. Stirring constantly, slowly add approximately 500mL of IPA. For greatest safety, use a labor-
atory squirt bottle. Squirt the stream of IPA along the inside edge of the dewar, close to the top
of the dewar, allowing the IPA to flow down the inside wall of the dewar. Do not stop stirring
themixture in the bottom of the dewar, even if stirring becomes difficult. As stirring and adding
IPA continues, themixture will loosen and become easier to stir.

3. When all the IPA has been placed in the dewar, slowly begin pouring LN2 into the dewar.
Approximately 1 liter is needed. Continue to stir themixture as LN2 is added. As ice chunks
form, break them up and stir them down into themixture. Avoid splashing. Gently knock ice
chunks away from the sides of the dewar and continue stirring. Add liquid nitrogen until the
slurry is within 25mm (1 in.) of the top of the dewar.

4. Lift the stirrer out of the slurry and observe as the slurry drips into the dewar; the stirrer should
be thickly coated with slurry.

The goal is to achieve a slurry that has a thick, syrupy consistencywithout large chunks.When
the slurry is cold enough, small pieces of icemay be present (10 - 20% of themixture). A little
ice accumulation along the sides of the dewar is acceptable.

PROTECT DETECTOR FILAMENTS BY FLOWING GAS

A carrier gasmust be flowing through the detector whenever the detector filaments are
turned on; otherwise, the filaments will deteriorate and lose sensitivity. If the gases are
shut off, the filaments are automatically turned off after fiveminutes.

The flowing gas also continuously cleans the plumbing of anywater vapor which can enter when the
sample tube is removed. Ten cm3/min is sufficient to perform this function.

Mixing an IPA/LN2 Slurry
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5 Perform an Analysis

PREPARE FOR ANALYSIS
The steps in this topic properly prepare the equipment for an analysis. It is recommended to perform
the tasks in the provided order.

Steps to perform analyses:

l Step 1 -Clean and Label Sample Tubes on the facing page
l Step 2 - Prepare the Sample on page 5 - 9
l Step 3 -Create Sample Files on page 3 - 2
l Step 4 -Determine the Sample Mass on page 5 - 10
l Step 5 - Sample Tube Installation on page 9-23
l Step 6 - Fill and Install the Dewar on page 5 - 13

See also:

l Analysis Temperature Guidelines on page 5 - 1
l Analysis Tutorials on page 11 - 1
l Cold Trap Tube or Delay Path on page 9-1
l Cooling Options on page 5 - 2
l Dewar Precautions on page 5 - 4
l Protect Detector Filaments by Flowing Gas on the previous page
l Sample Thermocouple on page 9-14
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CLEAN AND LABEL SAMPLE TUBES

The equipment images in this document may differ slightly from your equipment, how-
ever the instructions are the same unless otherwise noted.

Sample tubes and filler rodsmust be clean and dry before samples are added and weighed. The
following table indicateswhichmaterials are supplied byMicromeritics and which are supplied by the
user. The procedures following thematerials table are recommended.

Supplied by Micromeritics Supplied by User

l Funnel
l Sample data worksheet
l Sample tube
l Sample tube brush
l Sample tube rack
l Sample weighing support
l Stopper for sample tube

l Acetone or isopropyl alcohol
l Analytical balance
l Detergent (such as Alconox)
l Drying oven
l Forceps
l Insulated gloves
l Pipe cleaners
l Rubber gloves or lint-free cloth
l Safety glasses
l Ultrasonic cleaning unit
l Waste container

1. Preheat drying oven to 110 ºC.
2. Verify that the ultrasonic cleaning unit is clean.
3. Use 5 grams of Alconox (or other suitable detergent) per 500mL of warmwater and fill the

ultrasonic unit with enough water to cover the sample tubes and filler rods (if used). If too
much detergent is used, it may be difficult to rinse from the sample tubes. Ensure the deter-
gent is dissolved before placing the sample tubes and filler rods into the water.

4. Fill the sample tubeswith warmwater and place them in the ultrasonic cleaning unit, then
place the filler rods in the unit. Turn on the ultrasonic cleaning unit for approximately 15
minutes.

Clean and Label Sample Tubes
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5 Perform an Analysis

5. Use rubber gloves to ensure no oils or residue are transferred to the clean tubes and filler
rods, then remove the sample tubes and filler rods from the unit.

6. Clean the interior of the sample tubeswith the brush supplied with the analyzer.
7. Rinse the sample tubes and filler rods thoroughly with hot water. Rinse again with isopropyl

alcohol or acetone. If isopropyl alcohol or acetone is not available, deionized water may be
used.

8. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in the
rack. Bake in a vacuum oven for two hours at 110 °C.

Samples tubes can also be cleaned with high purity acetone or isopropyl alcohol and
dried for about 10minutes under heat. If using thismethod, continue with step 10.

9. Remove the sample tubes and filler rods from the oven and allow to cool.

Do not insert the filler rods at this time. Filler rods are inserted before the sample tube is
installed on the analysis port.
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10. Blow out the sample tubeswith oil-free compressed air.
11. Rinse the sample tube closure with isopropyl alcohol, then wipe the sample tube closure dry

with a clean, lint-free cloth.
12. Label the sample tube and stopper for identification.
13. Replace the rubber stopper, Check Seal, or TranSeal.

PREPARE THE SAMPLE

To obtain themost repeatable, accurate results:

l Use approximately the same amount of sample for each analysis (especially if data are compared
sample to sample).

l Ensure the sample is well dispersed in the tube, not against the side or walls of the tube.
l Ensure the sample particle size distribution remains fairly constant from sample to sample. (Large
particles of a substance reduce at a different rate than small particles of the same substance.) For
sampleswith a wide particle size distribution, care should be taken that each sample is rep-
resentative of the entire lot’s distribution.

Micromeritics recommends analyzing samplesweighing between 20mg and 2 g.When determining
a sample amount, consider that the samplemust be contained within the bottom 20mm (3/4 in.) of
the sample tube.

When determining sample size, consider the percentage of activemetals in the sample. Materials
with lower percentages of activemetalsmay require larger sample amounts for analysis, while
materials with high percentages of activemetals can be analyzed using smaller samples.

Larger amounts of very fine powdersmay become packed in the sample tube and block
gas flow. The resulting increase in gas pressuremay force some of the sample out of the
sample tube, causing contamination of, or damage to the analyzer. A possible solution is
to expand the sample bed with quartz wool.

CREATE THE SAMPLE FILE

See:

Create Sample Files on page 3 - 2

Prepare the Sample
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5 Perform an Analysis

DETERMINE THE SAMPLE MASS

See also:

Sample Data Worksheet on page H - 6

Bulb sample tubes are for pellets and other sampleswithout loose particles. Using
powder samples in bulb tubesmay cause the loose particles to go into the analyzer's
exhaust.

1. Record theSample Tube Identification on theSample DataWorksheet.
2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize at

zero.
3. If analyzing a powder or samplemade of fine particles, push a piece of quartz wool all the way

down into the sample tube. SeeUse Quartz Filter Discs for Chemical Adsorption on the
facing page.

4. If using quartz wool, put a second piece of quartz wool just inside the sample tube. If using fil-
ter discs, push a filter disc down into the tube until it sits on top of the quartz wool. Place a
second filter disc just inside the sample tube.

5. Place the sample tube set (sample tube with quartz wool or filter discs and stoppers) on the
sample support. Record the stabilizedmass on theSample DataWorksheet.

6. Remove the sample weighing support and sample tube set from the balance.
7. Place the sample container on the balance and allow the balance to stabilize at zero.

Do not touch the sample with bare hands. Oil from hands could affect the accuracy of
results.
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8. Slowly add approximately 0.5 to 1.0 gram of sample to the sample container.
9. If a second piece of quartz wool or filter disc was inserted, remove the top portion of the quartz

wool or the filter disc from the sample tube.
10. Use a funnel to slowly pour sample from the container into the sample tube on top of the

quartz wool in the tube.

Ensure all sample in the container is placed in the sample tube to avoid errors caused by
incorrect samplemass.

11. If using quartz wool, insert the top portion of quartz wool into the tube and press it down. If
using filter discs, insert the filter disc into the tube and press it down.

Ensure the disc is flat on top of the sample. A seal must be created around the edge to
prevent the sample from escaping.

12. Wipe the top of the sample tube with a lint-free cloth, such as a Kimwipe®, to remove any
quartz wool that may have adhered to the surface.

13. Weigh the sample tube set containing the sample and the stoppers. Record thismass as the
Sample + tube.

Use Quartz Filter Discs for Chemical Adsorption

The equipment images in this document may differ slightly from your equipment, how-
ever the instructions are the same unless otherwise noted.

The use of quartz wool is not mandatory, however it can provide extra protection for light
powdered samples.

Wear latex gloveswhen handling the quartz sample tube. The natural oils in human skin
can chemically damage and weaken the quartz tube. It is also important that the sample
tube and its components, as well as the sample and exhaust ports, be clean and free of
debris. Dust particles from quartz wool or the insulator disc of previous analysesmay
adhere to the port and/or components, preventing a proper seal of the sample tube.

Use quartz filter discs or quartz wool to aid in chemical adsorption sample preparation. Quartz filter
discs (placed both below and above powdered samples) not only provide amore uniform sample
surface but also keep the analyzer free of sample debris. The filters can be used up to 900 °C.

1. Insert a small portion of quartz wool into the sample tube to serve as a support for the
powdered sample. Use a filler rod or smaller sample tube to push the quartz wool to the

Determine the SampleMass
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5 Perform an Analysis

bottom of the sample tube.

2. Insert a quartz disc into the sample tube and push it into the tube until it rests on top of the
quartz wool. Inspect the disc to ensure that there is a good seal and that the sample will not go
past the filter. An additional filter can be inserted if needed.

3. Insert a second filter disc on top of the quartz wool. Ensure that the filter is placed high enough
into the sample tube for easy retrieval.

4. Take the initial tube weight (with both filters).
5. Remove the top filter disc. Place it on a clean surface, then use a funnel to add the powdered

sample on the bottom filter disc.
6. Reinsert the top filter disc into the sample tube, then use a rod or smaller sample tube to push

it down until it reaches the top of the sample.
7. To remove the quartz wool and disc after analysis, use the quartz wool extractor tool.

SAMPLE TUBE INSTALLATION

See:

Sample Tube on page 9-23
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FILL AND INSTALL THE DEWAR

See also:

l Dewar Precautions on page 5 - 4
l Check and Clean the Dewar on page 10 - 13

To surround the cold trap, the dewar must rest on a small stand. Hold the dewar beneath the cold
trap, then raise it enough to slide the stand underneath the dewar. Lower the dewar until it rests on
the stand. Ensure the cold trap is immersed.

If performing an analysis that requires use of the cold trap and cryogen, check the cryogen level in
the dewar. It should be approximately 25mm (1 in.) from the top.

The cryogenmust not be cold enough to trap the carrier gas or analysis gas. Do not use
liquid nitrogen with argon carrier gas. For example, use an alcohol and liquid nitrogen
slurry (-80 ºC).

Fill and Install the Dewar
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5 Perform an Analysis

PERFORM A SAMPLE ANALYSIS
Unit [n] > Sample Analysis

See also:

Analysis Tutorials on page 11 - 1

1. ClickBrowse to select or clickNew to create a new sample file.

2. Edit theMass, Empty Tube, andSample + Tube fields as needed.
3. ClickNext and select a calibration file for each experiment.

4. ClickNext and read the warnings.
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5. ClickStart to begin the analysis.

TheOperation view displays experiment steps and details as steps are performed. To change
steps that have not been started, click theSuspend button, select the step, then click the
appropriate button for modification. ClickResume to continue the analysis.

6. Select theResults view to see the analysis in progress.

Perform a Sample Analysis
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5 Perform an Analysis

Click the Live Graph Settings button to hide or show different settings.

RESET THE ANALYSIS
Unit [n] > Reset
Use to abort the current analysis and return the analyzer to a safe state. The following actions occur:

l All gas flows stop
l The detector is disabled
l The heat zones are reset to 0 °C
l The target furnace temperature is reset to 20 °C

Do not select this option unless you are sure you want to stop the current analysis. The analysis
cannot be resumed afterReset is selected.
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6 ABOUT REPORTS
Reports > Open Report > [.REP file]
Opens a saved report.

Reports > Close Reports
Closes all open reports. This option is unavailable if reports are being generated.

Reports > Start Report
Generates a report on a sample analysis.

Reports can be generated for data collected on a sample that has completed analysis, collected on a
sample currently being analyzed, or manually entered.

6 About Reports
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6 About Reports

INTERACTIVE REPORTS
When opening a sample file that contains data from a complete or in-progress analysis, the
interactive reporting feature is enabled.

1. When opening a sample file that contains analysis data, a plot of the data collected during ana-
lysis will display.

2. From the drop-down list at the bottom of the window:

l change the option presentation of the sample information window to either Basic or
Advanced to modify certain file parameters, or

l select another plot from the list and edit the data contained in the plot.

3. When ranges are edited, the changes are reflected immediately in the plots and the summary
data displayed in the window. Some editing options are:

l Drag the blue bars to increase or decrease the range of data included in the plot.
l Right click to display a popupmenu to include reports; enable or select overlays; edit
curves, axes, legends, titles; and copy and paste the data in a graph or in tabular format.

4. ClickSave.

MICROACTIVE REPORTS
MicroActive reports are generated automatically after an analysis is performed. This feature
provides a quick and easyway to investigate andmanipulate analysis data using a variety of
reportingmethods.

When a sample file with a status ofComplete or Analyzing is opened, a linear plot and log plot of the
data collected during analysis are displayed aswell as a summary of the analysis giving the total pore
volume. Numerous reports are accessible from a drop-downmenu.

When a report is opened, plots and summary data are displayed, and in some reports certain
parameters are also displayed. Plotsmay be edited by selecting the data points or data point range
to be included in the plots andmodifying the parameters. When a report is edited, the results are
immediately reflected in the plots and summary data.
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PEAK EDITOR
ThePeak Editor feature provides the viewing and editing of up to 16 dynamic analysis experiments.
ThePeak Editor options are accessed by selecting a sample file that contains at least one
experiment with signal data from the drop-downmenu at the bottom of the report window. Peaks
can be defined, edited, or deleted.

Peaks are defined by a baseline. If the Find All Peaks button is clicked (enabled when Edit Peak is
selected), thePeak Editorwill define baselines for all positive peaks detected according to the
Integration window accessed from the Integration button. The baseline can bemanually defined by
double left clicking in the signal graph on the starting baseline point (this places the Peak Editor into
baseline creationmode). The ending baseline point is then defined by left clicking in the signal graph
on the ending baseline point. Baseline creationmode can be exited by right clicking in the signal
graph.

PEAK EDITOR VIEW

See also:

Open a Sample File on page 3 - 4

When a sample file with aComplete status is opened, three views are available:

l Overlay Experiments View
l Stacked Experiments View
l Peak Editor

To change the view, select the view from the drop-down list at the bottom of the graph window. Only
thePeak Editor view allows editing of the experiment.

Peak Editor
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6 About Reports
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6 About Reports

Field or Button Description
Calibration [button]

Calibration.Select a previously defined calibration file. If the
experiment carrier gas and the calibration carrier gas differ, a warning
displays. The system also compares the experiment flow rate and
calibration flow rate. If they differ, a warning displays.

Experiment Information.

l Description.Enter a description of the current experiment.
l Type of analysis. Select the analysis type that most closely
describes the current experiment. This will affect what is reported
as part of the Summary report data and the available reports.

l Loop volume.Displays the volume of the gas injection loop.
l Ambient temperature. Displays the ambient temperature entry
from theOptions > Environmental Defaults setting. This field
may be edited, if necessary.

l Atmospheric pressure.Displays the atmospheric pressure entry
from theOptions > Environmental Defaults setting. This field
may be edited, if necessary.

l Active concentration.Displays the percent of the gasmixture
which is composed of the reactive gas versus an inert filler. This
value is used for pulse chemisorption data reduction.

l P0 of adsorbate.Displays the saturation pressure of the
adsorbate.

l Manual Injections.Displays the injection settings entered during
analysis. This tablemay be edited, if necessary.

Create Calibration. Create a signal calibration from the currently
selected experiment.

Peak Editor Fields and Buttons Table
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Field or Button Description
Delete All [button]
Delete All Peaks [button]
Delete Peak [button]

Clears all peaks from the table and removes all markings from the
peaks.

To delete a single peak, select the peak from the peak table or left click
the peak to enable theDelete Peak button.

Delete All is available only when the Fit Peaks selection is enabled.

Delete All Peaks is available only when theEdit Peaks selection is
enabled.

Delete Peak is available only when the Fit Peaksselection is enabled.
Delete Baseline [button] Removes the baseline from the graph.

Available only when the Fit Peaks selection is enabled.
Display Options
[group box]

Use to change how the data are displayed.

Zero. Select to zero the signal (starting baseline).

Invert. Select to invert the signal (peak).

Hide Peak Marks.Select to hide all marks from peaks.

Smooth.Select to smooth the signal on the display.

l Order andWindow. Enabled when theSmooth checkbox is selec-
ted. The smoothing process uses the Savitzky-Golay filter to fit a
polynomial order n into size of the specified window [m].

Find All Peaks [button] Defines baselines for all positive peaks detected according to the
Integrationwindow, accessed via the Integration button.

Find All Peaks automatically detects the peaks and draws the
baseline for detection. Place the cursor over one of the baseline end
points and double left-click to grab the baseline. Move the cursor to the
new position and right click. Available only when theEdit Peak
selection is enabled.

Peak Editor Fields and Buttons Table (continued)

Peak Editor
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6 About Reports

Field or Button Description
Gaussian
[drop-down box]

Standard Gaussian curve. Available only when the Fit Peaks selection
is enabled.

Import M.S. [button]
Remove M.S. [button]

Mass spectrometer data can be imported and overlaid in theOverlay
Experiment view. In thePeak Editor view, it is saved as a separate
signal.

Import M.S. Click to import mass spectrometer data. In the bottom
right-hand corner of the pop-up window, select the type of mass
spectrometer file to import (Quadera, Quadstar, MKS, or TAMS) .
Select the file, then clickOpen to import the signals.

A popup window prompts the user to sync the temperature data with
the current experiment temperature data.

Remove M.S.Click to remove all previously importedmass
spectrometer signals from the current experiment.

Import standard peaks
[button]

Imports the saved peak parameters from theEdit Peaks view.

Available only when the Fit Peaks selection is enabled.
Integration Options
[button]

SeePeak Detection / Integration Options on page F - 1.

Available only when theEdit Peak selection is enabled.
Interpolate Tem-
perature [check box]

Select to interpolate the temperature. ClickRange to specify a
temperature range. Slide the blue bars on the graph to indicate the
range.

Peak Editor Fields and Buttons Table (continued)
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Field or Button Description
Log Normal Skewed
[button]

A 4-parameter, log-normal shape that allows for skewed peaks. This is
the default peak. Available only when the Fit Peaks selection is
enabled.

Peak fit model
[button]

Select the peak shape.

Available only when the Fit Peaks selection is enabled.

Gaussian.Standard Gaussian curve.

Log Normal Skewed. A 4-parameter, log-normal shape that allows
for skewed peaks. This is the default peak.

Sample mass
[text box]

The samplemass field is auto-filled with the samplemass from the
sample file being used.

Snap to Signal [button] Places the selected baseline point on the signal curve.

Stoichiometry [button] SeeActive Metals for Chemical Adsorption on page 3 - 5.

View Type [group box] Edit Peak. Locates peaks via signal integration over a baseline.

Fit Peaks. Locates peaks via function fitting tominimize residual over
a baseline.

Peak Editor Fields and Buttons Table (continued)

Peak Editor
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6 About Reports

REPORT FEATURES AND SHORTCUTS
Reports can be customized andmanipulated using the toolbar, shortcut menus, the zoom feature, or
axis cross-hairs.

l After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.
l The report zoom feature provides the viewing of fine graph details and the ability to shift the axes.
l All reports contain a header displaying file statistics.

If configured, the report header can also contain a graphic and/or a title.

l Tabular and graphical reports contain sample and analyzer statistics such as analysis date/time,
analysis conditions, etc.

l The headers contain notes of sample file changes occurring after analysis.
l Summary report headers contain the same information as tabular and graphical reports with the
exception of notes.
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REPORT HEADER SHORTCUTS

Display header shortcuts by right clicking in the report header.

Field or Button Description
Copy header as text Use to copy the report header as text. Text is copied to the clipboard

and then can be pasted into other documents.
Edit Use to edit the report title and/or graphic in the report header.

Report header Shortcut Field and Button Table

Report Header Shortcuts
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6 About Reports

REPORT TOOLBAR

TheReportwindow has a toolbar on the right portion of the window and selectable tabs at the top of
the report header. To view a specific report, either select the tab or the report in theReports list box,
then clickShow.

Field or Button Description
Default Style [button] Specify default report parameters for fonts and curve properties.

Delete [button] Deletes the selected report in theReports list box. Deleted reports will
have to be regenerated if deleted in error.

Hide [button] Hides (or temporarily removes) the selected report from the tabbed
view. The report name remains in theReports list box.

Print [button] Displays thePrintwindow for report output.

Reports [group box] Contains a list of all generated reports. The same reports display as
tabs at the top of the report header unless the report has been hidden
using theHide button.

Show [button] Displays the selected or hidden report in theReports list box.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Report Toolbar Fields and Buttons Table
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TABULAR REPORT FEATURES AND SHORTCUTS

Display tabular report shortcuts by right clicking in the body of the tabular report. Column shortcuts
require right clicking on the column to bemodified.

Field or Button Description
Align column Select to change the column alignment to either left, right, or centered.

Copy table as text Use to copy the report contents to the clipboard as tab-delimited text. It
can then be pasted into another document.

Edit title Use to edit the report title and/or title font attributes. ClickFont to
modify font attributes.

Move column Right click the column to bemoved. SelectMove column on the short-
cut menu and select Left orRight for themove.

Rename column Right click the column to be renamed. SelectRename column on the
shortcut menu and enter the new column name.

Resize column Right click the column to be resized. SelectResize column on the short-
cut menu and enter the new columnwidth in inches.

Show column Displays a list of all columns. Click a column to add a checkmark to
show the column or remove the checkmark to hide the column.

Table data font Right click in the report data. Select Table data font on the shortcut
menu.

Table header font Right click in the report data. Select Table header font on the shortcut
menu.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Tabular Reports Shortcut Options and Descriptions Table

Tabular Report Features and Shortcuts
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6 About Reports

GRAPH FEATURES AND SHORTCUTS

Right click in the graph area to display graph report shortcuts.

Field or Button Description
Autoscale all axes Returns the report to full view after using the zoom feature.

Edit axis Use to edit the selected axis properties.

Autoscale minimum / maximum. [check box] Tomanually
specifyminimum / maximumautoscale, deselect the option and
enter the new amount in the text box.

Grid lines.Use to change how to displaymajor / minor grid lines.

Invert scale. Use to invert the scale.

Linear / Logarithmic.Select the option to scale the graph as
linear or logarithmic.

Scale font. Use tomodify the font for the scale label. Deselect
Use default font to enable font options.

Graph Shortcuts Options and Description Table
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Field or Button Description
Title.Use to edit the selected axis label.

Title font.Use tomodify the font for the selected axis label.
Deselect Use default font . Select new font attributes for report
data. EnableUse default font to reset default fonts.

Edit curve Use to edit selected curve properties.

Color.Click to change the curve color.

l Curve.Use to change the interpolation, point style and pen
style for the selected curve. These options are disabled ifUse
default fill style is selected in theHistogram group box.

l Histogram. Enabled only ifHistogram is selected in theStyle
drop-down list. Use to specify the type of fill, fill color and label
position for the selected curve.

Label.Select where the graph point labels will display (left, right,
center, etc.) on the SPC report.

Style.Use to select another style for the collected data curve.

Title. Use to change the title of the selected curve.

Use default thickness.Uses the default curve thickness.
Deselect to enter a new thickness number in the Thickness text
box.

Graph Shortcuts Options and Description Table (continued)

Graph Features and Shortcuts
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6 About Reports

Field or Button Description

Edit legend Use to change the legend location and font.

Edit title Use to change the graph title and font.

Reset axis limits to initial
setting

Removes the cross-hair and returns the graph back to the initial
setting.

Show curve Displays a list of all curves. Select the curve(s) to display.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Graph Shortcuts Options and Description Table (continued)
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Axis Cross-Hair

Left click on the graph to view the cross-hair coordinates.

Graph Features and Shortcuts
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6 About Reports

Graph Grid Lines

Options > Graph Grid Lines

Use to select how grid lines appear on reports. Thismenu option is not available if usingRestricted
option presentation.

Field or Button Description
Grid Line Styles
[selection]

Select if themajor and/or minor grid lines should appear as solid or dot-
ted lines.

X-Axis / Y-Axis
[selection]

Select major and/or minor lines to display in reports for the logarithmic
and linear scales. Deselect this option to remove the grid lines.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Graph Grid Lines Fields and Buttons Table

Zoom Feature

Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the
graphical area to be enlarged. A boxwill display in the area to be enlarged. To return to normal view,
right click in the graph and selectAutoscale all axes.
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REPORT EXAMPLES

FIRST ORDER KINETICS REPORT

Report Examples

MicroActive AutoChemHP 2950Operator Manual
295-42830-01 (Rev -) — Jan 2018 6 - 19



6 About Reports

PRESSURE VS TEMPERATURE
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SIGNAL VS TEMPERATURE

Signal vs Temperature
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6 About Reports

SIGNAL VS TIME
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7 SELECTED REPORTS

To edit reports, open theSample file. Select theReport Options tab, then highlight the
report name in theSelected Reports list box. ClickEdit.

Log in to your customer portal to accessMicroActive Report Tutorials.

ADVANCED REPORT OPTIONS

Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports a
"mic" Pythonmodulemust be created. SeeAdvanced Reports - Python Module on page A -
1 for an example of Python script and functions for the "mic" Pythonmodule.

1. Create the Python script and save it in theScripts directory.
2. Open a sample file with aComplete status.
3. SelectAdvanced in the drop-down list at the bottom of the window to return to the tabbed

view.

4. In theSelected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in theAvailable Scripts box.

5. On theReport Options tab, clickPreview. The Python Reports will be included on the tabs
across the top portion of theReportswindow.

7 Selected Reports
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7 Selected Reports

Field or Button Description
Add [button] Click to add additional Python reports.

Available Scripts
[group box]

Lists the available reports and provides the option to add, replace, edit
or remove reports.

Overlay samples (if
shown) [check box]

Use to overlay samples as defined by the function.

Advanced Report 1
through 5
[drop-down box]

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Advanced Report Options Fields and Buttons Table
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BET SURFACE AREA REPORT OPTIONS

Field or Button Description
Selected Experiments
[group box]

Displays all related experiments in the current file. Deselect report
options to exclude from the experiment. If this is a new file, no exper-
iments are listed. Experiments are not included in the list until BET
data are collected.

Report Type [group box] Select the report types to generate.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

BET Report Options Fields and Buttons Table

BET Surface Area Report Options
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7 Selected Reports

FIRST ORDER KINETICS REPORT OPTIONS

Field or Button Description
Plot [check box] Select to have the report formatted in a graph format.

Selected Experiments
[group box]

Displays all related experiments in the current file. Only experiments
with collected data are shown.

Tabular Report
[check box]

Select to have report formatted in table format.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

First Order Kinetics Report Options Fields and Buttons Table
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GRAPH REPORT OPTIONS

l Concentration vs Time
l Concentration vs Temperature
l Pressure vs Time
l Pressure vs Temperature

l Signal and Pressure vs Time
l Signal vs Temperature
l Signal vs Time
l Temperature vs Time

Any signal (the detector signal or the 1 or 2 auxiliary signal) may be plotted against time or
temperature. Any signal can be overlaid onto the primary signal.

For color output to amonitor or printer, signals are displayed in different colors. For black and white
output, different symbols are used.

Field or Button Description
Options [button] Enabled when theShow peakmarks option is selected.

Lists the peaks for the results of the highlighted experiment. Select any
(or all) peaks to include in the graph.

Graph Report Options Fields and Buttons Table

Graph Report Options
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7 Selected Reports

Field or Button Description

Select the peak labels to display on the graphs.
Selected Experiments
[group box]

Displays all related experiments in the current file. Only experiments
with collected data are shown.

This option is disabled for new files.
Show peak marks
[check box]

l Enables theOptions button to specify the peaks to include in the
experiment

l Displays the areas and baselines on the graph
l Draws a straight baseline between the selected peaks

X-axis [group box] SpecifyTime or Temperature for the X-axis variable.

Autoscale.When enabled on the report parameters windows, allows
the x- and y- axes to be scaled automatically.Autoscalemeans that the
x- and y- rangeswill be set so that all the data is shown. If Autoscale is
not selected, the entered range is used.

Y-axis [group box] SpecifyTime or Temperature for the Y-axis variable.

Autoscale.When enabled on the report parameters windows, allows
the x- and y- axes to be scaled automatically.Autoscalemeans that the
x- and y- rangeswill be set so that all the data is shown. If Autoscale is
not selected, the entered range is used.

Overlay.Select to overlay another variable with the current one.

Variable. Select a Y-axis variable from the drop-down list.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Graph Report Options Fields and Buttons Table (continued)
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LANGMUIR REPORT OPTIONS

See:

BET Surface Area Report Options on page 7 - 3.

Langmuir Report Options
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7 Selected Reports

LOOP CALIBRATION REPORT OPTIONS

Field or Button Description
Selected Experiments
[group box]

Displays all related experiments in the current file. Only experiments
with collected data are shown.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Loop Calibration Report Options Fields and Buttons Table

OPTIONS REPORT
Produces a printed report of predefined collection of sample file parameters

Options reports cannot be edited.
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PULSE CHEMICAL ADSORPTION REPORT OPTIONS

Field or Button Description
Area to Volume Con-
version
[group box]

Calculated.Uses the standard calculation and the raw signal.

Calibrated.Uses selected peaks for the conversion. A calibration step
must be included in the experiment to use thismethod.

Selected Experiments
[group box]

Displays all related experiments in the current file. Only experiments
with collected data are shown.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Pulse Chemical Adsorption Report Options Fields and Buttons Table

SAMPLE LOG REPORT
Inserts a log of sample operations in the reports.

Sample Log reports cannot be edited.

Pulse Chemical Adsorption Report Options
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7 Selected Reports

SUMMARY REPORT OPTIONS

TheSummaryReport for dynamic analyses provides a condensed summary of the peaks and
selected analysis parameters.

TOTAL PORE VOLUME REPORT OPTION

Field or Button Description
Selected Experiments
[group box]

Displays all related experiments in the current file. Deselect report
options to exclude from the experiment. If this is a new file, no exper-
iments are listed. Experiments are not included in the list until BET
data are collected.

Adsorbate density con-
version factor [text box]

Enter the appropriate value for converting the gas volume to liquid
volume. This value can be obtained by dividing the gas density by the
liquid density at the adsorption temperature.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Total Pore Volume Report Options Fields and Buttons Table
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8 CALIBRATION
Unit [n] > Instrument Calibration
A calibration file was created specifically for the analyzer and included with the accessories. It is not
necessary to recalibrate the system unless it seems out of calibration.

Disabled calibrationmenu options can be accessed only with the assistance of an authorized
Micromeritics service representative. Calibrations can be saved to a file and reloaded later.

Generally it will not be necessary to change the data in the calibration file. However, if a condition
occurs during the operational verification that requires changes to the calibration data, changes
should be saved in a file. Calibration data files are retained in the analyzer history file and can be
reloaded in the event that calibration data becomes corrupt.

Field or Button Description
Accept [button] Replaces the existing calibration valueswith those entered.

Load from File [button] Use to load a different calibration file. See Load Calibration from
File on page 8 - 8.

MFC Full Scale [button]

Calibration Fields and Buttons Table

8 Calibration
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8 Calibration

Field or Button Description
Displays the full scale flow rate for themass flow controllers. The full
scale was determined using H2 as the calibration gas.

Save to File [button] Use to save the current calibration settings to a file. SeeSave Cal-
ibration to File on page 8 - 8.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Calibration Fields and Buttons Table (continued)

8 - 2 MicroActive AutoChemHP 2950Operator Manual
295-42830-01 (Rev -) — Jan 2018



GAS FLOW CALIBRATION
Unit [n] > Gas Flow Calibration

See also:

l Gas Charts on page E - 1
l Gas Flow Constant Calibration Worksheet on page H - 3

Use theGas Flow Constant Calibration option to determine a constant used by the analyzer to
ensure accurate gas flows through eachMass Flow Controller (MFC). TheMass Flow Controllers
were calibrated before shipping and calibration is typically not necessary.

1. Go toUnit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go toUnit [n] > Show Instrument
Schematic. Flow the gas to be calibrated throughMFC to be used for the calibration.

2. Connect a flow meter to the exhaust andmeasure the actual flow rate.
3. In theGas drop-down box, select the gas to be flowed. In theActual flow field, enter the actual

flow rate to compute themass flow constant.
4. ClickAccept to change themass flow constant in theAdsorptive Properties for the gas to be

the computed value.

Gas Flow Calibration
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8 Calibration

SIGNAL CALIBRATION
Analyses yield data on signal reading, peak area, temperature, and time. These data are sufficient
for many applications, however volume datamay also be needed.

It is not necessary to perform a calibration if volume data are not needed. If volume data are needed,
calibrationmay be performed either before or after the analysis.NOTE: This doesnot apply to loop
calibration, ambient temperature, and atmospheric pressure.

A group of automatic calibration routines are provided in the form of specialized experiment steps. A
calibration run is an analysis using one of these experiment steps. The calibration run can be
performed before or after the sample analysis and can be included as a step within the analysis, or it
can be performed as a separate analysis.

After the sample data and calibration data are collected, the calibration file is associated with the
sample file, and the sample data are converted to volume. A single calibration run can be associated
with an unlimited number of sample data files. For example— TPR yields peak area and the
temperature(s) at whichmaximum reduction occurs. To obtain the volume of gas uptake, a
calibration file must be associated with the analysis file, then reports are created in which the area
data are converted to volume data.

A calibration file can be associated with a sample file by:

l going toOptions > Signal Calibration > Defaults and selecting a default calibration file for
each experiment type,

l using the default file or choose a different file in theUnit [n] > Sample Analysiswindow.
l clickingSet Calibration on thePeak Editorwindow and select from a list of calibration files that
were created after the sample file was used in an analysis.

CREATE A NEW SIGNAL CALIBRATION FILE
Options > Signal Calibration > New

8 - 4 MicroActive AutoChemHP 2950Operator Manual
295-42830-01 (Rev -) — Jan 2018



When selecting aSignal Type and Type of Calibration, only those options used in the original
analysis are enabled on the right side of the window.

1. Select the sample file to be used for the new signal calibration file.
2. Select theSignal Type and Type of Calibration options to include in the new calibration file. As

these selections aremade, the experiments from the selected analysis file display on the right
side of the window. Only those experiments applicable to the selected signal type and cal-
ibration type are enabled. ClickOK.

3. If prompted, enter the active gas concentration in the carrier gas and in the loop gas. ClickOK.

Field or Button Description
Degree [drop-down box] Select the power to display in theCoefficients list.

Delete Peak [button] To remove a peak from the peak table, select the peak and click
Delete Peak.

Description [text box] Enter a description of the file.

Include origin
[check box]

Enables or disables the original in the graph.

Load Calibration Data
[button]

Use to enter calibration data from a selected file.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Signal Calibration Fields and Buttons Table

Repeat this process for each gas concentration in the calibration. For example— if gas
concentrations of 10%, 20%, and 30% are used, mark the calibration peaks and create calibration
files for each concentration.

Signal Calibration
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8 Calibration

Calculation used for peak volume:

For example, calculations for 1 cm3 injection, ambient temperature of 22 °C, ambient pressure of
740mmHg:

CREATE A SIGNAL CALIBRATION REPORT
Options > Signal Calibration > Report

Select a previously defined signal calibration file from the drop-down list, then select the print
destination.
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OPEN A SIGNAL CALIBRATION FILE
Options > Signal Calibration > Open
Select a previously defined signal calibration file from the drop-down list. If a calibration file already
exists, select the serial number from the drop-down serial number list. When a new calibration file is
saved using a new serial number, the new serial number displays in theSerial Number drop-down
list.

If this is the first calibration file to be saved, theSerial Number drop-downwill not display until the first
calibration file is saved.

LIST SIGNAL CALIBRATION FILES
Options > Signal Calibration > List

Displays a list view of previously defined signal calibrations for the selected serial number.

Signal Calibration
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8 Calibration

LOAD CALIBRATION FROM FILE
Unit [n] > Instrument Calibration > Load from File [button]
Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved usingUnit [n] > Instrument
Calibration > Save to File prior to loading another calibration file. When loading a previously saved
calibration file, a backup of the current file is created and saved as [SN]last.cal. The backup file is
overwritten each time a new one is created.

Changing the calibrationmay affect the analyzer’s performance.

SAVE CALIBRATION TO FILE
Unit [n] > Instrument Calibration > Save to File [button]
Use to save the current calibration settings to a backup file which can later be reloaded using the
Unit [n] > Instrument Calibration > Load from Filemenu option.

The default file naming convention for calibration files can be used or the file name can be changed.
The default file name of 0217-2013-04-25.CAL is interpreted as:

0217 is the analyzer serial number
2013-04-25 is the date the calibration file was saved
.CAL is the file name extension
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9 HARDWARE

COLD TRAP TUBE OR DELAY PATH
A Cold Trap option is available. Parts and accessories can be found online at
www.Micromeritics.com.

The cold trap or delay path is installed in the ports located under the top panel, to the left of the
sample tube ports.

A cold trap is used to condense liquids out of the gases flowing through the analyzer before reaching
the detector.

A delay path is used to reduce the perturbation (disturbance) of the gas flow caused by injections of
gas through the septum.

1. Insert the open ends of the cold trap or delay path into the openings under the upper panel. If
difficult to insert, loosen the attachment nuts by unscrewing them slightly.

9 Hardware
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9 Hardware

If the nuts are loosened until they become free of the analyzer, theywill fall out of the ana-
lyzer.

2. Press the cold trap or delay path up into the analyzer until it comes to a stop.Securely tighten
the fittings.

Do not overtighten the fittings. A sufficient seal is achieved when the fittings are finger-
tight.

3. The use of a dewar reduces the temperature of the cold trap. To use a dewar:
a. Fill the dewar with the appropriate coolant.
b. If using the dewar shelf, hook the shelf on the front of the analyzer and slide the shelf to

the right. Position the dewar beneath the cold trap and raise the dewar until the shelf can
bemoved to the left underneath the dewar. Lower the dewar to rest on the shelf.

c. If using the dewar stand, position the dewar beneath the cold trap and raise the dewar
until the stand can bemoved underneath the dewar. Lower the dewar to rest on the
stand.

d. Ensure the cold trap is completely immersed in the coolant.
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CHANGE OR CLEAN THE COLD TRAP OR DELAY PATH
The cold trap removes condensibles from the gas stream, therefore it will require occasional
cleaning. The delay path (used for BET analyses) also attaches to the cold trap port fittings.

1. If a dewar is around the cold trap, raise the dewar slightly, move the dewar stand out of the
way, and remove the dewar. Allow the cold trap to warm to room temperature.

Depending upon the state of the analyzer, the cold trap fittingsmay be hot. Use caution.
If necessary, wear cotton gloves to protect your hands.

2. Go toUnit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go toUnit [n] > Show Instrument
Schematic.Right-click on the cold trap valve and selectBypass.

3. Loosen the retaining nuts on the cold trap port fittings.

4. Remove the cold trap (or delay path), nuts, ferrules, andO-rings.
5. Clean the cold trap (or delay path) by flushing it with isopropyl alcohol (IPA). Dry the trap in an

oven or by blowing compressed air or nitrogen through it before replacing it.
6. Inspect the O-rings for cracks or other damage that might cause leaks. If the O-rings are

cracked or damaged, replace them before reinstalling the cold trap (or delay path). Otherwise,
clean, dry, and re-install the O-rings.

Cold Trap Tube or Delay Path
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9 Hardware

Use only KalrezO-rings. Kalrez is rated for both chemical and temperature suitability in
this application. O-rings of other materials could burn, melt, or decompose.

7. Place the retaining nuts, ferrules, andO-rings on the cold trap (or delay path).

Do not over tighten the retaining nuts. Doing somay damage theO-rings. Finger-tight is
sufficient.

8. Hold the cold trap (or delay path) in place and tighten the retaining nuts. Tighten the nuts only
enough to hold the cold trap securely in place and prevent leaks.
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FURNACE
When performing BET analyses, the furnacemust be removed to allow placement of a cold bath
dewar around the sample.

The equipment images in this document may differ slightly from your equipment, how-
ever the instructions are the same unless otherwise noted.

FURNACE REMOVAL
1. Unplug the furnace power plug and the thermocouple cable from the analyzer.

2. Open the latch, then open the furnace.

If used recently, parts of the furnacemay be hot. Use the cotton gloves provided with the
analyzer to protect your hands.

Furnace
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9 Hardware

3. Gently lift the right side of the furnace until it is free from the support post.

4. Lower the furnace, moving it away from the support post until it is free of the retaining knob.
5. Close the furnace and secure the furnace latch. Place the furnace in a location where it will be

protected from damage.

9-6 MicroActive AutoChemHP 2950Operator Manual
295-42830-01 (Rev -) — Jan 2018



FURNACE INSTALLATION
1. Hold the open furnace next to the support post. Raise the furnace, moving it above the support

post until the retaining knob is inserted in the hole in the top of the furnace.

2. When the retaining socket on the bottom of the furnace is located above the support post,
gently lower the furnace until it rests securely on the post.

3. When ready to begin the experiment, close the furnace around the sample tube and secure
the latch.

4. Plug the thermocouple cable and the furnace power cable into the appropriate connectors on
the analyzer. These connectors are located on the recessed front panel.

Furnace
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9 Hardware

KWIKCOOL
A KwikCool unit allows the furnace to cool quickly between analyses.

1. Power OFF the analyzer.
2. Attach the KwikCool cable to the connector labeledSub Ambient Cooler on the front panel of

the analyzer.
3. Attach the tubing provided to the inlet on the front of the furnace.
4. Attach a supply of dry house air (or nitrogen) to the gas inlet on the front of the KwikCool. The

pressure is indicated next to the inlet.
5. Fill a dewar with an ice water bath.
6. Place the KwikCool on top of the dewar.

7. Power ON the analyzer and start the analysis application.
8. In the experiment, select theEnable KwikCool option in the Temperature Rampwindow.
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KWIKCOOL VORTEX INSTALLATION

The optional KwikCool Vortex uses compressed air to generate a sub ambient supply of air to the
furnace to allow rapid cooling.

This kit includes:

l 1 KwikCool unit
l 1 Clear urethane tube to connect to clean dry compressed air
l 1 Swagelok fitting to connect the Vortex Cooler to the urethane tube for the supply of clean dry
compressed air

To install the KwikCook Vortex:

1. Connect the KwikCool Vortex electrical cable to the front panel of the analyzer at the con-
nector labeledSub Ambient Cooler.

2. Push the flexible hose from the front of the KwikCool Vortex onto the short metal tube at the
center front of the furnace.

3. Connect the compressed air tubing to the Swagelok fitting and then connect the Swagelok fit-
ting to the 1/4 in. tube on the front of the KwikCool Vortex.

4. Connect the other end of the compressed air tubing to any clean, dry compressed air supply,
at approximately 100 psig. Do not exceed 120 psig.

Do not exceed 120 psig. The KwikCool Vortex system uses about 2 cfm of air when run-
ning. Nitrogen or other inert gasmay also be used. If a gas cylinder is used, the
KwikCool Vortex will consume the cylinder of gas quickly, depending on the cylinder
size.

5. Restart the analyzer application so the application will recognize the new hardware.

KwikCool Vortex Installation
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9 Hardware

MASS FLOW CONTROLLER CALIBRATION

See also:

Gas Charts on page E - 1

The analyzer uses aMass Flow Controller (MFC) to control the flow of gases. TheMFC requires a
conversion constant for each gas or gasmixture to compensate for variations in gas flows resulting
from variations in the gas properties.

In most cases, the default MFC conversion constant yields accurate data. A new conversion
constant may be used if:

l A unique gasmixture is used
l The gas to be used is not included in the table
l A higher precision calibration of theMFC for a given gas is required
l Unexpected analysis data lead you to believe that the default value is in error

FLOW MEASUREMENT

An external device that measures the flow of gas from the analyzer’s exhaust is used duringMFC
calibration. A soap bubble burette is shipped with the analyzer. For evenmore precise calibration,
use another type of flow meter and follow these instructions for obtaining a new conversion constant,
substituting your flow meter for the soap bubble burette.

INSTALL THE SOAP BUBBLE BURETTE

The equipment images in this document may differ slightly from your equipment, how-
ever the instructions are the same unless otherwise noted.

These instructions are for assembling and using the burette supplied byMicromeritics. If
using another type of flow meter, follow themeter manufacturer’s assembly and oper-
ation instructions.

1. Carefully unwrap the glass tube and the rubber bulb.
2. Attach one end of the flexible tubing to the side arm of the glass tube.
3. Attach themetal tubing provided with the bubble burette to the other end of the flexible tubing.
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4. Locate the exhaust port that corresponds to theMFC to be used for this calibration. Remove
external plumbing from that port and attach the bubble burette using the connector provided
with the burette. For example, if using the Carrier Flow Controller, attach the bubble burette to
the carrier gas exhaust port.

5. Fill the rubber bulb with the contents of the 8 oz. bottle of the leak detector fluid included in the
accessory kit.

6. Attach the bulb to the bottom of the glass tube.

The soap bubble burette must be held in an upright position.

Install the Soap Bubble Burette
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9 Hardware

DETERMINE THE GAS FLOW CONSTANT FOR INDIVIDUAL GASES

Unit [n] > Gas Flow Calibration

1. Go toUnit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go toUnit [n] > Show Instrument
Schematic. Flow the gas to be calibrated through the Carrier gasMFC and sample tube.

2. Connect a flow meter to the exhaust andmeasure the actual flow rate. If using the bubble bur-
ette shipped with the analyzer, observe a bubble as it rises through the glass tube. The lines
on the glass tube indicate the beginning and ending points for measuring the progress of a
bubble through the tube. Use a stopwatch tomeasure the amount of time that elapses from
themoment the bubble passes the lower mark on the tube until themoment it passes the
higher mark on the tube.

3. Go toUnit [n] > Gas Flow Calibration and select the gas being flowed.
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4. Enter the actual flow rate in theActual flow field to compute themass flow constant.
5. ClickAccept to change theMass flow constant field in theAdsorptive Properties for the gas to

the computed value.
6. Attach the gas to be calibrated to an inlet port for theMFC to be used during calibration.
7. On the analyzer schematic, right click the Flow Controller icon. SelectSet Flow Rate, then

enter the flow rate. ClickOK.

Determine theGas Flow Constant for Individual Gases
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9 Hardware

SAMPLE THERMOCOUPLE

The equipment images in this document may differ slightly from your equipment, how-
ever the instructions are the same unless otherwise noted.

THERMOCOUPLE POSITION

The thermocouplemust be attached to the analyzer prior to running an analysis. There are three
possible configurations for the thermocouple:

l inside the sample tube
l inside the sample tube surrounded by a quartz sheath
l outside the sample tube

Best accuracy is obtained when the bare thermocouple is placed inside the sample tube. In some
cases, one or more of the gases used during the experiment may react with the thermocouple's
Inconel material. A quartz sheath is provided to protect the thermocouple when the gases or sample
used in the experiment may damage it. In this case, the sheath is placed around the thermocouple
and the thermocouple is positioned inside the sample tube.When placed inside the tube, the
thermocouple can be adjusted so that the end is located in the sample or just above it. Always try to
position the end of the thermocouple as close to the furnace thermocouple as possible.

Positioning the thermocouple along the exterior of the sample tube is less accurate than the other
configurations. If the thermocouple is placed outside the sample tube, ensure it is clamped against
the sample tube, and that the end does not extend below the point where the sample tube begins to
taper. SeeUse the Thermocouple Clamp on page 9-20.

1. Power OFF the analyzer, then disconnect the analyzer from the power source.
2. Press in on the right side of the retractable handle on the top of the analyzer to protrude the

handle. Use the handle to open the hinged top panel.
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3. Pull down the upper front panel.

4. The valve cover is held in place by two knobs or plungers. Remove the valve cover by pulling
the plungers outward until the valve cover is released. Pull the cover up and out.

5. Remove the insulation that surrounds the valve. The thermocouple ports are located toward
the front of the block.

The sample thermocouple and nearby componentsmay be hot. Allow the sample ther-
mocouple to cool before removing. Use the cotton gloves provided with the analyzer to
protect your hands. If the zone is not near room temperature, loosening or tightening the
fittingsmay damage the analyzer components.

Thermocouple Position

MicroActive AutoChemHP 2950Operator Manual
295-42830-01 (Rev -) — Jan 2018 9-15



9 Hardware

6. Use an open-ended wrench to loosen the sample thermocouple fitting.

The sheath is very fragile and can be easily broken. Because the sheath ismade of
quartz, cotton glovesmust be worn when handling the sheath. Oils from fingersmay
lower the quartzmelting point.

7. Adjust the thermocouple:
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To change the position: a. Loosen the fitting for the stainless steel plug in the alternate ther-
mocouple opening and remove the plug.

b. Remove the fitting that retains the sample thermocouple.
c. Move the sample thermocouple from its current position to the

new position.
d. Place the stainless steel plug in the unused thermocouple open-

ing and tighten the fitting. Reinstall the sample thermocouple
retaining screw.

If using the quartz sheath, perform the following before
proceeding. The sheath can only be used when the
thermocouple is being placed inside the sample tube.

i. Remove the ferrule from the thermocouple, straighten
the thermocouple asmuch as possible.

ii. Insert the thermocouple into the sheath.
iii. Place a larger ferrule around the sheath.

To adjust the length: SeeDetermine the length of the thermocouple on the next
page. Adjust the thermocouple wire up or down as needed.

8. Tighten the thermocouple fitting.
9. Place the insulation in its original position. Reinstall the valve cover.
10. Return the upper front panel and the top panel to their original closed positions.
11. Power ON the analyzer.

Thermocouple Position
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DETERMINE THE LENGTH OF THE THERMOCOUPLE

When adjusting the length of the exposed portion, consider the following:

l The end of the thermocouple should be aligned as closely as possible with the furnace ther-
mocouple.

l The end of the thermocouple should never be placed outside the painted (black), recessed area
inside the furnace.

l If the thermocouple is positioned inside the tube, its end should generally be located approx-
imately 2 to 3mm (1/8 in.) above the sample surface. In some cases, allow the thermocouple to
extend into the sample.

l If the thermocouple is positioned outside the tube, its end should not extend below the point
where the sample tube begins to taper.

METAL TUBES

When usingmetal tubes, it may be helpful to use the dipstick included with the analyzer accessories
to determine the appropriate length of the sample thermocouple. At times, a small amount of sample
may adhere to the dipstick. When using very small amounts of sample for an analysis, the amount
that adheres to the dipstickmay affect analysis results.

1. After inserting the quartz wool and sample into the sample tube, insert the dipstick into tube.
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2. When the dipstick reaches the sample, gently press down on the sleeve until it is flush with the
top of the sample tube.

3. Remove and invert the dipstick.

4. Place the inverted dipstick on the underside of the analysis port close to the thermocouple.
Place it on a flat surface and not into one of the openings in the port.

Determine the length of the thermocouple
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The end of the thermocouple should be 2 to 3mm (1/8 in.) above the exposed rod. If it is not, adjust
the thermocouple length as needed.

USE THE THERMOCOUPLE CLAMP

If the thermocouple is placed outside the sample tube, a clampmust be used to secure the
thermocouple to the sample tube.
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RECALIBRATE THE SAMPLE THERMOCOUPLE

See also:

Calibration on page 8 - 1

A calibration file is created specifically for each analyzer before the analyzer is shipped. This
calibration file is installed during installation. If the original calibration file is corrupted or missing, or if
the sample thermocouple is replaced, recalibration will be needed.

Do not attempt to calibrate anything other than the sample thermocouple without prior
approval from a qualifiedMicromeritics Service Representative.

Prior to recalibration, ensure:

l The analyzer is poweredON and the application is running.
l All heat zones to be calibrated are stabilized at ambient temperature.
l Familiarity with manually controlling the analyzer.
l All gas flows through the analyzer are stopped.
l The furnace is open and the sample tube is removed (the thermocouple is bare and exposed).
l A traceable thermocouplemeter and a water bath (ambient temperature) to immerse the sample
thermocouple are available.

1. Go toUnit [n] > Instrument Calibration.

2. Place the water bath around the thermocouple so that the lowest 25mm (1 in.) is immersed in
the water. Place the thermocouplemeter (reference thermocouple) parallel to the sample ther-
mocouple so that both thermocouples are at the same temperature.

3. After the reference thermocouplemeter reading stabilizes, enter the ambient temperature
reading in the Low Cal. field on the Instrument Calibrationwindow.

4. Remove the water bath. Move the tip of the reference thermocouple so that it touches the
sample thermocouple tip, yet allows the furnace to be closed.

Recalibrate the Sample Thermocouple
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5. Go toUnit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go toUnit [n] > Show Instrument
Schematic.Set the furnace target temperature to 1000 °C. Use a ramp rate of 50 °C/min.
Observe the schematic to ensure that both the furnace temperature and sample temperature
are increasing.

6. After the furnace and sample temperature have stabilized, enter the reading from the ref-
erence thermocouple in theHigh Cal. field on the Instrument Calibrationwindow.

7. Usemanual control of the furnace to return the temperature to ambient.
8. On the Instrument Calibrationwindow, clickAccept to save the new values. Make a backup

copy of the settingswhen prompted.
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SAMPLE TUBE

The equipment images in this document may differ slightly from your equipment, how-
ever the instructions are the same unless otherwise noted.

SAMPLE TUBE INSTALLATION

Ensure the furnace has cooled to ambient temperature before installing tubes. It is a
good practice to wear the cotton gloves provided with the instrument when installing
sample tubes.

Wear latex gloveswhen handling the quartz sample tube. The natural oils in human skin
can chemically damage and weaken the quartz tube. It is also important that the sample
tube and its components, as well as the sample and exhaust ports, be clean and free of
debris. Dust particles from quartz wool or the insulator disc of previous analysesmay
adhere to the port and/or components, preventing a proper seal of the sample tube.

Use only KalrezTM (or equivalent) O-rings. Kalrez is rated for both chemical and
temperature suitability in this application. O-rings of other materials could burn, melt, or
decompose.

Sample Tube
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9 Hardware

Item Description
A Retaining nuts

B Two part ferrule set

C O-ring with filter

D O-ring

E Stem seal (part 1)

F Stem seal (part 2)

G Seal frit

Sample Tube Parts

1. Carefully slide the sample tube retaining nuts and ferrules over the open ends of the sample
tube. The larger diameter nuts and ferrules should be placed on the larger side of the tube,
and the smaller diameter nuts and ferrules should be placed (narrow end down) on the smal-
ler side of the sample tube.

For quartz tubes, do not allow the nuts to slide down rapidly to the curved portion of the
tube. This could damage the tube.

2. Place anO-ring around each opening of the sample tube.
3. Remove any sample tube stoppers immediately before connecting the sample tube to the ana-

lyzer.
4. Insert the open ends of the sample tube into the openings under the upper panel, aligning the

thermocouple in the proper position. SeeSample Thermocouple on page 9-14.
5. Push the sample tube up into the sample port until it comes to a stop. Tighten the fittings by

turning the retaining nuts until finger-tight.

Do not overtighten the analysis port fittings— doing somay break the quartz sample
tube. TheO-rings are sealed when the fittings are finger-tight.

6. If the thermocouple is placed on the outside of the sample tube, clamp it to the tube. SeeUse
the Thermocouple Clamp on page 9-20.

7. Close and latch the furnace. The furnace will not heat unless closed. The pressure controller
will also be disabled when the furnace is open.
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SAMPLE TUBE REMOVAL

The furnace and sample tubemay remain very hot for some time after analysis has
ended. The sample tube retaining nuts are extremely hot, approximately 110 ºC. Use
extreme caution!

It is recommended to allow the furnace and sample tube to return to ambient temperature before
touching them. If the sample tube has cooled, use rubber gloveswhen removing it. If it is still hot, use
the cotton gloves provided.

1. Unlatch and open the furnace.

Support the sample tube retaining nuts so that they do not fall rapidly out of the analyzer.
Thismay damage the sample tube.

2. Loosen the sample tube retaining nuts, be very careful and support them. As the nuts are
loosened, support the sample tube and pull it gently down out of the analyzer. When the nuts
are sufficiently loose, the sample tube, retaining nuts, ferrules, andO-rings should slide out of
the analyzer. If necessary, use the extractor tool to pull the O-rings out of the ports.

3. Inspect the O-rings for cracks or other damage that might cause leaks. If the O-rings are
cracked or damaged, replace them before reinstalling the sample tube. Additional O-rings are
shipped with the analyzer. Otherwise, clean, dry, and re-install the O-rings.

Use only KalrezTM (or equivalent) O-rings. Kalrez is rated for both chemical and
temperature suitability in this application. O-rings of other materials could burn, melt, or
decompose.

Sample Tube Removal
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9 Hardware

SAMPLE TUBE FILTER OR O-RING REPLACEMENT

A frit filter is used to protect the analyzer internal components from contaminants that may be forced
out of the sample tube during an analysis. As the analyzer is used, the filter may gradually become
clogged with trapped particles. If the filter does become blocked, it must be removed and cleaned or
replaced. One indication of a clogged filter is a sample pressure greatly exceeding atmospheric
pressure. SeeShow Instrument Schematic on page 2 - 17. The nominal sample pressure
reading should be a few mmHg above atmospheric pressure

1. Loosen the analysis port fittingswhile holding the sample tube.

The sample tube and nearby componentsmay be hot. Allow the sample tube to cool
before removing it. Use the cotton gloves provided in the accessory kit to remove the
sample tube before it has cooled. Rubber glovesmay be used to handle the sample tube
when it has cooled.

2. Carefully remove the sample tube by unscrewing the retaining nuts. Do not allow the nuts to
slide down onto the curved portion of the sample tube or the tubemay break.

3. Remove the left (smaller) sample tube fitting (it has a tube within a tube).
4. Use a small diameter probe to remove theO-ring and frit filter disk from the sample tube fitting.
5. Install a new (or cleaned) analysis port filter in the sample tube fitting.
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Use only KalrezTM (or equivalent) O-rings. Kalrez is rated for both chemical and
temperature suitability in this application. O-rings of other materials could burn, melt, or
decompose.

6. Inspect the O-ring for cracks or cuts. If the O-ring is damaged, replace it with a new O-ring.
Otherwise, clean theO-ring, dry it, and place it in the sample tube fitting. Ensure the O-ring is
securely in place.

7. Place the left sample tube fitting back into position and tighten it slightly.
8. Reinstall the right sample tube fitting and sample tube, then tighten both fittings.

Sample Tube Filter or O-ring Replacement
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9 Hardware

SEPTUM

PROPER USE OF THE SEPTUM

The septum is used to inject quantities of gas into the analyzer.

Do not use the septum at pressures above ambient. Gasmay escape at elevated pres-
sures.

Accuracy of data is diminished when poor techniques are used for injecting gas through the septum.

Injecting the gas through the septum causes a peak to appear, but it also causes a perturbation in the
flow of gas through the analyzer. This perturbation is visible in the peak data. Tominimize this
perturbation, inject the gasmore slowly into the septum. Prolonging the injection causes the peak to
spread.

An injectionmethod should be developed to balance the need tominimize the perturbation with the
need for sharper peaks. SeePeak Editor on page 6 - 3 to adjust peak data to reduce the effects of
perturbation.

l Always hold the syringe by itsmetal parts away from the needle. Holding the syringe by the glass
allows body heat to affect the volume of gas in the syringe.

l After filling the syringe, allow the syringe to lie on a room temperature surface for about aminute.
This ensures that the syringe and its contents are at room temperature.

l If the gas used is lighter than air, do not allow the filled syringe to remain in a vertical position
(needle up)— the gaswill diffuse out and the total volumewill be reduced.
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To fill the syringe:

1. Empty the syringe completely.
2. Insert the syringe into a septum accessory installed on the gas regulator.
3. Draw the syringe plunger back until the syringe is completely filled with gas.
4. Remove the syringe from the septum and allow it to return to room temperature as described

previously.
5. Press the plunger into the syringe until the correct amount of gas is contained in the syringe.

An alternate method to fill the syringe with nitrogen (evaporating from liquid nitro-
gen):

1. Empty the syringe.
2. Hold the tip of the needle just above the surface the liquid nitrogen.
3. Draw the syringe plunger back until the syringe is filled with nitrogen gas.
4. Allow the syringe to stabilize at room temperature.
5. Push the plunger into the syringe until the correct amount of gas is contained in the syringe.

To inject gas into the analyzer:

The systemmust be at atmospheric pressure to safely use the septum. Attempting to
use the septum at a higher pressuremay cause the septum to eject from the analyzer,
resulting in damage to the septum and, possibly, bodily injury.

1. Turn the septum closure cap counter-clockwise to loosen, then remove the nut.
2. Insert the needle fully into the septum .
3. Press the plunger into the syringe completely to ensure that the entire quantity of gas is injec-

ted from the syringe.
4. Remove the syringe.
5. Replace the septum cap and tighten finger-tight.

Proper Use of the Septum
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9 Hardware

SEPTUM REPLACEMENT

The septum usually requires replacing after approximately 100 injectionswhen using the 1 mL
syringe.

1. Turn the knurled nut counterclockwise and remove it from the injection port.
2. Tap the nut into the palm of your hand to remove the septum and discard the used septum.
3. If the washer came out when the septumwas removed, place the washer back into the

knurled nut first. Place a new septum into the knurled nut.
4. Place the knurled nut back onto the injection port. Turn the nut clockwise to finger-tighten.

Do not use a wrench to tighten the septum retaining nut. Do not overtighten the retaining
nut. Doing somay damage the septum or the fitting.
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10 TROUBLESHOOTING AND MAINTENANCE

The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time.When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided:

Log in to your customer portal to access error messages. Parts and accessories can be found online
at www.Micromeritics.com.

Most operational problems are caused by:

l Leaks (commonly found at the sample tubeO-ring at the analysis port)
l Sample weighing errors
l Use of toomuch analysis bath fluid in the dewar at the start of an analysis
l Entry of incorrect system volume for analysis
l Impure gas supply

When unexpected analysis results occur, check the above first. Some common operational
problems not indicated on the window and their respective causes and solutions are provided below:

Does not work when powered ON

Cause A: Power cord is not fully inserted at one of the ends

Action A: Insert power plug firmly into outlet socket. Insert unit connector into power connector
opening.

Cause B: No power at outlet.

Action B: Plug in another electrical device to test outlet. If there is no power, contact electrician.

Cause C: Plug prongs are bent so that contact is not made at outlet.

Action C: Gentlymove power plug at the outlet while watching the status LEDs on the analyzer
front panel. If at least one LED becomes illuminated, have an electrician replace the
outlet or the plug.

Cause D: Power cord is damaged.

Action D: Have an electrician check cord using a test meter. Replace cord if defective.

Cause E: Loose internal connection or broken wire.

Action E: Call a Micromeritics Service Representative for repair or replacement.

Liquid nitrogen boils away too quickly to complete an analysis.

10 Troubleshooting andMaintenance
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10 Troubleshooting andMaintenance

Cause A: Dewar damaged.

Action A: Replace dewar.

Cause B: Lengthy analysis.

Action B: Refill dewar during analysis.

Specified temperature not reached or not maintained.

Cause: Thermocouple or other internal component is damaged or disconnected.

Action: Contact the appropriate service personnel.

Gas drained from gas cylinder.

Cause: Leaks in the gas line connection.

Action: Replace the gas cylinder; then pressurize the system. Close, then open the cyl-
inder valve. If the needle on the pressure gauge on the gas cylinder jumps
abruptly, a leak in the gas line connectionmay be indicated. Check all gas line
connections.

Too much heat supplied to analyzer.

Cause: Thermocouple or other internal component is damaged or disconnected.

Action: Contact the appropriate service personnel.

A stable TCD baseline cannot be maintained.

Cause A: TCD filaments are contaminated or need to be replaced.

Action A: See TCD Assembly on page 10 - 27 to replace or clean the TCD.
Cause B: Possible leak in carrier path.

Action B: Perform leak test in the carrier path. SeePerform a Leak Test on page 10 -
15.

Cause C: Faulty RTD in one of the temperature zones.

Action C: Accessmanual mode and check for temperature stability in the temperature
zones.

Data collection results in very high or very low peaks that are inconsistent with previous
experience.

10 - 2 MicroActive AutoChemHP 2950Operator Manual
295-42830-01 (Rev -) — Jan 2018



Cause A: TCD filaments are contaminated or need to be replaced.

Action A: See TCD Assembly on page 10 - 27 to replace or clean the TCD.
Cause B: A different (lower) TCD temperature is being used.

Action B: Repeat the analysis using a higher temperature.

During data collection, a TCD signal of zero is recorded, or no peaks are seen.

Cause A: TCD filaments are contaminated or need to be replaced.

Action A: See TCD Assembly on page 10 - 27 to replace or clean the TCD.
Cause B: TCD temperature was not reset after a run automatically suspended.

Action B: Ensure the TCD is re-enabled after all run suspensions.

Furnace will not heat.

Cause A: Furnace not closed and latched.

Action A: Close and latch the furnace.

Cause B: The furnace is not plugged in.

Action B: Plug in the furnace connector.

Cause C: Thermocouple damaged or not plugged in.

Action C: If unplugged, plug in the thermocouple. Replace the thermocouple if necessary.

Pressure will not rise or readings very unstable.

Cause A: Furnace not closed and latched.

Action A: Close and latch the furnace.

Cause B: The furnace is not plugged in.

Action B: Plug in the furnace connector.

10 Troubleshooting andMaintenance
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10 Troubleshooting andMaintenance

ENABLE MANUAL CONTROL
Unit [n] > Enable Manual Control

See also:

Show Instrument Schematic on page 2 - 17

Use to enable themanual control of certain system valves and elevator components on the analyzer
schematic. When this option is enabled, a checkmark appears to the left ofUnit [n] > Enable
Manual Control.

If the analyzer schematic is not immediately visible, go toUnit [n] > Show Instrument Schematic.
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FOAM AIR FILTER REPLACEMENT
The foam air filter should be cleaned every 30 days (more frequently in environments with high levels
of dust). If, after cleaning, it is determined that the filter is degrading, it should be replaced.

The equipment images in this document may differ slightly from your equipment, how-
ever the instructions are the same unless otherwise noted.

1. Go toUnit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go toUnit [n] > Show Instrument
Schematic.

2. Right click the analysis valve and ensure that it is in thePrepare position.
3. Remove the furnace, the cold trap (or delay path), the sample tube, and any other parts or

accessories from the front of the analyzer.
4. Remove the blackmat from the lower panel.

5. Remove the screws that hold the stainless steel support plate in place.

FoamAir Filter Replacement
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10 Troubleshooting andMaintenance

6. Hold the furnace support post and lift the support plate up and away from the analyzer.

7. Pull the foam air filter up and out of the analyzer.
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8. Rinse the foam air filter with clean water and allow it to dry completely.
9. If the filter is in good condition, place it back inside the analyzer. If the filter needs to be

replaced, obtain a new filter and place it inside the analyzer.
10. Place the support plate back into position and reinstall its retaining screws.
11. Reinstall the furnace, cold trap (or delay path), sample tube, etc.

FoamAir Filter Replacement
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10 Troubleshooting andMaintenance

GUIDELINES FOR CONNECTING GASES

l Place gas cylinders within 6 feet (2m) of the gas inlets of the analyzer. Using gas line extenders
on gas cylinders located in remote areasmay degrade gas quality and reduce pressure. Gas lines
are typically five to six feet long. Place the cylinders close enough to allow for proper connection at
the analyzer inlet.

l Use a retaining strap (or other appropriate tether) to secure the gas cylinder.
l Always use the gas lines provided with the analyzer. It is very important that proper gas lines are
used with the analyzer.

o Do not use polymer tubing for the gas line.
o Do not use flexible gas lines. Some flexible linesmay appear to be appropriate, such as those
with a herringbone covering, but the linemay be coated internally with a polymer.

l Long gas lines, such as those used with gas cylinders placed in remote areas, must be evacuated
for an extended period of time to remove ambient gases.When possible, avoid placing gas cyl-
inders in remote locations. It is always best to have gas cylinders located near the analyzer.

l Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or entangling
gas lines. This will help avoid confusion whenmaintenance is required.

l Label the gas line at the analyzer inlet for proper identification andmaintenance.
l Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the pres-
sure reads approximately 500 psi (3500 kPa) on the high pressure gauge. Contaminants
absorbed to the walls of the cylinder will desorb as the pressure decreases.

l Ensure the gas cylinder is closed before connecting to the analyzer.
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REPLACE A GAS CYLINDER

These instructions apply to working with inert gases only. Whenworking with hazardous
gases, follow the safety procedures established by your lab.

Replace aGasCylinder
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10 Troubleshooting andMaintenance

DISCONNECT THE DEPLETED GAS CYLINDER
1. Close the regulator shut-off valve and gas cylinder shut-off valve by turning the knobs clock-

wise.
2. Disconnect the gas line from the regulator. Gaswill be vented from the line. It is not necessary

to disconnect the gas line from the analyzer inlet if the cylinder will be replaced immediately
with one of the same type.

3. Open the gas regulator shut-off valve by turning the knob counter-clockwise. Gaswill be ven-
ted from the regulator.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges
should read at or near zero. If not, make sure the gas regulator shut-off valve is open.

5. Close the regulator by turning the control knob counter-clockwise.
6. Use an appropriate wrench to loosen the nut at the regulator connector nut then remove the

regulator from the cylinder.
7. Replace the protective cap on the depleted cylinder. Disconnect the retaining strap andmove

the cylinder to an appropriate location.

CONNECT A GAS CYLINDER

Analyzer Series Gauge should indicate
3Flex 15 psig (103 kPag)

AccuPyc 25 psig (172 kPag)

ASAP 15 psig (103 kPag)

AutoChem 15-18 psig (103 - 124 kPag)

AutoPore 50-60psig (345 - 404 kPag)

Gemini 15-18 psig (103 - 124 kPag)

TriStar 15-18 psig (103 - 124 kPag)

Regulator Pressure Settings
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O-RING COMPATIBILITY
O-ring selection for chemical adsorptionmeasurements is based on temperature, time, and chemical
compatibility. Chemical compatibility should be the first consideration when selecting an appropriate
O-ring. The time at which the furnace, and subsequently the sample cell, is at elevated temperature
can also affect the performance of the O-rings and should be a secondary consideration. Common
O-ringmaterials include Buna-N (nitrile), Viton (fluoroelastomer), and Kalrez (perfluoroelastomer).
Kalrez has historically been used extensively for chemical adsorptionmeasurements due to
compatibility with a wide range of chemicals and temperatures and should be suitable for all
applications of the chemical adsorption option. Viton or Buna-N may also be suitable for analyses
similar to the referencematerial example file. The ability to re-use Buna-N or Viton O-ringsmay be
limited, while the re-use of KalrezO-rings should bemore broad. Frequency of use and, potentially,
several other factors affect the duration of O-ring use, so rigid rules cannot be specified for these
materials. Leak rate and ultimate vacuum levelsmay be used as indicators for O-ring performance.

O-ring Compatibility
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10 Troubleshooting andMaintenance

PREVENTIVE MAINTENANCE

Perform the following preventivemaintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventivemaintenance procedures and
calibration be performed by aMicromeritics Service Representative every 12months.

Procedure 3 months or
75 runs

6 months or
150 runs

9 months or
225 runs

12 months or
300 runs

Change septum U-R F

Change Injection loop U-I-A F

Foam air filter F

Sample tube filter U-R F-R

Clean analyzer exterior U-I-A F

Adjust sample ther-
mocouple

U-I-A F

Clean the cold trap U-I-A U-I-A U-I-A F

Replace TCD U-I-A F

Clean dewar U-I-A U-I-A U-I-A F

Change sample O-rings F-R

Perform leak check U-I-A F

Check temperature
stability

F

Check sample ther-
mocouple calibration

F-A

Perform calibration run F

U = User performed
F= Factory / Micromeritics Service procedure
I = Inspect
R = Replace
A = As necessary
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CHECK AND CLEAN THE DEWAR

When handling dewars, follow the precautions outlined inDewar Precautions on
page 5 - 4.

Always handle glass dewars with care. Any product incorporating a vacuum is a poten-
tial safety hazard and should be treated with caution. If in doubt, contact your safety
officer.

Ice and suspended frost particlesmay accumulate in the bottom of the analysis port dewar. Particles
or deposits exceeding 1/4 in. (0.64 cm) in depthmay jam between the bottom of the sample tube and
the bottom of the dewar. Accumulations of fine particles impede liquid nitrogen circulation around the
bottom of the sample tube. This causes the sample temperature to be slightly higher which, in turn,
can cause pore volumemeasurement errors in those samples exhibiting high isotherm slope above
0.97 relative pressure. Accumulated ice is likely to melt and form a pool of water in the dewar if all
liquid nitrogen evaporates. The water must be removed; otherwise it will solidify when liquid nitrogen
is added and could press on the bottom of the sample tube causing breakage.

To ensure problems do not develop due to ice accumulation, check the dewar after each use. Clean
on a weekly basis.

1. Remove the dewar from the analyzer.
2. Pour out liquid nitrogen into an appropriate cryogenic container. Do not re-use liquid nitrogen.

Do not pour liquid nitrogen directly into a sink. Doing somay cause drain pipes to burst.

3. Rinse the dewar with warmwater to melt any remaining ice accumulation whichmay remain.
Dry thoroughly.

4. Replace the dewar.

CLEAN THE ANALYZER

The exterior casing of the analyzer may be cleaned using a clean cloth dampened with isopropyl
alcohol (IPA), amild detergent, or a 3% hydrogen peroxide solution. Do not use any type of abrasive
cleaner.

Do not allow liquid to penetrate the casing of the analyzer. Doing so could result in
damage to the unit.

Check and Clean the Dewar
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10 Troubleshooting andMaintenance

POWER ANALYZER ON AND OFF

DO NOT connect or disconnect cables when the analyzer is poweredON.

When the system is powered on for the first time or after a period of non-use, allow it to warm up for
at least three hours before analyses. During this time, a purge carrier gas (such as helium or
nitrogen) should be flowed through the system at about 50 cm3/min. The heat zones should be set at
110 °C.

When the analyzer is powered on (but the application is still not running), the red Fault light and the
green Attention! light are lit. When the application is started and communication is established with
the analyzer, these lights are turned off and the greenOK light is lit.

A carrier gasmust be flowing through the detector whenever the detector filaments are
turned on; otherwise, the filaments will deteriorate and lose sensitivity. If the gases are
shut off, the filaments are automatically turned off after fiveminutes.

Power ON the equipment in the following order:

1. Computer, monitor, and printer
2. Analyzer

Power OFF the equipment in the following order:

1. Exit the analysis program. Failure to do so could result in loss of data. If an analysis is in pro-
gresswhen closing the application, the followingmessage is displayed:

2459 - An Instrument is busy. A delay in restarting this application
could result in loss of new data. Continue program exit? Yes / No

Yes. Closes the program. The analysis continues and data continue to be collected. The
data will be restored when the application is restarted. Reports queued in the print manager
will print. If a power failure occurs and an uninterruptible power supply (UPS) is not attached
to the analyzer, the data collected after exiting the analysis program are lost.

No. The program remains open and the analysis continues to run.

2. Computer, monitor, and printer
3. Analyzer
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PERFORM A LEAK TEST

1. Use to enable themanual control of certain system valves and elevator components on the
analyzer schematic. When this option is enabled, a checkmark appears to the left ofUnit [n] >
Enable Manual Control.If the analyzer schematic is not immediately visible, go toUnit [n] >
Show Instrument Schematic.

2. Prepare for the leak test:
a. Set all heat zones to ambient temperature.
b. Set all four flow controllers to 50 cm3/min.
c. Allow the analyzer to cool to room temperature.

This test must be performed in the order provided to ensure the analyzer is fully tested.
Any flow reading other than zero indicates a leak in the gas flow path being tested.

3. Preparation GasPath tests:
a. Right-click the analysis valve and selectAnalyze.
b. Right-click the Prep. valves and select Flow Gas [n] (He).
c. Plug the preparation gas exhaust outlet.

4. Observe the preparation gas flow controller reading as it slowly drops to zero. A flow reading
of zero indicates the flow path between the preparation gas flow controller and the preparation
exhaust does not leak.

This tests all fitting connections in the gas flow path and part of the analysis valve. Any flow
reading other than zero indicates a leak in the gas flow path being tested.

Perform a Leak Test
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10 Troubleshooting andMaintenance

5. To fix a leak that may be indicated on the preparation gas flow controller, tighten the fittings in
the gas flow path and observe the reading for any decrease that would indicate that the leak
has stopped.

Any leak detected in the remaining steps of this proceduremay be fixed by using the
same processmentioned in Step 5.

6. Right-click the preparation gas flow controller and selectStop Flow. This will close the helium
valve.

7. Remove the plug from the preparation gas exhaust outlet.

CARRIER GAS PATH LEAK TEST

1. Right-click the cold trap Valve and selectBypass.
2. Right-click the analysis valve and selectPrepare.
3. Right-click the loop valve and select Fill.
4. Turn the pressure control knob on the helium gas regulator to deliver less than 5 psi.
5. Right-click the carrier valves and select Flow Gas [n] (He).
6. Plug the analysis gas exhaust outlet.
7. Right-click on calibration valve B and selectClose Valve, then repeat the step for calibration

valve C.
8. Observe the carrier gas flow controller reading as it slowly drops to zero.

A flow reading of zero indicates the flow path between the carrier gas flow controller and
calibration valve B does not leak.

9. Right-click calibration valve B and selectOpen Valve.
10. Observe the carrier gas flow controller reading as it slowly drops to zero or remains at zero

from the previous test.

A flow reading of zero indicates the flow path between the carrier MFC and the carrier exhaust
outlet does not leak. This tests all fitting connections in the gas flow path and part of the
analysis valve, part of the bypass valve, the transducer, the septum, part of the inject valve,
and the analysis side of the thermal conductivity detector.

11. Right-click the loop valve and select Inject.
12. Observe the carrier gas flow controller reading as it slowly drops to zero or remains at zero

from the previous test.

A flow reading of zero indicates the flow path between the carrier gas flow controller and the
carrier gas exhaust outlet does not leak. This tests all fitting connections in the gas flow path,
the remaining parts of the loop valve, and the loop.

13. Install an empty sample tube on the sample port.
14. Right-click the analysis valve and selectAnalyze.
15. Observe the carrier gas flow controller reading as it slowly drops to zero or remains at zero

from the previous test.
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A flow reading of zero indicates the flow path between the carrier gas flow controller and the
carrier gas exhaust outlet does not leak. This tests all fitting connections in the gas flow path,
the sample tube, and the remaining parts of the analysis valve.

16. Install a cold trap (or a delay path) on the cold trap port.
17. Right-click the cold trap valve and select Trap.
18. Observe the carrier gas flow controller reading as it slowly drops to zero or remains at zero

from the previous test.

A flow reading of zero indicates the flow path between the carrier gas flow controller and the
carrier gas exhaust outlet does not leak.

This tests all fitting connections in the gas flow path, the remaining parts of the cold trap valve,
and the cold trap.

19. Right-click the carrier valves and selectStop Flow to close the helium valve.
20. Remove the plug from the analysis exhaust outlet.
21. Reset the pressure on the helium gas regulator to its original pressure.

Carrier Gas Path Leak Test
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10 Troubleshooting andMaintenance

LOOP GAS PATH LEAK TEST

1. Right-click the loop valve and select Inject.
2. Right-click calibration valve C and selectClose Valve.
3. Right-click calibration valve D and selectClose Valve.
4. Plug the loop gas exhaust outlet.
5. Right-click the LoopGasValves and select Flow Gas [n] (He) (or other appropriate gas)

through the LoopGas Flow Controller.
6. Observe the LoopGas Flow Controller reading as it slowly drops to zero.

A flow reading of zero indicates the flow path between the LoopGas Flow Controller and
calibration valvesC and D does not leak. This tests all fitting connections in the small section of
the gas flow path to Calibration ValvesC and D.

7. Right-click calibration valve D and selectOpen Valve.
8. Observe the LoopGas flow Controller reading as it slowly drops to zero or remains at zero

from the previous test.

A flow reading of zero indicates the flow path between the LoopGas Flow Controller and the
loop gas exhaust outlet does not leak.

This tests all fitting connections in the gas flow path, calibration valvesC and D, and the tubing
to the loop valve.
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PURGE THE SYSTEM
When changing the gas that is flowing through the analyzer, or when the type of gas connected to a
port is changed, purge the analyzer of the previous gas by flowing the new gas. The system should
also be purged if the loop is changed.

If changing gases during an analysis, allow the new gas to flow for a period of time before creating
conditions that cause the experiment to begin (such as elevating the temperature). In some cases,
purge one gas by flowing an inert gas for a period of time before starting to flow another gas. This
may be useful for avoiding undesirable combinations of gaseswithin the analyzer.

To flow an inert gas between incompatible gases, insert aChangeGas Flows step (in which an inert
gas is flowed for a period of time) and aWait step (to wait for the inert gas to purge the analyzer)
between other steps that involve incompatible gases.

When gas flows are changed while the analyzer is recording data, the gas flow is briefly
disturbed. Thismay result in a brief period of noise or other visible disturbances on the
peak data. Either disregard the disturbance or insert aWait for stable baseline step
immediately after changing gas flows.

Purge one line at a time. It is the operator’s responsibility to ensure that dangerous
combinations of gases are not created while usingManual Control. It may be necessary
to flow an inert gas through the system between flows of incompatible gases.

1. Go toUnit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go toUnit [n] > Show Instrument
Schematic.

Purge the System
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10 Troubleshooting andMaintenance

2. Set the Cold Trap valve, Analysis valve, Loop valve, and Detector heat zone temperatures to
110 °C.

a. Move the cursor over each valve until the cursor changes to a thermometer.

When the heat zone is clicked, the cursor appears as a thermometer. If the valve
is clicked instead, move the cursor slightly and click again.

b. Right click the valve’s heat zone.
c. SelectSet temperature and enter 110.
d. ClickOK.

3. Wait until the temperature reaches the 110 °C target.Cllick the heat zone to display both the
target and current temperatures on the right side of the schematic.

4. Purge all air from the gas lines. These steps should be performed for each inlet valve for the
preparation, carrier, and loop gas lineswhere a gas cylinder is connected.

a. Right click the preparation gasMass Flow Controller (MFC).
b. SelectSet Flow Rate and enter 50.
c. ClickOK.
d. Right click gas inlet valve 1 and selectOpen.
e. Allow the gas to flow for approximately 20minutes or until the lines have been purged

of air.
f. Repeat Step 4 for each valve that has a gas cylinder connected.

CHANGE THE GAS FLOW DURING AN ANALYSIS

When changing gases during an analysis, allow the new gas to flow for a period of time before
creating conditions that cause the experiment to begin (such as elevating the temperature). Purge
one gas (by flowing an inert gas for a period of time) before starting to flow another gas. Thismay be
useful for avoiding undesirable combinations of gaseswithin the analyzer.

To flow an inert gas between incompatible gases, insert aChangeGas Flows step (in which an inert
gas is flowed for a period of time) and aWait step (to wait for the inert gas to purge the analyzer)
between other steps that involve incompatible gases.

When gas flows are changed while the analyzer is recording data, the gas flow is briefly
disturbed. Thismay result in a brief period of noise or other visible disturbances on the
peak data. Either disregard the disturbance or insert aWait for stable baseline step
immediately after changing gas flows.
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RECOVER FROM A POWER FAILURE
The analyzer saves entered and collected data in case of power failure. File parameters and any
other data entered will still be present when power is restored. If an analysis was in progresswhen
the power failure occurred, it will be canceled when the analyzer restarts. Any data collected during
the analysis will still be present, but the analysis should be restarted in order to produce complete
results.

Recover from a Power Failure
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10 Troubleshooting andMaintenance

REPLACE THE INJECTION LOOP
1. Ensure that no heat is being applied to the analyzer. If necessary, enablemanual control and

set the target temperature for the heat zones to ambient. Wait for the analyzer to cool.
2. Press in on the right side of the retractable handle on the top of the analyzer to protrude the

handle. Use the handle to open the hinged top panel. It is not necessary to remove the top
panel. Pull down the upper front panel.

Depending upon the state of the analyzer, the internal componentsmay be hot. Use cau-
tion.

3. The Fill/Inject (Loop) valve cover is held in place by two retaining plungers. Remove the valve
cover by pulling the plungers outward until the Fill/Inject valve cover is released. Pull the cover
up and out.

4. Remove the insulation from Fill/Inject valve.
5. Unscrew the loop nut and lay it aside. It may be necessary to loosen the screw in themiddle of

the assembly in order to free the loop nut.
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6. Remove the enclosure ring.

7. Use a 1/4 in. open-end wrench to loosen the nuts on the injection loop.

Replace the Injection Loop
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10 Troubleshooting andMaintenance

8. Pull up and remove the injection loop and enclosure ring from themounting plate.

Ensure the body of the loop is positioned in the temperature-controlled enclosure of the
loop valve. This orientation keeps the temperature (and volume) of the loop constant.
Failure to keep the full loop at a constant temperaturemay cause variations in the quant-
ity of gas contained in the loop.
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9. Install the replacement injection loop by placing the ends of the loop into the sides of the valve
and turning the nuts finger-tight.

10. Push the replacement loop down to contact themounting plate and place the loop enclosure
ring firmly into place.

11. Screw the loop nut down finger-tight. Tighten the screw inmiddle of the assembly if it was
loosened earlier.

12. Tighten the loop nuts securely, using a 1/4 in. open-end wrench.
13. Check the injection loop for leaks. If a leak is detected, the injection loop is probably not

installed properly. Repeat the installation and check for leaks again. SeePerform a Leak
Test on page 10 - 15.

14. After checking for leaks, move the insulation back into position and reinstall the Fill/Inject valve
cover.

15. Close the top panel and the lower front panel.
16. After installing a new injection loop, the loopmust be calibrated. Go toUnit [n] > Unit Con-

figuration to update the loop volume.

The smaller loops connect to the same openings in the valve, but rest in a different
position than the larger loop.

Replace the Injection Loop
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10 Troubleshooting andMaintenance

SERVICE TEST MODE

Options > Service Test Mode

Service Test Mode is a password protected option used to perform certain service tests with the
assistance of a trainedMicromeritics service representative. This password is supplied by your
service representative.
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TCD ASSEMBLY

The equipment images in this document may differ slightly from your equipment, how-
ever the instructions are the same unless otherwise noted.

The filaments in the thermal conductivity detector assembly are heated to high temperatures and
may be exposed to corrosive gases, therefore theymay eventually need to be replaced. Symptoms
that the TCD filamentsmay need replacing:

l A stable TCD baseline cannot bemaintained.
l Data collection results in very high or very low peaks that are inconsistent with previous exper-
ience.

l During a data collection, no TCD signal is displayed on themain display or the application indic-
ates that no TCD signal is present.

Contamination of the thermal conductivity detector filaments will produce the symptoms described
above. To clean the filaments, set the filament zone to 150 °C and flow an inert gas through the
analyzer for several hours. If this action does not correct the problem, replace the TCD assembly.

REPLACE THE TCD ASSEMBLY

The equipment images in this document may differ slightly from your equipment, how-
ever the instructions are the same unless otherwise noted.

1. Ensure that no heat is being applied to the analyzer. If necessary, enablemanual control and
set the target temperature for the heat zones to ambient. Wait for the analyzer to cool.

2. Power OFF the analyzer but do NOT disconnect the power cord from the analyzer.

The power cordmust remain connected tomaintain an electrical ground connection to
the analyzer.

3. Press in on the right side of the retractable handle on the top of the analyzer to protrude the
handle. Use the handle to open the hinged top panel. It is not necessary to remove the top
panel. Pull down the upper front panel.

TCD Assembly
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10 Troubleshooting andMaintenance

4. Pull the Bypass/Trap valve cover retaining plungers outward until the Bypass/Trap valve
cover is released. Pull the cover up and out.

5. Remove the insulation from the rear of the Bypass/Trap valve and locate the TCD assembly
(not shown).

The thermal conductivity detector assembly and nearby componentsmay be hot. Allow
the TCD to cool before removing it. Use the cotton gloves provided with the analyzer to
protect your hands.

6. Loosen all four fittings for the stainless steel tubing. Label each piece of tubing for recon-
nection.

7. Unplug the TCD assembly cable from the card cagemotherboard and cut the plastic cable ties
that retain the various cables. This frees the cables for removal of the TCD and cable.
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8. Use a screwdriver to remove the two TCD mounting screws from the yoke plate. Lift the TCD
assembly out of the analyzer.

9. Install the new TCD assembly in the analyzer. Reconnect the tubing at all four fittings and
reconnect the cable to the card cagemotherboard.

10. Reinstall the insulation in the rear of Bypass/Trap valve over the TCD assembly.
11. Reinstall the Bypass/Trap valve cover and allow the retaining plungers to snap into place.
12. Close the top panel and the upper front panel.
13. Power ON the analyzer.
14. Adjust the filament temperature to 150 °C and select an inert carrier gas to flow through the

TCD. Set the TCD Zone temperature to 110 °C.
15. Allow the TCD baseline to stabilize. Go toUnit [n] > Show Status to observe the TCD read-

ing. Stabilizationmay take several hours.

CLEAN THE TCD ASSEMBLY
In some instances, contamination of the thermal conductivity detector filaments will produce the
symptoms described above. To clean the filaments, set the filament zone to 150 °C and flow an inert
gas through the analyzer for several hours. Contact your Micromeritics service representative if
necessary.

TCD Assembly
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11 ANALYSIS TUTORIALS

BET SURFACE AREA ANALYSIS
The BET Surface Area analysis evaluates total surface area of the catalyst before and after
chemisorption. Loss of activity, whichmay occur due to the blocking of pores during the
chemisorption reaction, as well as the occurrence of sintering of the support, can be studied.

After outgassing the sample, amixture of 30% nitrogen and 70% helium is applied to the sample
which is immersed in a liquid nitrogen (LN2) bath. The amount of nitrogen adsorbed (usually
measured on desorption) at LN2 temperatures is used to calculate total surface area.

Because nitrogen uptake is a function of pore size, sample sintering can cause results to show
reduced surface area. Therefore, it may be helpful to performBET as the first and last experiments
in the analysis in order to check for sintering of the support.

PREPARATION

Pretreatment Flow helium over the sample to remove impurities, usually at themax-
imum temperature tolerated by the sample (for example, the tem-
perature at which the sample was calcined).

Analysis Flow 30%N2/He, using a dewar of liquid nitrogen, to measure the
uptake of nitrogen. Then remove the LN2 dewar and replace it imme-
diately with a dewar of water at ambient temperature. The amount of
N2 desorbed ismeasured and the BET equation is used to calculate
the active surface area.

Cold Trap Install the external long delay path. Do not use a cold trap dewar.
Pressure regulator For BET analysis, gas cylinders should be set to a level between 10

and 15 psig (69 and 103.5 kPag).
Furnace temperature During pretreatment, select a temperature high enough to remove con-

taminants or moisture, but not so high as to cause sintering or fusing of
the sample. Hold the temperature long enough to remove con-
taminants or moisture. Maintain the target temperature for at least 30
minutes to ensure adequate degassing. Ensure theDone step is set to
return the sample temperature to 0 ºC.

11 Analysis Tutorials
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11 Analysis Tutorials

CALIBRATION

BET experiments require a separate calibration consisting of threemanual injections of nitrogen
through the septum. This calibration can be performed either before or after the BET analysis. As
with all TCD calibrations, use the Peak Editor to associate the calibration file with the analysis file.
For this reason, it is necessary that the data on themanual injections are collected in a separate
experiment from the BET experiment. The injectionsmay be included in the same analysis as the
BET experiment, or theymay be performed as a completely separate analysis. Use the same
recording options (zero, invert) for the Calibration experiment and the BET experiment.

The followingmethod includes the calibration injections as a separate experiment which follows the
BET experiment in the analysis.

INJECTION SIZE

Inject three volumes of gaswith the goal of approximating the volume of gas taken up by the sample.
Use one injection slightly larger than the expected volume, one injection slightly smaller than the
expected volume, and one injection between these two volumes. The largest injection should be two
to three times greater than the smallest injection.

Because the same syringemust be used for all three injections, select a syringe that can
accommodate all three injection volumes. The volume of gas uptake can be estimated if the
approximate surface area (SA) of the sample is known. Use the following formula to determine the
approximate volume (Vm) to inject.

So:

For example, a sample of 0.1 g of 50m2/g material has a surface area of 5m2. Therefore, the
volume of the gaswhich will be adsorbed is approximately 1.145 cm3 STP.
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PROCEDURE

Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared.

1. Obtain the sample weight, then install the loaded sample tube and thermocouple on the ana-
lyzer.

2. Ensure theDelay Path is installed in the cold trap port.
3. Create a sample file containing the appropriate analysis conditions and report options.

a. Go to File > New Sample.
b. Complete the sample Information window using appropriate values.
c. Select theAnalysis Conditions tab and insert the following experiment steps:

Insert Step Window Field Field Entry or Selection
Experiment New Experiment Experiment

description
Enter a description of the experiment

Type of analysis Physisorption Surface Area
Zones TCD Detector

Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Back pressure 110

Gas Flows PrepGas Helium
CarrierGas Helium
LoopGas None
Rate 50 cm3/min
Cold trap valve Trap
Analysis valve Prepare
Loop valve Fill
Back pressure Prepare

Outputs Outputs Use default values
Peaks Peaks Use default values
Recording
Options

Invert the
TCD signal

Select this option

BET Surface Area Analysis
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Insert Step Window Field Field Entry or Selection
Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 350
Ramp rate 50.0
Hold time 0.00
Enable KwikCool No

Temperature
Ramp

Temperature
Ramp

Ramp Type Return to ambient
Enable KwikCool Enable this selection

Change Gas
Flows

Gas Flows PrepGas None
Carrier Gas Nitrogen-Helium
LoopGas None
Cold trap valve Trap
Analysis valve Analyze
Loop valve Fill
Back pressure Prepare

Wait Wait Wait until baseline
is stable

Select this option

Wait Wait Wait for operator ClickOK to proceed with phys-
isorptionmeasurement

Start Recording Start Recording Onemeasurement
every

0.1 seconds

Dose Dose Get physisorption
point

Select this option

The application automatically inserts a Stop Recording step when a Start Recording step is
inserted. Ensure that a Dose step and a Temperature Ramp step is inserted within the Start/Stop
Recording loop.

Termination Termination Return to ambient
temperature

Select this option

Leave detector
enabled after ana-
lysis

Option is not selected

Zones Not applicable
Gas Flows Not applicable
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To include the calibration data collection (threemanual injections through the septum) within
this analysis but as a separate Experiment, also insert the following steps (before theDone
step):

Insert Step Window Field Field Entry
Experiment New Experiment Experiment

description
Enter a description of the experiment

Type of analysis Other
Zones TCD Detector

Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Back pressure 110

Gas Flows PrepGas None
CarrierGas Nitrogen-Helium
LoopGas None
Rate 50 cm3/min
Cold trap valve Trap
Analysis valve Analyze
Loop valve Fill
Back pressure Prepare

Outputs Outputs Use default values
Peaks Peaks Use default values

Wait Wait Wait until baseline
is stable

Select this option

Start Recording Start Recording Onemeasurement
every

0.1 seconds

Start Repeat Start Repeat
Sequence

Repeat 3 times

BET Surface Area Analysis
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Insert Step Window Field Field Entry
Wait Wait Wait for operator Preparemanual N2 injection. Click

OK.
Dose Dose Manual injection Select this option

The application automatically inserts aStop Repeat step when aStart Repeat step is inserted.
Ensure that aWait step is inserted within theStart/Stop Repeat loop.

The application automatically inserts aStop Recording step when aStart Recording step is inser-
ted. Ensure that theDose step and the Temperature Ramp step is inserted within theStart/Stop
Record loop.

d. Select theReport Options tab andmodify the values as needed.
e. ClickSave, then clickClose.

4. Start the analysis.
a. Go toUnit [n] > Sample Analysis and select the sample file that was just created.
b. Edit the sample file as needed, but for this example, editing is not required. ClickNext.
c. From the drop-down list, select the calibrations associated with each experiment in the

sample file (if any). For this example, selectNone.
d. ClickNext.
e. Read the cautionary window andmake any necessary changes. ClickStart to start the

analysis. During the analysis, change the dewar when prompted.

Change the dewar rapidly. It is recommended to hold the water dewar in one hand and
remove the LN2 dewar with the other to minimize the time required for the change.

5. When the analysis ends, remove the sample tube from the analyzer, place the caps on the
tube, and dry off the outside of the tube with a paper towel.

Use the cotton gloves provided in the accessory kit to remove the sample tube before it
has cooled. Rubber glovesmay be used to handle the sample tube when it has cooled.

6. Weigh the sample tube, sample, and caps. Subtract this weight from the weight obtained for
the sample tube and caps. The resulting weight is the dry sample weight (the after analysis
weight). This weight will be used when calculating the BET surface area in the following sec-
tions.
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GENERATE THE BET REPORT
The following tasksmust be performed before generating the BET report:

l Edit the sample file and the calibration file to ensure that peaks are properlymarked
l Create a TCD calibration file
l Associate the TCD calibration file with the sample file

After completion of these tasks, go toReports > Start Report. Verify that BET Surface Area is
selected.

EDIT THE PEAKS IN THE SAMPLE FILE

1. Open the Peak Editor.
2. Select thePeak Editor experiment from the drop-down at the bottom of the window.
3. SelectEdit Peaks in theView Type group box.
4. ClickFind All Peaks.
5. If needed, edit the edges of the desorption peak:

The desorption peak ismost often used to determine the surface area because the
desorption process starts with the adsorbate equilibrated on the surface.

a. Drag the cursor over the entire baseline of the peak to enlarge the editing area.
b. Click on the baseline of the left side of the peak, right click and selectMark left edge.
c. Repeat step b for the right side of the peak.

6. As the peak edges are adjusted, the values associated with the peak (listed in the peak table)
are also adjusted.When satisfied with the appearance of the peak, right click and selectSave.

EDIT THE PEAKS IN THE CALIBRATION FILE

1. ClickCalibration.
2. Select the calibration file used with the analysis. ClickOK.
3. Edit the peaks in the samemanner as described for the sample file.

BET Surface Area Analysis
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Create the TCD calibration file

1. Go toOptions > Signal Calibration > New.
2. SelectUser defined and enable an Experiment. ClickOK.

3. Click Load Calibration Data.
4. Select the sample file containing the calibration data. ClickOK. The data in the file are inserted

into the appropriate fields of the Signal Calibration window.
5. The values in thePeakQuantity column are defaults. The correct values for the volume of

each injection at STP must be determined using the formula:

Determine the volumes for each calibration peak listed in the table.

6. Enter the converted values (cm3 STP) into the table.

Assess the Peak Area plot, Goodness of Fit, and Coefficients to decide if the calibration file is
acceptable. Use your laboratory’s standards to determine what level of linearity is acceptable.
As a general guideline, use a calibration file with a very low value for Goodness of Fit (less
than 0.1), when 1st or 2nd Degree is specified.

To delete peaks that are outliers, highlight the peak data in the table and clickDelete Peak.
Evaluate the results when changing the degree (select a different degree from the drop-down
list).
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7. Enter a new description into theDescription field.
8. When satisfied with all values in the file, clickSave, then clickClose

Associate the Calibration file with the Sample file

1. Open the Peak Editor.
2. Select thePeak Editor experiment from the drop-down at the bottom of the window.
3. Select the experiment and click theCalibration button.
4. Select the down-arrow to the right of theCalibration field. Select the calibration file just cre-

ated. ClickOK.
5. Repeat steps 3 and 4 for each experiment.
6. ClickSave, then clickClose.

BET Surface Area Analysis
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LOOP CALIBRATION

See also:

Septum on page 9-28

Each calibration loopmust be calibrated prior to its first use to determine its precise volume under
local conditions. Calibration consists of:

l Determining the average area of a series of peaks generated by injections of a known volume of
gas through the analyzer septum using a syringe.

l Determining the average area of a series of peaks generated by injections of the same gas using
the analyzer’s internal loop.

l Calculating the volume of the loop by comparing the average peak area generated by the loop
injectionswith that generated by the syringe injections.

l Entering the calculated loop volume underUnit [n] > Unit Configuration.

STEP 1: UPDATE AMBIENT PRESSURE AND TEMPERATURE

Options > Environmental Defaults

See also:

Environmental Defaults for TCD Analyzers on page 2 - 13

Ambient pressure and temperature at the time of the analysis affect the results of a loop
calibration. In calculations, the analyzer uses the ambient pressure and temperature recorded in
Environmental Defaults. Check and update theEnvironmental Defaults before beginning a loop
calibration.

STEP 2: CREATE A SAMPLE FILE

Create the sample file and insert a Loop Calibration experiment on theAnalysis Conditions tab.

A loop calibrationmust be created for each loop. For Loop Calibration, select a car-
rier gas, flow rate, and loop gas that will commonly be used for sample analyses.
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STEP 3: PERFORM THE ANALYSIS

1. Install the correct injection loop.
2. Go to Unit > Sample Analysis and select the sample file for the loop calibration.
3. ClickNext to accept the default values, then clickStart.
4. Follow the prompts tomake the selected number of injections. Use a volume that is close

to the volume of the loop being calibrated. For example, if calibrating the 1 cm3 loop, use a
1 cm3 syringe and inject as close to 1 cm3 of gas as possible.

Pay close attention to the instructions provided in each prompt and perform the
steps in the order given. Most accurate data results from keeping injection size as
consistent as possible. Injection errorsmay be evident in the data andmaymake it
necessary to repeat the experiment.

After the last manual injection, the analyzer automaticallymakes the same number of injections
using the loop.

STEP 4: GENERATE THE REPORT

See also:

Peak Editor on page 6 - 3

When properly performed, eachmanual and automatic injection results in a peak.When the
Results view of theStart Analysiswindow is selected, each peak can be viewed as it is collected.
The area under the peak corresponds to the amount of gas injected.

1. In thePeak Editor, open the sample file to ensure the peaks are properlymarked.
2. Go to File > Open > [.SMP] and open the .SMP file containing the calibration exper-

iment and verify (or correct) the defined peaks using theMicroActive Peak Editor.
3. On theReports tab, select only the Loop Calibration report option.
4. Go toUnit > Unit Configuration. In the Loop volume field, enter the Loop Volume.

Verify that the Loop Volume andEnvironmental Default values are correct prior to
starting an analysis with injections.

Loop Calibration
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PULSE CHEMICAL ADSORPTION ANALYSIS
A Pulse Chemisorption analysis determines active surface area, percent metal dispersion, and
active particle size by applyingmeasured pulses of reactant gas to the sample, depending upon what
technique is used. Pulse Chemisorption is performed in the samemanner as TPD, except that the
sample is dosed with the analysis gas using the injection loop until each active site has reacted. After
the active sites have completely reacted, the discretely injected gas volumes emerge unchanged. If
TPD is performed after Pulse Chemisorption, additional information about the distribution of active
sites and the strength of active sites is collected.

The amount chemisorbed is the difference between the total amount of reactant gas injected and the
amount that did not react with the active sites of the sample. The size of each pulse is determined by
the loop, which is located on an electrically operated valve.

LOOP VOLUME
It is preferred for the sample to require at least two doses of gas, but nomore than ten doses, before
the reaction ends— depending on the environment. Some factors that influence the number of
doses required are sample size, the active surface area per unit of sample, and the size of the loop. If
the pulse chemisorption analysis requiresmore doses or fewer doses, change either the sample size
or the loop size.

Three loops of different sizes are provided with the analyzer— each loopmust be calibrated prior to
use. As an alternative to replacing the loop, the loop volumemay be changed by adjusting its
temperature. If the loop volume is changed by changing its temperature, results will bemore
accurate if the loop volume is recalibrated at the new temperature.
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LOOP CALIBRATION
Before data from an analysis that uses an injection loop can be reduced, a loop calibration
experiment must be performed. An independent loop calibration can be performed either before or
after the analysis.

The following example assumes that the loop calibration will be performed after the analysis. A Loop
Calibration step can be included in a pulse chemical adsorption analysis.

PREPARATION

Pretreatment Degas by flowing inert gas (such as helium, argon, or nitrogen) over
the sample while ramping the temperature.

Analysis Pulse the loop (analysis) gas over the sample until the peak area
remains constant.

Cold Trap No cold trap is needed during pretreatment. During the analysis, use
the cold trap fixture with a dewar of water in place as a short delay
path. This delay compensates for the flow disturbance caused by each
loop injection.

Pressure regulator Gas cylinders should be set to a level between 10 and 15 psig (69 and
103.5 kPag).

Furnace temperature Select a temperature high enough to remove any contaminants or
moisture, but not so high as to cause sintering or fusing of the sample.
Ensure theDone step is set to return the sample temperature to ambi-
ent.

Pulse Chemical Adsorption Analysis
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11 Analysis Tutorials

PROCEDURE

In the following example, Pulse Chemisorption is performed on a sample of Pt/Al2O3
with CO. Alter the analysis conditions to accommodate a different analysis.

Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared using the instructions inPrepare for Analysis on page 5 - 6.

1. Obtain the samplemass, then install the loaded sample tube and thermocouple on the ana-
lyzer. Close the furnace around the sample tube.

2. Create a sample file for this analysis.
a. Complete theSample Description tab. Enter the correct mass and complete the optional

fields.
b. Select theAnalysis Conditions tab and insert the experiment steps listed below:

Insert Step Window Field Field Entry or Selection

Experiment New Experiment Experiment
description

Enter a description of the experiment

Type of analysis Pulse Chemisorption
Zones TCD Detector

Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Back pressure 110

Gas Flows PrepGas Helium
Carrier Gas Helium
LoopGas None
Rate 50 cm3/min
Cold trap valve Trap
Analysis valve Analyze
Loop valve Fill
Back pressure Prepare

Outputs Outputs Use default values
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Insert Step Window Field Field Entry or Selection
Peaks Peaks Use default values

Wait Wait Wait [n] minutes 5

Change Gas
Flows

Gas Flows PrepGas Hydrogen
Carrier Gas Helium
LoopGas None
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Back pressure Prepare

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 120
Ramp rate 10.0
Hold time 30

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 220
Ramp rate 10.0
Hold time 30

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 350
Ramp rate 10.0
Hold time 120.0

Change Gas
Flows

Gas Flows PrepGas Helium
Carrier Gas Helium
LoopGas None
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill

Wait Wait Wait [n] minutes 90

Temperature
Ramp

Temperature
Ramp

Ramp Type Return to ambient

Wait Wait Wait [n] minutes 30

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 35
Ramp rate 5.0
Hold time 10.0

Pulse Chemical Adsorption Analysis
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Insert Step Window Field Field Entry or Selection

Change Gas
Flows

ChangeGas
Flows

PrepGas None
Carrier/Reference
Gas

Helium

LoopGas CarbonMonoxide
Cold trap valve Trap
Analysis valve Analyze
Loop valve Fill
Back pressure Prepare

Wait Wait Wait until baseline
is stable

Select this option

Start Recording Start Recording Onemeasurement
every

0.2 second

Wait Wait Wait [n] minutes 3

Start Repeat Start Repeat
Sequence

Repeat until peaks
are equal or [n]
times

20

Dose Dose Inject LoopGas Select this option
Wait for [n] minutes 1.5

The application automatically inserts a Stop Repeat step when a Start Repeat step is
inserted. Ensure that the Dose step is inserted within the Start/Stop Repeat loop.
The application automatically inserts aStop Recording step when a Start Recording step is
inserted. Ensure that the Temperature Ramp step is inserted within theStart/Stop
Recording loop.
Termination Termination Return to ambient

temperature
Select this option

Leave detector
enabled after ana-
lysis

Option is not selected

Zones Not applicable
Gas Flows Not applicable

d. Select theReport Options tab andmodify values as needed.
e. ClickSave, then clickClose.

3. Start the analysis.
a. Go toUnit > Sample Analysis. From the Files list box, select the sample file created in

the previous step. Edit the file as needed. ClickNext.
b. From the drop-down list, select the calibrations associated with each experiment in the

sample file (if any). For this example, selectNone. ClickNext.
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Calibration files can also be associated with a sample file after analysis usingCal-
ibration button in the Peak Editor.

c. Read the cautionary window andmake any necessary changes.
d. ClickStart to start the analysis.

When the analysis ends, the furnace begins to lower the sample to room temperature. To
speed cooling of the sample, use the optional CryoCooler or KwikCool.

Use the cotton gloves provided in the accessory kit to remove the sample tube before it
has cooled. Rubber glovesmay be used to handle the sample tube when it has cooled.

When the displayed sample temperature reaches the ambient temperature, open the furnace.
Using gloves, remove the sample tube.

Pulse Chemical Adsorption Analysis
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GENERATE THE LOOP CALIBRATION REPORT

See also:

Peak Editor on page 6 - 3

Open the Peak Editor and ensure that peaks are properlymarked.

There are three possibilities for each dose of gas injected during Pulse Chemical Adsorption:

l all of the gas is taken up by the sample,
l some of the gas is taken up by the sample, or
l none of the gas is taken up by the sample.

When pulse chemical adsorption is properly performed, there will be some injections of each type.
When the data is viewed using the Peak Editor, however, only those injections in which some or
none of the gas is taken up will appear as peaks.When all of the gas is taken up by the sample, none
of it reaches the detector and, therefore, the peak area is zero. These types of peaks are detected
automatically by the application and do not requiremarking.

1. Go to File > Open > .SMP file.
2. Select the sample file used with this analysis. ClickOK.
3. Select theReport Options tab.
4. Enter the percent of active gas in theActive concentration field.
5. On the Sample Information tab, clickActive Metals. Verify that theStoichiometry Factor and

the%of SampleWeight values are correct. ClickOK.
6. Verify that the values for the physical injection volume, ambient temperature, and ambient

pressure are accurate.
7. Go toReports > Start Report to generate the report.
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TEMPERATURE PROGRAMMED DESORPTION ANALYSIS

This topic provides an example of how to perform a Temperature ProgrammedDesorp-
tion analysis using NH3 on calcium oxalate under heliumwith a 10 °C/min temperature
ramp. Make the appropriatemodifications for thematerial being analyzed.

Temperature ProgrammedDesorption (TPD) analyses determine the quantity, type, and strength of
active sites available on the surface of a catalyst frommeasurement of the amount of gas desorbed
at various temperatures.

After the sample has been outgassed, reduced, or otherwise prepared, a steady stream of analysis
gas flows over the sample and reacts with the active sites. (Alternatively, Pulse chemical adsorption
can be used to react with active sites.) Programmed desorption begins when the temperature is
ramped linearly over time while a constant stream of inert carrier gas passes over the sample.

At a certain temperature, the heat will overcome the activation energy, breaking the bond between
the adsorbate and adsorbent. The adsorbed species will then desorb. If different activemetals are
present, they usually will desorb the reacted species at different temperatures. The desorbed
molecules enter the stream of inert carrier gas and are swept to the detector where the detector
response is proportional to the gas concentrations. The quantity of desorbed species, combined with
the stoichiometry factor, and the temperature at which pre-adsorbed species desorb, yield the
quantity and strength of active sites, respectively.

If TPD is performed after coverage of the active sites by flow or pulse chemical adsorption, additional
information about the distribution of active sites and the strength of active sites is collected.

Temperature ProgrammedDesorption Analysis
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PREPARATION

Pretreatment Degas by flowing inert gas— such as helium, argon, or nitrogen—
over the sample while ramping the temperature.

Analysis Choose a gasmixture from the following table based on the needed
results. Flow the gas over the sample, then ramp the temperature
beginning at ambient.

Cold Trap Not required

Needed Results Carrier Gas Analysis Gas
ActiveMetal Surface Area H2 Chemisorption argon hydrogen

ActiveMetal Surface Area COChemisorption helium carbonmonoxide

Acidity helium ammonia (15%maximum
NH3, blended in helium)

Before performing an analysis, ensure the sample and analyzer have been adequately
prepared.
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PROCEDURE
These instructions analyze zeolite with ammonia (use 15%maximumNH3 blended in helium) at 3 to
20 ºC/min. Adjust the values in the example to accommodate the analysis you are performing.

1. Obtain the sample weight, then install the loaded sample tube and thermocouple on the ana-
lyzer. Close the furnace around the sample tube.

2. Create a sample file for this analysis.
a. Go to File > New Sample.
b. Complete theSample Informationwindow. Enter the correct mass and complete the

optional fields as needed.
c. Select theAnalysis Conditions tab and insert the following experiment steps:

Insert Step Window Field Field Entry or Selection
Experiment New Experiment Experiment

description
Enter a description of the experiment

Type of analysis Other
Zones TCD Detector

Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Back pressure 110

Gas Flows PrepGas Helium
Carrier Gas Helium
LoopGas None
Rate 50 cm3/min
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Back pressure Prepare

Outputs Outputs Use default values
Peaks Peaks Use default values

Temperature ProgrammedDesorption Analysis
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Insert Step Window Field Field Entry or Selection
Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 350
Ramp rate 50.0
Hold time 10.00

Experiment New Experiment Experiment
description

Enter a description of the experiment

Type of analysis Temperature Programmed
Desorption

Zones TCD Detector
Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Back pressure 110

Gas Flows PrepGas Helium
Carrier Gas Helium
LoopGas None
Rate 50 cm3/min
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Back pressure Prepare

Outputs Outputs Use default values
Peaks Peaks Use default values

Temperature
Ramp

Temperature
Ramp

Ramp Type Return to ambient

Wait Wait Wait for Operator Add sample and setup cold trap.
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Insert Step Window Field Field Entry or Selection
Change Gas
Flows

Gas Flows PrepGas Ammonia (15%maximumNH3 blen-
ded in helium)

Carrier Gas Helium
LoopGas Ammonia (15%maximumNH3 blen-

ded in helium)
Rate 50 cm3/min
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Back pressure Prepare

Wait Wait Wait [n] minutes 60

Change Gas
Flows

Gas Flows PrepGas None
Carrier Gas Helium
LoopGas Ammonia (15%maximumNH3 blen-

ded in helium)
Cold trap valve Bypass
Analysis valve Analyze
Loop valve Fill
Back pressure Prepare

Wait Wait Wait [n] minutes 30

Wait Wait Wait until baseline
is stable

Select this option

Start Recording Start Recording Onemeasurement
every

1.0 seconds

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 500
Ramp rate 3.0
Hold time 0.0

The application automatically inserts aStop Recording step when a Start Recording step is
inserted. Ensure that the Temperature Ramp step is inserted within theStart/Stop
Recording loop.

Temperature ProgrammedDesorption Analysis
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Insert Step Window Field Field Entry or Selection
Wait Wait Wait [n] minutes 30

Temperature
Ramp

Temperature
Ramp

Ramp Type Return to ambient

Repeatedly insert the steps between the double lines in this table. Use a different ramp rate for
each repetition; after ramping at 3°/min. and 5°/min., use 10, 15, and 20°/min. This shifts the peak
as a function of the Heat of Desorption.

Termination Termination Return to ambient
temperature

Select this option

Leave detector
enabled after ana-
lysis

Option is not selected

Zones Not applicable
Gas Flows Not applicable

d. Select theReport Options tab and set the values. ClickSave then clickClose.
3. Start the analysis.

a. Go toUnit > Sample Analysis. From the Files list box, select the sample file created in
the previous step. Edit the file as needed. ClickNext.

b. From the drop-down list, select the calibrations associated with each experiment in the
sample file (if any). For this example, selectNone. ClickNext.

c. Read the cautionary window andmake any necessary changes.
d. ClickStart to start the analysis.

When the analysis ends, the furnace begins to lower the sample to room temperature.
To speed cooling of the sample, use the optional CryoCooler or KwikCool. Remove the
sample tube when the analysis is complete.

Use the cotton gloves provided in the accessory kit to remove the sample tube before it
has cooled. Rubber glovesmay be used to handle the sample tube when it has cooled.
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TEMPERATURE PROGRAMMED OXIDATION ANALYSIS

This topic provides an example of performing a TPOonWO3. Because TPR is often
used as the preparation for TPO, the TPR processwas included in this example.

Temperature ProgrammedOxidation (TPO) examines the extent to which a catalyst can be re-
oxidized. Generally, TPOanalyses are used tomeasure the degree of reduction of certain oxides.

Usually the sample is pretreated and themetal oxides are reduced to the basemetal. Then the
reactant gas is applied to the sample in pulses or (alternatively) as a steady stream. The analyzer
measures the uptake of the reactant gas.

TPO is often performed after TPR is performed.When the TPR experiment concludes, the sample is
returned to room temperature. Then, the analysis gas is changed to 2-5%O2 + He. This gasmixture
is flowed after the sample is at ambient temperature, then the temperature is ramped up to the same
maximum temperature used for the preceding TPR analysis. The portion of the sample that had
been reduced is re-oxidized, and the degree of reduction can be calculated.

If the TPR and TPO results are different, there are several possible causes: the samplematerial
sintered such that only a surface oxide (and not a bulk oxide) is formed, or part of the sample was re-
oxidized at room temperature while the TCD baseline was stabilizing.

When using anymixture of gases for TPR or TPOanalyses, make sure the thermal
conductivities of the two gases in themixture are quite different for maximum sensitivity,
SeeGas Charts on page E - 1 .

PREPARATION

Pretreatment TPR
Analysis 2 to 5% oxygen/helium is flowed through the sample while tem-

perature is ramped, beginning at ambient temperature.
Cold Trap None needed.

Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared using the instructions inPrepare for Analysis on page 5 - 6.

Temperature ProgrammedOxidation Analysis
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PROCEDURE
1. Obtain the sample weight, then install the loaded sample tube and thermocouple on the ana-

lyzer. Close the furnace around the sample tube.
2. Create a sample file for this analysis.

a. Go to File > New Sample. Enter a file name or accept the default. ClickOK, then click
Yes to confirm.

b. Complete the Sample file as needed.
c. Select theAnalysis Conditions tab and insert the experiment steps in the following table:

Insert Step Window Field Field Entry
Experiment New Experiment Experiment

description
Enter a description of the experiment

Type of analysis Temperature Programmed
Reduction

Zones TCD Detector
Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Back pressure 110

Gas Flows PrepGas Helium
Carrier Gas Hydrogen-Argon (blend of 10%

hydrogen in argon)
LoopGas None
Rate 50 cm3/min
Cold trap valve Trap
Analysis valve Prepare
Loop valve Fill
Back pressure Prepare

Outputs Outputs Use default values
Peaks Peaks Use default values
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Insert Step Window Field Field Entry
Temperature
Ramp

Temperature
Ramp

Ramp Type Return to ambient

Change Gas
Flows

Gas flows PrepGas None
Carrier Gas Hydrogen-Argon (blend of 10%

hydrogen in argon)
LoopGas None
Cold trap valve Bypass
Analysis valve Analyze
Loop valve Fill
Back pressure Prepare

Wait Wait Wait for operator Position cold trap dewar and close fur-
nace

Wait Wait Wait until baseline
is stable

Select this option

Start Recording Start Recording Onemeasurement
every

1.0 seconds

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 980
Ramp rate 10.0
Hold time 0.00

The application automatically inserts aStop Recording step when a Start Recording step is
inserted. Ensure that the Temperature Ramp step is inserted within theStart/Stop
Recording loop.
Change Gas
Flows

Gas Flows PrepGas Helium
Carrier Gas Helium
LoopGas None
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Back pressure Prepare

Temperature
Ramp

Temperature
Ramp

Ramp Type Return to ambient

Temperature ProgrammedOxidation Analysis
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Insert Step Window Field Field Entry
Experiment New Experiment Experiment

Description
Enter a description of the experiment

Type of analysis Temperature Programmed
Oxidation

Zones TCD Detector
Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Back pressure 110

Gas Flows PrepGas Helium
Carrier Gas Helium
LoopGas None
Rate 50 cm3/min
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Back pressure Prepare

Outputs Outputs Use default values
Peaks Peaks Use default values

Wait Wait Wait until baseline
is stable

Select this option

Start Recording Start Recording Onemeasurement
every

1.0 seconds

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 980
Ramp rate 20.0
Hold time 0.00
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Insert Step Window Field Field Entry
The application automatically inserts aStop Recording step when a Start Recording step is
inserted. Ensure that the Temperature Ramp step is inserted within theStart/Stop
Recording loop.
Change Gas
Flows

Gas Flows PrepGas Helium
Carrier Gas Helium
LoopGas None
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Back pressure Prepare

Temperature
Ramp

Temperature
Ramp

Ramp Type Return to ambient

Termination Termination Return to ambient
temperature

Select this option

Leave detector
enabled after ana-
lysis

Option is not selected

Zones Not applicable
Gas Flows Not applicable

d. Select theReport Options tab and set the values.
e. ClickSave, then clickClose.

3. Start the analysis.
a. Go toUnit > Sample Analysis. From the Files list box, select the sample file created in

the previous step. Edit the file as needed. ClickNext.
b. From the drop-down list, select the calibrations associated with each experiment in the

sample file (if any). For this example, selectNone. ClickNext.
c. Read the cautionary window andmake any necessary changes.
d. ClickStart to start the analysis.

When the analysis ends, the furnace begins to lower the sample to room temperature.
To speed cooling of the sample, use the optional CryoCooler or KwikCool. Remove the
sample tube when the analysis is complete.

4. As the temperature increases, the sample is oxidized, and the application calculates the
volume of oxygen taken up.

Temperature ProgrammedOxidation Analysis
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5. Allow the TCD signal to return to the initial baseline after the peak has been displayed

Use the cotton gloves provided in the accessory kit to remove the sample tube before it
has cooled. Rubber glovesmay be used to handle the sample tube when it has cooled.

6. When the displayed sample temperature reaches the ambient temperature, open the furnace.
Using gloves, remove the sample tube.
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TEMPERATURE PROGRAMMED REDUCTION ANALYSIS

This topic provides an example of how to perform a TPR analysis of copper oxide. Cop-
per Oxide ReferenceMaterial can be ordered fromMicromeritics . Log in to your cus-
tomer portal to access parts and accessories.

Some reactions begin at temperatures below ambient. In such cases, a dewar con-
taining an appropriate coolant should be used instead of the furnace at the beginning of
the experiment. For example, reduction of PtO should begin at approximately -50 °C,
because the reaction begins at about -30 °C. Alternatively, the optional CryoCooler can
be used.

Temperature ProgrammedReduction (TPR) determines the number of reducible species present in
the catalyst and reveals the temperature at which reduction occurs. An important aspect of TPR
analyses is that the sample need not have special characteristics other than containing reducible
metals.

The TPR analysis begins by flowing analysis gas (typically hydrogen in an inert carrier gas such as
nitrogen or argon) over the sample, usually starting at ambient temperature. While the gas is flowing,
the temperature of the sample is increased linearly with time and the consumption of hydrogen by
adsorption/reaction ismonitored. Changes in the concentration of the gasmixture are determined.
This information yields the hydrogen uptake volume.

Temperature ProgrammedReduction Analysis
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PREPARATION

Pretreatment Oxidize by flowingO2 over the sample.
Analysis Flow 5-10% hydrogen/argon while ramping the temperature. The ana-

lyzer records hydrogen consumption as a function of temperature.
Nitrogen is sometimes used because it may bemore economical than
argon. Argon is recommended over nitrogen because the resultant
peak(s) show no reaction between sample and gas.

Cold Trap A cold trap is required to remove traces of water formed as a product
of the reduction.

Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared using the instructions inPrepare for Analysis on page 5 - 6.
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PROCEDURE

See also:

l Create Sample Files on page 3 - 2
l Peak Editor on page 6 - 3

1. Obtain the samplemass then install the loaded sample tube on the analyzer. If the analysis
begins below ambient, either place a dewar of coolant around the sample tube or close the fur-
nace around the sample tube and install the CryoCooler. If the analysis begins at ambient,
close the furnace around the sample tube.

2. Install the cold trap (if using one), then place a dewar filled with coolant around the cold trap.
Ensure that the dewar contains sufficient coolant to cover the cold trap loops.

A mixture of isopropyl alcohol (IPA) and liquid nitrogen (LN2) is the recommended coolant for
this experiment. Place the isopropyl alcohol in a dewar and slowly pour LN2 into the dewar
while stirring themixture. Continue to add and stir themixture until it becomes a slush. The
mixturemust be capable of achieving a temperature of about -90 ºC.

Extreme caution should be used whenmixing the IPA/LN2. SeeDewar Precautions
on page 5 - 4.

3. Create a sample file for this analysis.
a. Go to File > New Sample.
b. Complete the Sample Information window. Enter the correct weight and complete the

optional fields.
c. Select theAnalysis Conditions tab and insert the experiment steps listed below:

Insert Step Window Field Field Entry or Selection
Experiment New Experiment Experiment

description
Enter a description of the experiment

Type of analysis Temperature ProgrammedReduc-
tion

Temperature ProgrammedReduction Analysis
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Insert Step Window Field Field Entry or Selection
Zones TCD Detector

Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Back pressure 110

Gas Flows PrepGas Helium
Carrier Gas Hydrogen-Argon (10% blend of

hydrogen in argon)
LoopGas None
Rate 50 cm3/min
Cold trap valve Trap
Analysis valve Prepare
Loop valve Fill
Back pressure Prepare

Outputs Outputs Use default values
Peaks Peaks Use default values

Wait Wait Wait for operator Add sample and setup cold trap

Change Gas
Flows

Gas Flows Prep None
Carrier Hydrogen-Argon (10% blend of

hydrogen in argon)
Loop None
Cold trap valve Trap
Analysis valve Analyze
Loop valve Fill
Back pressure Prepare

Wait Wait Wait until baseline
is stable

Select this option

Start Recording Start Recording Onemeasurement
every

1.0 seconds

Temperature
Ramp

Temperature
Ramp

Type Sample Ramp
End Temperature 400
RampRate 10.0
Hold Time 0.00
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Insert Step Window Field Field Entry or Selection
The application automatically inserts aStop Recording step when a Start Recording step is
inserted. Ensure that the Temperature Ramp step is inserted within theStart/Stop
Recording loop.
Termination Termination Return to ambient

temperature
Select this option

Leave detector
enabled after ana-
lysis

Option is not selected

Zones Not applicable
Gas Flows Not applicable

d. Select theReport Options tab andmodify the values as needed..
e. ClickSave, then clickClose.

4. Start the analysis.
a. Go toUnit > Sample Analysis. From the Files list box, select the sample file created in

the previous step. Edit the file as needed. ClickNext.
b. From the drop-down list, select the calibrations associated with each experiment in the

sample file (if any). For this example, selectNone. ClickNext.

Calibration files can also be associated with a sample file after analysis usingSet
Calibration in the Peak Editor.

c. Read the cautionary window andmake any necessary changes.
d. ClickStart to start the analysis.

As the temperature increases, the copper oxide is reduced, the water produced by the
reaction is collected in the cold trap (if used), and the amount of hydrogen consumed is
detected and transmitted to the application. Use theResults view to display a
chromatogram of the hydrogen consumed from the detector signal as a function of the
ramping temperature.

A hydrogen consumption peak, which corresponds to the reduction capacity of copper
oxide, is displayed. Themaximumpeak should occur at approximately 280 ºC. This
temperature varies highly, depending on the CuOparticle size. Larger particle size shifts
the temperature upward to 330 °C or more. Under certain combinations of sample,
hydrogen concentration, and flow rate, two peaksmay appear due to the transition state
of Cu2+ to Cu+ to Cu.

Temperature ProgrammedReduction Analysis
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A ADVANCED REPORTS - PYTHON MODULE

See also:

Mic Module Python Calls on page A - 12

l Summary reports.Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with themic.summary call.

l Tabular reports. Consist of one or more tables each containing one or more labeled columns of
data. Tabular reports are created with themic.table call.

l Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with themic.graph call.

Calls for accessing the sample file data can be found in theMicModule Python Calls section of this
appendix. More advanced example python scripts are included in the analyzer software. Application
specific discussions can be found on http://www.micro-report.com

The examples in this topic are also included as a part of theMicromeritics installation pro-
cess and are located in theScripts sub-directory.

A Advanced Reports - PythonModule
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A Advanced Reports - PythonModule

ADVANCED REPORT OPTIONS

TheSelected Reports list boxmay display aUser-Defined option rather than an
Advanced option. These options are the same.

Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports a
"mic" Pythonmodulemust be created. SeeMic Module Python Calls on page A - 12 for an
example of Python script and functions for the "mic" Pythonmodule.

1. Create the Python script and save it in theScripts directory.
2. Open a sample file with aCompleted status.
3. SelectAdvanced in the drop-down list at the bottom of the window to return to the tabbed

view.
4. In theSelected Reports group box, click the drop-down arrows to select up to five Python

scripts previously added in theAvailable Scripts box.
5. ClickPressures to add pressure points to the report. ClickOK to return to theReport Options

tab.
6. Select theOverlay samples checkbox to enable the overlay sample feature.
7. On theReport Options tab, clickPreview. The Python Reports will be included on the tabs

across the top portion of theReportswindow.
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Field or Button Description
Add [button] Click to add additional Python reports.

Available Scripts
[group box]

Lists the available reports and provides the option to add, replace, edit
or remove reports.

Overlay samples (if
shown) [check box]

Use to overlay samples as defined by the function.

Advanced Report 1
through 5
[drop-down box]

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Advanced Report Options Fields and Buttons Table

SCRIPTS

RUN A SCRIPT
1. Open a sample file with aComplete file status.
2. SelectAdvanced in the drop-down list at the bottom of the window.
3. Select theReport Options tab.
4. HighlightAdvanced in theReports list box, then clickEdit.
5. On theAdvanced Report Optionswindow, clickAdd. Locate and select one or more python

scripts then clickSelect. The selected scripts become a part of the drop-down list in theAvail-
able Scripts section of theAdvanced Report Optionswindow.

6. In theSelected Reports section, select up to five Advanced reports in the drop-down lists. Use
thePressures button to include or exclude available pressures in the report.

7. ClickOK.
8. ClickPreview on theReport Options tab to view all reports selected in the previouswindow.

Scripts
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A Advanced Reports - PythonModule

EDIT A SCRIPT

When a script is added, the code is stored within the application. If the script changes out-
side of the application, the script file will have to be re-added to the Advanced Report
Optionswindow for the changes to take affect.

Field or Button Description
Add Adds one or more scripts to theAvailable Scripts box. The added

scripts then become available as options in theSelected Reports
section.

Edit Edits the script stored within the application but does not affect the
original .py text file.

Remove Removes the script from theAvailable Scripts box but does not affect
original .py text file

Replace Replaces the contents of the selected script however, the script name
remains the same.

REMOVE A SCRIPT
Select the script in theAvailable Scripts box then clickRemove. The script is removed from the
application however, the original .py text file is not affected.
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SUMMARY REPORT
This script produces a summary report with two summaries:

import mic
mic.summary( "My Summaries" )

mic.summary.add( "Summary A",
["label 1:", "label 2:", "label 3:"],
["val1", "val2", "val3"] )

mic.summary.add( "Summary B",
["label 4:", "label 5:", "label 6:"],
["val4", "val5", "val6"] )

The result is:

SummaryReport
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A Advanced Reports - PythonModule

TABULAR REPORT
If more than one column is required, the callmic.table is employed. This script produces a tabular
report consisting of two tables.NOTE: This script uses the Python package "numpy" and c-style
formatting of the numerical values.

import mic
import numpy as np

mic.table("My Tables")

mic.table.addtable( "My set A" )
mic.table.addcolumn( "x", ["1.0", "2.0", "3.0"] )
mic.table.addcolumn( "y", ["0.5", "1.0", "1.5"] )

x1 = 0.2
x2 = 0.5
x3 = 3.14159/2
mic.table.addtable( "My set B" )
mic.table.addcolumn( "x", ["%8.3f" % x1,

"%8.3f" % x2,
"%8.3f" % x3 ] )

mic.table.addcolumn( "sin(x)", ["%8.3f" % np.sin(x1),
"%8.3f" % np.sin(x2),
"%8.3f" % np.sin(x3)] )

mic.table.addcolumn( "cos(x)", ["%8.3f" % np.cos(x1),
"%8.3f" % np.cos(x2),
"%8.3f" % np.cos(x3)] )

The result is:
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GRAPHIC REPORT
This script is an example of themicmodule producing a graph with two curves:

import mic
import numpy as np

mic.graph( 'My Graph', 'x', 'f(x)' )

myx = np.array( [0.1, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1.0 ] )
mic.graph.add( 'x^2', myx, myx*myx, marker='o' )
mic.graph.add( 'sin(x)', myx, np.sin(myx), marker='^' )

The results are:

Graphic Report
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A Advanced Reports - PythonModule

ACQUIRE BASIC INFORMATION FOR CHEMICAL ADSORPTION
This script produces a graph of the primary, repeat, and difference isotherms; and prints summaries
of the sample information and the adsorptive properties.

To acquire the adsorption isotherm and other basic information about the sample being edited, the
callsmic_chem.isotherm,mic.sample_information andmic.adsorptive_data are applied.

Note the calls tomic_chem.isotherm andmic.adsorptive_data above are each returning results as a
list with elements of varying return type.

import mic

p_primary, q_primary = mic.chem_isotherm('primary')
p_repeat, q_repeat = mic.chem_isotherm('repeat')
p_difference, q_difference = mic.chem_isotherm('difference')
mic.graph( 'Graphical Report 1', 'Abs. Press', 'Quantity Adsorbed')
mic.graph.add('Primary', p_primary , q_primary)
mic.graph.add('Repeat', p_repeat , q_repeat)
mic.graph.add('Difference', p_difference, q_difference)

mic.summary( "Sample Information" )
mic.summary.add( "Sample Information:",

[ "Ambient Free space (cm^3):",
"Analysis Free space (cm^3):" ,
"Sample mass (g):",
"Description:",
"Analysis Temp (K):",
"Sample Density (g/cm^3):" ],

[ "%8.3f" % mic.sample_information('ambient freespace'),
"%8.3f" % mic.sample_information('analysis freespace'),
"%8.3f" % mic.sample_information('sample mass'),
mic.sample_information('sample description'),
"%8.3f" % mic.sample_information('analysis temperature'),
"%8.3f" % mic.sample_information('sample density') ] )

csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()

mic.summary.add( "Adsorptive Data",
[ "Cross Sectional Area",

"Hard Sphere Diameter",
"Density Conversion Factor",
"Molecular Weight",
"Analysis gas"],

[ "%8.3f" % csa,
"%8.3f" % hsd,
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"%8.3f" % dcf,
"%8.3f" % mol_weight,
analysis_gas ] )

Acquire Basic Information for Chemical Adsorption
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A Advanced Reports - PythonModule

ACQUIRE OVERLAY SAMPLE DATA FOR CHEMICAL ADSORPTION
The call to obtain overlay sample data is similar to the calls for the primary sample. This script
involves two overlay sample files.

The calls to obtain adsorptive data and report results for an overlay sample file usingmic.report and
mic.adsorptive_data have a very similar interface as themic.chem.overlay call, and a summary of
their usage is shown in the example in this topic.

import mic

p0, q0 = mic.chem_isotherm('primary')
p0r,q0r = mic.chem_isotherm('repeat')
p1, q1 = mic.chem_overlay(1,'primary')
p1r, q1r = mic.chem_overlay(1,'repeat')
p2, q2 = mic.chem_overlay(2,'primary')
p2r, q2r = mic.chem_overlay(2,'repeat')
mic.graph( 'Graphical Report 1', 'Abs. Press', 'Quantity Adsorbed')
mic.graph.add('prim 0',p0,q0)
mic.graph.add('rep 0',p0r, q0r)
mic.graph.add('prim 1',p1,q1)
mic.graph.add('rep 1',p1r, q1r)
mic.graph.add('prim 2',p2,q2)
mic.graph.add('rep 2',p2r, q2r)

mic.summary( "A summary report" )

mic.summary.add( "Sample and Two Overlays",
[ "Primary Sample:",

"Overlay Sample 1:",
"Overlay Sample 2:" ],

[ mic.sample_information('sample description'),
mic.sample_information('sample description',1),
mic.sample_information('sample description',2) ] )
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ACQUIRE METAL COMPOSITION DATA FOR CHEMICAL ADSORPTION
The call to obtain information about activemetals in a chemical adsorption sample ismic.metal_
composition. Specifically, this call provides access to the data shown in the table of theActiveMetals
window.With no arguments specified, the call returns a list of all the activemetals in the sample.
When called with ametal specified, themethod returns an associative array (python dictionary) of
themetal's properties. With both themetal and property specified, the call returns the value for the
specifiedmetal property. The following example script illustrates these three usage patterns.

import mic
import pprint as pp

mnames = mic.metal_composition()
mic.summary( "Metal Composition:" + pp.pformat( mnames ) )

mprops = sorted( mic.metal_composition( mnames[0] ).items() )
mkeys = []
mvals = []
for k, v in mprops :

if ( 'cross sectional area' in k ) :
mkeys.append( k + ' (nm^2)' )

elif ( 'atomic weight' in k ) :
mkeys.append( k + ' (amu)' )

elif ( 'density' in k ) :
mkeys.append( k + ' (g/cm^3)' )

else :
mkeys.append( k )

mvals.append("%8.3f" % v )
mic.summary.add( "Properties for " + mnames[0], mkeys, mvals)

mweights = []
for mname in mnames :

mweights.append( "%8.3f" % mic.metal_composition(mname, 'atomic weight') )
mic.summary.add("Active Metals and Atomic Weight (amu)", mnames, mweights)

AcquireMetal Composition Data for Chemical Adsorption
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MIC MODULE PYTHON CALLS

TABLES

AvailableMic Python calls for tables:

l Create a new tabular report
l Add a column
l Add a table

ADD A TABLE
This script adds a table to the last created tabular report:

mic.table.addtable( name )

Keyword arguments:

name --- the table name

ADD A COLUMN
This script adds a column to the last created table:

mic.table.addcolumn( header, values )

Keyword arguments:

header --- column header; must be a string (or convertible)
values --- column values; must be a list of strings (or convertible)

CREATE A NEW TABULAR REPORT
mic.table( title='User Table' )

Keyword arguments:

title --- the tabular report title (default = 'User Table')
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SUMMARY REPORTS

AvailableMic Python calls for summary reports:

l Add a summary section to the last created summary report
l Create a new summary report

ADD A SUMMARY SECTION
This script adds a summary section to the last created summary report:

mic.summary.add( name, labels, values )

Keyword arguments:

name --- summary section name
labels --- column of labels; must be a list of strings

(or convertible) and the same length as values
values --- column of values; must be a list of strings

(or convertible) and the same length as labels

CREATE A NEW SUMMARY REPORT
mic.summary( title='User Summary' )

Keyword arguments:

title --- the summary title

SummaryReports
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GRAPHIC REPORTS

AvailableMic Python calls for graphic reports:

l Add a curve
l Add a curve using the second Y-axis
l Create a new graphic report

ADD A CURVE
This script adds a curve to the last created graphical report:

mic.graph.add( name, x, y, yyaxis=False, color=None, linestyle='-', mark-
er='a', graphtype='both' )

Keyword arguments:

name --- the curve name
x --- list of x values; must be a list of floats

(or convertible) and the same length as y
y --- list of y values; must be a list of floats

(or convertible) and the same length as x
yyaxis --- place this curve on the yy-axis if True

otherwise place on the y-axis (default = False)
color --- RGB color as an HTML hex string (e.g., '#4169e1')

or a three-element list or tuple (e.g., [65,105,225]);
if None, color is automatically selected (default = None)

linestyle --- line style; (default = '-')
'-' : solid
'--' : dash
'.' : dot
'-.' : dash dot
'-..' : dash dot dot

marker --- marker shape; (default = 'a')
'+' : plus
'o' or '0' : circle
'x' : cross
'^' : up triangle
'v' : down triangle
's' : square
'd' : diamond
'8' : hourglass
'~' : horizontal hourglass
'' or None : no marker
'a' : automatically selected
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graphtype --- graph type; (default = 'both')
'curve' or 'c' : curve
'points' or 'p' : points
'both' or 'b' : curve-and-points
'hist' or 'h' : histogram

ADD A CURVE USING THE SECOND Y-AXIS
This script adds a curve to the last created graphical report using the second y-axis:

mic.graph.addyy( name, xx, yy )

Add a curve to the last created graphical report using the second
y-axis. The arguments to this call are the same as to mic.graph.add
with the argument

CREATE A NEW GRAPHICAL REPORT
mic.graph( title='User Graph', xlabel='X axis', ylabel='Y axis', yylabel='YY
axis', xlinear=True, ylinear=True, yylinear=True )

Keyword arguments:

title --- the graphical report title (default = 'User Graph')
xlabel --- x-axis label (default = 'X axis')
ylabel --- y-axis label (default = 'Y axis')
yylabel --- yy-axis label (default = 'YY axis')
xlinear --- x-axis linear scale; if false, use log scale

(default = True)
ylinear --- y-axis linear scale; if false, use log scale

(default = True)
yylinear --- yy-axis linear scale; if false, use log scale

(default = True)

Graphic Reports
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GET PRIMARY ISOTHERM DATA FOR CHEMICAL ADSORPTION
mic.chem_isotherm( branch='primary' ) :
Get primary, repeat and difference isotherm data.

Keyword arguments:
branch --- Specifies which analysis to get isotherm data;

use 'primary' for the first analysis,
'repeat' for the repeat analysis

and 'difference' for the difference of these two

Usage:

p, q = mic.chem_isotherm('primary')
p, q = mic.chem_isotherm('repeat')
p, q = mic.chem_isotherm('difference')
p --- array of absolute pressures
q --- array of cumulative quantity adsorbed

GET OVERLAY ISOTHERM DATA FOR CHEMICAL ADSORPTION
mic chem_overlay( overlay_number = 1, branch='primary' ) :

Get overlay isotherm data.

Keyword arguments:

overlay_number --- the overlay number (1 through 8; default = 1)

branch --- Specifies which analysis to get isotherm data;
use 'primary' for the first analysis,

'repeat' for the repeat analysis
and 'difference' for the difference of these two

Usage:

p, q = mic.chem_overlay(1, 'primary')
p, q = mic.chem_overlay(1, 'repeat')
p, q = mic.chem_overlay(1, 'difference')
p --- array of absolute pressures
q --- array of cumulative quantity adsorbed

GET ADSORPTIVE DATA FOR EACH SAMPLE
mic.adsorptive_data( sample_number = 0 )

Keyword arguments:
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sample_number --- Identifier for the adsorptive data to retrieve
0 : the current sample file
1 through 8 : the corresponding overlay sample file

Usage:

csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()
csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data(0)

csa --- cross sectional area (nm^2)
hsd --- hard sphere diameter (angstroms)
dcf --- density conversion factor (dimensionless)
mol_weight --- molecular weight
analysis_gas --- mnemonic for the analysis gas species

(e.g., 'CO', 'H2')

GET SAMPLE INFORMATION ITEM
mic.sample_information( item, sample_number = 0 )

Keyword arguments:

item --- string identifying the item to be returned.
Accepted identifiers are

'sample mass'
'sample description'
'analysis temperature' (degrees Kelvin)
'sample density' ( g/cm^3 )

sample_number --- Sample to retrieve (default = 0).
0 : the current sample file
1 through 8 : the corresponding overlay sample file

Usage:

mass = sample_information('sample mass')
mass = sample_information('sample mass',0)

GET IMPORTED PORE DATA
mic.imported_pore_data( import_number = 1 )

Keyword arguments:

import_number --- the import number (1 through 8)

Usage:

Get Sample Information Item
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xdat, ydat, desc = mic.imported_pore_data(1)

xdat --- array of pore dimension boundaries (angstroms);
empty-array if unavailable.

ydat --- array of incremental pore volumes (cm^3/g);
empty-array if unavailable.

desc --- Name of data set; empty-string if unavailable.

GET METAL COMPOSITION FOR CHEMICAL ADSORPTION
mic metal_composition( metal='' , metal_property='' , sample_number = 0 ) :

Get information about the active metals in this sample

Keyword arguments:

metal --- the metal to return information about
if '' or None, then return a list of the
active metals

metal_property --- the specific property to return information on
if '' or None, then return all the properties
for the specified metal (requires metal to be
specified)

sample_number --- Identifier for the metal data to retrieve
0 : current sample file (default)
1 through 8 : corresponding overlay sample file

Usage:

metal_list = mic.metal_composition()
copper_prop = mic.metal_composition( 'copper')
copper_perc = mic.metal_composition( 'copper',

'percent of sample mass' )

In the above first usage case, the list of active metals is returned.
In the above second usage case, a python dictionary type
is returned which includes all the properties of the metal
available and their corresponding values. The last case returns
a single value (int, float, or string) for the specified property.

The metal_property keywords which one can use are

atomic weight
oxygen atoms
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density
percent of sample mass
metal atoms
cross sectional area
percent reduced
stoichiometry H2
stoichiometry O2
stoichiometry He

Or as just mentioned, one can make the call
metal_composition( metalname ) without any metal_property
keyword provided to see the whole dictionary.

Get Metal Composition for Chemical Adsorption
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B ATOMIC WEIGHTS AND CROSS SECTIONAL AREAS

Metal Symbol Atomic Weight
(g/mole)

Cross-sectional
Area (sq nm)

Density (g/ml)

chromium Cr 51.996 0.0635 7.19

cobalt Co 58.933 0.0662 8.9

copper Cu 63.54 0.0680 8.96

gold Au 196.967 0.08696 18.9

hafnium Hf 178.490 0.0862 13.3

iridium Ir 192.220 0.0769 22.4

iron Fe 55.847 0.0613 7.89

manganese Mn 54.938 0.0714 7.43

molybdnum Mo 95.940 0.0730 10.22

nickel Ni 58.710 0.0649 8.9

niobium Nb 92.906 0.0806 8.57

osmium Os 190.220 0.0629 22.6

palladium Pd 106.400 0.0787 12.02

platinum Pt 195.090 0.0800 21.45

rhenium Re 186.2 0.0649 21.02

rhodium Rh 102.905 0.0752 12.1

tuthenium Ru 101.070 0.0613 12.4

silver Ag 107.868 0.0869 10.5

tantalum Ta 180.947 0.0800 16.6

thorium Th 232.038 0.1350 11.7

tin Sn 118.710 0.1082 4.54

tungsten W 183.850 0.0741 19.3

vanadium V 50.942 0.0680 6.11

zirconium Zr 91.220 0.0877 6.51

Atomic Weights and Cross-sectional Areas for Selected Metals

B AtomicWeights and Cross Sectional Areas
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C AUXILIARY INPUTS AND OUTPUTS

File > New Sample [or Open] > Analysis Conditions tab

Analog and digital signals can be connected to the analyzer. Two industry standardD shell
connectors are available on the analyzer. A shielded cable with male pinsmust be used for any
auxiliary signal connected to the analyzer. The analog connector uses a 15 pin body; the digital
connector uses a 25 pin body. The cable shield must connect to ametal shellD connector housing.

Analog inputs are enabled bymarking one or both check boxes on the Insert Experimentwindow.

Click Insert then selectExperiment. After an auxiliary input is enabled, it remains enabled for the
duration of the experiment. Because an analysis can be comprised of many experiments, an input
can be disabled or enabled at various points in the analysis, as determined by the selection on the
New Experimentwindows.

Digital inputs are controlled by inserting aWait step in the analysis. On theWaitwindow, selectWait
for digital input number. Specify 1 or 2 to indicate the input signal. Enter a number of minutes to wait;
if the signal is not received before that amount of time elapses, the analysis continueswithout the
input.

C Auxiliary Inputs andOutputs
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C Auxiliary Inputs andOutputs

Analog and digital outputs are enabled bymarking the applicable check box(es) on theOutputs
window. TheOutputswindow is available when setting the initial conditions for an experiment (by
clicking theOutputs button on theNew Experimentwindow), or at many other points in the analysis
(by inserting aSet Outputs step in the experiment). The state of the auxiliary outputs can be changed
frequently throughout the analysis.

The state of the auxiliary inputs and outputs is displayed on the analyzer schematic. Auxiliary signals
can be incorporated in reports (overlaid over other data in graphs), in theResults view of the
Analysiswindow (during analysis) and in the Peak Editor.
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In theAuxiliary Status Display on the analyzer schematic, a zero or a one is displayed to show the
state of each digital output (DO), relay output (RO), and digital input (DI). SeeDigital on the next
page.

The voltage is displayed for each analog input (AUX 1 and AUX 2).

ANALOG
The 15 pin analog connector provides two output signals and two input signals.

OUTPUT SIGNALS:

l The TCD signal (could be as high as 12 volts—positive or negative).
l The sample temperature signal, which is a buffered voltage from the sample thermocouple. The
voltage ranges from –0.365 V at –40 °C, 0 at 0 °C, to 10.88 V at 1110 °C. The signal follows the
type-K thermocouple nonlinear characteristic.

The signals are available at these pins:

TCD (+) 7

TCD (–) 5

Temp (+) 8

Temp (–) 6

Output signals:
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INPUT SIGNALS:

The inputs are available for connection to other detectors, such as amass spectrometer. The voltage
range is –15 to 15 volts. The analyzer application can record these signals at the same time as it
records TCD and sample thermocouple data.

The signals connect to these pins:

Auxiliary input 1 (+) 4

Auxiliary input 1 (–) 3

Auxiliary input 2 (+) 2

Auxiliary input 2 (–) 1

All other pins in the 15 pin connector are floating (not connected). Connect themetal shell of the
connector to the chassis ground and cable shield tomaintain shielding of the signals.

DIGITAL
The 25 pin digital connector provides floating signals to control andmonitor external hardware—
such as auxiliary detectors or chart recorders.

The outputs consist of four sets of latching relay contacts and four opto-coupled photo transistors.
The inputs are two optically isolated photo couplers.

The analyzer application sets these as logic 1 or logic 0— as defined by the analysis step. They are
displayed on the analyzer schematic.

A logic 1 causes the relay to connect the common contact to the normally open contact. The relay will
retain this condition even when power to the analyzer is disconnected. A logic 0 causes the relay to
connect the common contact to the normally closed contact.

A logic 1 to the opto-coupled outputs causes the NPN photo transistor to be turned on. A logic 0
turns the NPN photo transistor off.

The two opto-coupled inputs are read by the analyzer as logic 1 (when current flows through the
opto-coupler photo diodes) or logic 0 (when no current is flowing).

C - 4 MicroActive AutoChemHP 2950Operator Manual
295-42830-01 (Rev -) — Jan 2018



ELECTRICAL SPECIFICATIONS

Relays Maximum voltage = 250 VAC, 48 VDC

Maximum switching current = 4A at 250 VAC; 3A at 30 VDC

Maximum switching current = 100mA at 100 VDC
Opto-coupled outputs Maximum voltage: VCE = 70 VDC

Maximum reverse voltage, VCE = 7 VDC

Maximum current = 10mA
Opto-coupled inputs Maximum reverse voltage = 3 v

Nominal forward voltage 1.3 v at 10mA

Minimum current required to be recognized by the analyzer = 1 mA

Pin Type Function
1 Relay 1 normally closed

2 Relay 1 common

3 Relay 1 normally open

4 Relay 2 normally closed

5 Relay 2 common

6 Relay 2 normally open

7 Relay 3 normally closed

8 Relay 3 common

9 Relay 3 normally open

10 Relay 4 normally closed

11 Relay 4 common

12 Relay 4 normally open

13 Not Used Not used

14 Opto output 1 collector

15 Opto output 1 emitter

16 Opto output 2 collector

Digital Connector Pin Designations

Input signals:
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Pin Type Function
17 Opto output 2 emitter

18 Opto output 3 collector

19 Opto output 3 emitter

20 Opto output 4 collector

21 Opto output 4 emitter

22 Opto input 1 anode (+)

23 Opto input 1 Cathode (-)

24 Opto input 2 anode (+)

25 Opto input 2 cathode (-)

Digital Connector Pin Designations (continued)

C - 6 MicroActive AutoChemHP 2950Operator Manual
295-42830-01 (Rev -) — Jan 2018



D EXPORTED DATA EXAMPLE

D Exported Data Example
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D Exported Data Example
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D Exported Data Example
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E GAS CHARTS

RELATIVE THERMAL CONDUCTIVITY OF GASES

Name Chemical Formula Conductivity (Relative to Air)
Air 1.00

Ammonia NH3 0.92

Argon Ar 0.68

Butane C4H10 0.60

Carbon Dioxide CO2 0.62

Carbon Monoxide CO 0.97

Ethane C2H6 0.79

Helium He 5.84

Hydrogen H2 7.07

Krypton Kr 0.37

Methane CH4 1.29

Neon Ne 1.87

Nitric Oxide NO 0.99

Nitrogen N2 1.00

Nitrogen Dioxide NO2 or N2O4 1.51

Nitrous Oxide N2O 0.65

Oxygen O2 1.02

Sulfur Dioxide SO2 0.38

Water Vapor H2O 0.67

E GasCharts

MicroActive AutoChemHP 2950Operator Manual
295-42830-01 (Rev -) — Jan 2018 E - 1



E GasCharts

TYPICAL GASES USED

Flow Rate of 50 cm3/min

Test Preparation
Gas

Carrier
Gas

Loop
Gas

Other

TPR Experiment Argon 10%H2 in
Argon

N/A

Calibration N/A Argon TCD Level Calibration

TPD Ammonia
Helium or
15%NH3 in
Helium Helium

N/A

Calibration N/A NH3 in Helium TCD Level Calibration

TPD Hydrogen 10% H2 in
Argon

Argon
N/A Calibration

Calibration N/A 10% H2 in
Argon TCD Level Calibration

TPD Oxygen 10%O2 in
Helium

Helium
N/A

Calibration N/A 10%O2 in
Helium TCD Level Calibration

TPO Experiment Helium 10%O2 in
Helium

N/A

Calibration N/A Helium TCD Level Calibration

H2 Pulse Chem-
ical Adsorption 10%H2 in

Argon

Argon 10% H2 in
Argon

CO Pulse Chem-
ical Adsorption Helium 10%CO in

Helium

Calibration Not Required

BET Surface Area Helium
30% N2 in
Helium N/A

Calibration N/A
User-definedmanual injec-
tions of N2 (0.5, 1.0, 1.5, and
2.0 cm3)
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GAS CONVERSION CONSTANTS
TheChemiSorb analyzer uses aMass Flow Controller (MFC) to control the flow of gases. TheMFC
requires a conversion constant for each gas or gasmixture to compensate for variations in gas flows
resulting from variations in the properties of gases. A default gas table containingMFC conversion
constants is included on theOptionsmenu. The following table provides amore complete list of
gases and their conversion constants.

Gas Symbol MFC Conversion Constant
(H2 = 1.000)

Acetylene C2H2 0.6535

Air (mixture) 0.9901

Allene C3H4 0.4752

Ammonia NH3 0.7822

Argon Ar 1.3861

Arsine A5H3 0.7525

Boron Trichloride BCl3 0.4356

Boron Trifluoride BF3 0.5743

Bromine Pentafluoride BrF5 0.2871

Bromine Trifluoride BrF3 0.4356

Butane C4H10 0.2871

Butene C4H8 0.3267

Carbon Dioxide CO2 0.7723

Carbon Monoxide CO 0.9802

Carbon Tetracloride CCl4 0.3465

Carbon Tetrafluoride CF4 0.4752

Carbonyl Fluoride COF2 0.2673

Carbonyl Sulfide COS 0.6733

Chlorine Cl2 0.8218

Chloroform CHCl3 0.4356

Chlorine Trifluoride ClF3 0.4257

Cyanogen C2N2 0.4950

Gas Conversion Constants for the MFC

GasConversion Constants
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E GasCharts

Gas Symbol MFC Conversion Constant
(H2 = 1.000)

Cyclopropane C3H6 0.5050

Deuterium D2 0.9901

Diborane B2H6 0.5446

Dichlorosilane SiH2Cl2 0.4356

Dimethylamine (CH3)2NH 0.6634

Dimethylether (CH3)2O 0.5842

Ethane C2H6 0.5446

Ethyl Chloride C2H5Cl 0.2871

Ethylene C2H4 0.6139

Ethylene Oxide C2H4O 0.5842

Fluorine F2 0.9208

Fluroform CHF3 0.5644

Freon 11 CCl3F 0.3762

Freon 12 CCl3F2 0.3861

Freon 13 CClF3 0.4257

Freon 13 B1 CBrF3 0.4059

Freon 14 CF4 0.4703

Freon 21 CHCl2F 0.4554

Freon 22 CHClF2 0.5050

Freon 23 CHF3 0.5644

Freon 113 CCl2F-CClF2 0.2277

Freon 114 CCl2F4-CClF2 0.2554

Freon 115 CClF2-CF3 0.2713

Freon 116 CF3-CF3 0.2277

Germane GeH4 0.6436

Gas Conversion Constants for the MFC (continued)
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Gas Symbol MFC Conversion Constant
(H2 = 1.000)

Helium He 1.3762

Hexamethyldisizane HMDS 0.1386

Hydrogen H2 1.0000

Hydrogen Bromide HBr 0.9703

Hydrogen Chloride (Dry) HCl 0.9802

Hydrogen Fluoride HF 0.9901

Hydrogen Iodide HI 0.9505

Hydrogen Selenide H2Se 0.8317

Hydrogen Sulfide H2S 0.8416

Isobutane C4H10 0.3069

Isobutylene C4H8 0.3366

Krypton Kr 1.3762

Methane CH4 0.8020

Methylamine CH3NH2 0.5644

Methyl Bromide CH3Br 0.6436

Methyl Chloride CH3Cl 0.6832

Methyl Fluoride CH3F 0.7525

Methyl Mercaptan CH4S 0.5842

Neon Ne 1.3861

Nitric Oxide NO 0.9901

Nitrogen N2 0.9950

Nitrogen Dioxide NO2 0.7525

Nitrogen Trioxide N2O3 0.4356

Nitrogen Trifluoride NF3 0.5446

Nitrous Oxide N2O 0.7426

Gas Conversion Constants for the MFC (continued)

GasConversion Constants
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E GasCharts

Gas Symbol MFC Conversion Constant
(H2 = 1.000)

Oxygen O2 0.9802

Ozone O3 0.7327

Pentaborane B5Hg 0.2871

n Pentane C5H12 0.2376

Perchloryl Fluoride ClO3F 0.4455

Phosgene COCl2 0.5050

Phosphine PH3 0.7822

Phosphorous Pentafluoride PF5 0.3465

Propane C3H8 0.3861

Propylene (Propene) C3H6 0.4653

Silane SiH4 0.6733

Silicon Tetrachloride SiCl4 0.3168

Silicon Tetrafluoride SiF4 0.3960

Sulfur Dioxide SO2 0.7228

Sulfur Hexafluoride SF6 0.2970

Trichlorosilane Cl3HSi 0.3267

Trimethylamine (CH3)3N 0.3168

Tungsten Hexafluoride WF6 0.2871

Uranium Hexafluoride UF6 0.2178

Vinyl Bromide C2H3Br 0.5248

Vinyl Chloride C2H3Cl 0.5347

Vinyl Fluoride C2H3F 0.5743

Xenon Xe 1.3762

Gas Conversion Constants for the MFC (continued)
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F PEAK DETECTION / INTEGRATION OPTIONS

This section applies only to dynamic analysis samples.

File Open > [.RPO file] > [Integration button]
Peak detection parameters can be customized using the Integration button on theReport Options
window or the Integration button on the Peak Editor window. Peak detection options can be
customized while creating the sample file or after analysis.

The TCD detects and records all deviations from baseline, but only those which satisfy the criteria
established in this window are reported as peaks.

Peak detection is accomplished through a combination of noise, height, and area
thresholds.

F PeakDetection / Integration Options
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F PeakDetection / Integration Options

Field or But-
ton Description

Standard
Settings
[group box]

l Baseline mode
The BaselineMode affects how the Find All Peaks function works.

If Best Fit Baseline is selected, the bottom of the peaks is placed in the
baseline that best describes the signal outside the range of the peaks. This
assumes a linear baseline between the beginning and the end of the peak.

If Snap to Signal is selected, the bottom of the peaks ismoved to the signal
recorded, not the best fit baseline between the peaks.

l Minimum peak height
Sets theminimumheight for peaks to be identified and included in the peak
table. This value is expressed in terms of the trace’s Y-axis units. Use a
value of 0 (zero) to include all peaks.

l Peak smoothing
Smoothing allows the application to average the points before using them,
so that noise spikes are ignored. Specify the number of points to average
into a single value during the peak picking process.

The smoothing parameter can be turned off by setting the value at 1 or 0
(zero). A setting of 1 disables smoothing, and the peak edges are
interpolated to the best X-axis value. A setting of 0 also disables smoothing,
but the peak edges (the points where the peak begins and ends) are not
interpolated. Instead, the nearest data point is used as the peak edge.

Advanced
Settings
[group box]

l Sensitivity
Sensitivity sets the noise rejection level for identifying the peaks in a trace.
Use a value from
-100 to 100%. For example, a sensitivity level of 5%means that 5% of all
local maxima in the trace are greater than the noise and are, therefore to be
considered as peaks. A value of 100% identifies all local maxima (or minima
for traceswith transmission Y units) as peaks. One possible exception to
note is the combination of other rejection parameters (such asMinimum
PeakArea andMinimumPeakHeight) which can reject peaks even when
the sensitivity is set to 100%.

The sensitivity can also be set to negative values to define a specific noise
level (in Y units) for peak rejection. For example, a sensitivity setting of -
2.5% sets the noise rejection to 2.5 V. Thismeans that maximawith an

Peak Detection/Integration Options Fields and Buttons Table
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Field or But-
ton Description

amplitude of 2.5 V or less will be considered as baseline noise instead of as
peaks. (As opposed to theMinimumPeakHeight rejection parameter which
eliminates refined peaks by using their height above the baseline.)

A setting of 0 (zero) automatically sets a default noise level for the trace.

l Maximum shoulder ratio
There can also be shoulder peaks (also called combination peaks) within a
group. SeeMaximum group separation on the next page for a
description of peak groups. Shoulders are usually small peaks that are
overlapped on the front or the tail of a larger peak. These peaks can also be
called leaders and followers, respectively. Aswith baseline groups, the
areas of these peaks can be calculated incorrectly. If the larger parent peak
has a long tail with amuch smaller peak riding on it, most of the area under
the trace belongs to the parent peak. However, if the area of these peaks
was determined using baseline grouping, the smaller peakwould be
calculated by using vertical drop lines at the edges. This would give the
parent peak too little area, and the rider peak toomuch.

The application can detect these shoulder peaks. The areas of shoulder
peaks are calculated by drawing a skimmed baseline from the leading edge
to the trailing edge. Either an exponential or a straight skim line can be used.
The skim type is specified by a secondarymethod parameter (seeMethods
on page 2 - 23) and the default is exponential skimming. The remaining
area between the shoulder peak baseline and the group baseline is
considered to be part of the parent peak.

TheMaxShoulder Ratio parameter is used to specify whether the peaks
that are overlapped in the front or the tail of much larger peaks should be
identified as shoulder peaks. To use shoulder peak detection, use a non-
zero value for theMaxShoulder Ratio parameter. After a baseline group
has been identified, the application looks for peakswithin the group that
satisfy the following shoulder peak criteria:

Shouldersmust have a significantly higher Y value at one edge than the
other. More importantly, the height of the shoulder above the common value
must bemuch smaller than the height of the “parent” (larger) peak above the
same valley. It must be smaller by theMaxShoulder Ratio setting. For
example, a setting of 33 implies that shouldersmust be smaller than 33% of
their parents in terms of height above the common valley. The areas for
shoulder peaks are calculated by drawing a skimmed baseline from the left

Peak Detection/Integration Options Fields and Buttons Table (continued)

F PeakDetection / Integration Options
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F PeakDetection / Integration Options

Field or But-
ton Description

edge to the right edge of the peak. The remaining area between the
shoulder peak baseline and the group common baseline is considered to be
part of the parent peak.

Shoulder peaks can only be calculated within a group of peaks. See
Maximum group separation below for a description of peak groups. If the
MaxGroup Separation parameter is set to 0 (no groups), aMaxShoulder
Ratio parameter value is not used. Use a value of zero to specify no
shoulder peak detection.

A value of 33%workswell with most data. Use a setting of zero to treat
shoulder peakswith a perpendicular drop to the common group baseline
instead of a skimmed baseline.

If the application detects unwanted baseline noise peaks, try increasing the
Sensitivity setting. Conversely, if some peaks are not detected, decrease the
value.

l Maximum group separation
The application normally calculates peak areas by drawing a valley-to-valley
baseline from the leading edge to the trailing edge of every identified peak.
However, in many traces, the valleys between peaks do not always drop
back to the original baseline. If a valley-to-valley baseline is used for this type
of peak, the calculated area does not accurately reflect the true area under
the peak.

The application provides a parameter that allows the calculation of Baseline
Groups. A group of peaks is defined by a common baseline that extends
from the leading edge of the first peak in the group to the trailing edge of the
last. The areas of grouped peaks are calculated by dropping vertical lines
from the peak edges down to the group baseline.

Theremay also beReport Groups defined by themethod and
assigned group letters fromA through Z. Unlike theseBaseline
Groups, theReport Groups need not be next to one another.
The two types of groups are not related.

TheMaxGroup Separation parameter is used to determine which peaks in a
trace have a common baseline. When using peak grouping, the application
compares the width (actually double the largest half width) of every identified

Peak Detection/Integration Options Fields and Buttons Table (continued)
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Field or But-
ton Description

peak in a trace to the width of the following peak. TheMaxGroup Separation
parameter specifies a percentage of the smallest of these two widths in X
units. If the edges of two adjacent peaks differ by less than this value, the
two peaks constitute a group and are given a common baseline. For
example, if two adjacent peaks in the trace have largest half widths of 1 and
1.5 respectively, and theMaxGroup Separation parameter is set at 20%,
then a difference of less than 0.4 X units between the adjacent edges of
these peakswouldmake them a group with a common baseline. If the same
two peaks have adjacent edges that are greater than 0.4 X units apart, they
do not define a group, and each peak has its own separate baseline.

The areas for grouped peaks are calculated by drawing imaginary vertical
lines from the peak edges to the common baseline. Any peaks that share
common edges are automatically considered a group and are given a
common baseline for anyMaxGroup Separation setting greater than 0. To
specify no peak grouping (each identified peak has its own baseline), use a
setting of 0. A value of 33% for this parameter workswell with most data.
Use a setting of zero to force all baselines to be drawn from peak valley to
valley.

l Minimum peak area
This parameter sets theminimumarea required for refined, processed
peaks to be recognized, identified, and included in the peak table. Any peak
with a calculated peak area smaller than the current setting is not detected.
Values for this parameter are expressed in terms of the trace X-axis units
multiplied by the Y-axis units (e.g., millivolt-minutes).

Setting theSensitivity parameter to large values (greater than 20%) can
cause noise spikes (or dips) on the sides of major peaks to be identified as
peaks themselves. If the areas of the peaks are smaller than theMinimum
PeakArea parameter, major peaks in the tracemay not be identified at all.
Exercise caution when using high Sensitivity settingswith theMinimum
PeakArea parameter.

If peaks are not detected by the application, lower the setting with a smaller
value. This parameter must be adjusted in conjunction with thePeak
Sensitivity and/orMinimumPeakHeight parameters above. Peak rejection
is accomplished through a combination of peak height and peak area
rejection parameters. If the application is not detecting the peak(s) of
interest, decrease both parameters.

Peak Detection/Integration Options Fields and Buttons Table (continued)
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F PeakDetection / Integration Options

Field or But-
ton Description

l Maximum Baseline Slope
Themaximumbaseline slope indicates how the application determines the
start and end of the baseline. The algorithm scans the trace and looks for the
first time when the slope of the trace is larger than themaximumbaseline
slope. Then it scans from the end of the trace backward and looks for the
first time the slope is larger than themaximumbaseline slope. It records
these two points as the start and end of the baseline.

Basically, theMaximumBaseline Slope value is used to decide how flat the
trace would need to be to set the baseline of the current peak.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Peak Detection/Integration Options Fields and Buttons Table (continued)
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G TEMPERATURE PROGRAMMED ANALYSES
Most temperature-programmed experiments are based on the following highly simplified steps:

1. Gas flows into the analyzer.
2. The gas interacts with the sample as the temperature changes.
3. Gas flows past the detector.
4. The detector collects data.
5. The application plots and calculates results.

How the Detector Works

The detector contains heated filaments that measure the difference in gas thermal conductivity
sensed between the gases flowing over the sample and reference filaments.

The gases flowing past the detector cool the filament by extracting heat. How quickly any type of gas
removes heat from the detector is determined by its thermal conductivity1 ) . A gaswith a high
thermal conductivity cools the filament rapidly, andmore power is required tomaintain its
temperature. A gaswith a lower thermal conductivity removes heat from the filament more slowly.

When the sample reacts with the gas, it causes changes in the composition of the gas and,
consequently, changes the thermal conductivity of the gas. These changes are sensed by the
detector as an increase or decrease in the amount of power required tomaintain the filament at a
constant temperature.

1 ) The thermal conductivity of a gas is its ability to conduct heat. Each gas has a distinct thermal
conductivity.

G Temperature Programmed Analyses
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GTemperature Programmed Analyses

Data that are Collected

The detector reports the amount of electricity (in volts) required to keep its temperature constant
during the analysis.

The Role of the Sample Temperature

Because the sample’s temperature determines how rapidly it interacts with the analysis gas (or if it
reacts at all), data are collected over the range of temperatures specified.

In some experiments, youmay prefer to start collecting data at a very low temperature to establish a
baseline where the gas is completely unaffected by the sample. In other cases, youmay prefer to
collect data after a reaction has begun. In still other experiments, your primary interest may be
determining the temperature at which themaximum reaction occurs.

For example, consider the example of a Temperature-ProgrammedReduction (TPR). During the
TPR, ametal oxide is reacted with hydrogen to form a puremetal. This reaction is referred to as
“reducing” themetal; for example, TPR of a catalyst containing Platinum. Argon, which has a very
low thermal conductivity, is used as a carrier gas. It is blended in a fixed proportion with hydrogen, an
analysis gaswith amuch higher thermal conductivity. Then the gasmixture flows through the
analyzer, through the sample, and past the detector.

When the gas blend begins flowing over the sample, a baseline reading is established by the
detector. This baseline is established at a low enough temperature that no reduction of the sample is
occurring, so the baseline level recorded by the detector is that of the thermal conductivity of the two
gases in their fixed proportion. In other words, the proportion of gases flowing over the detector is the
same as the proportion of gases entering the analyzer, because at the low temperature, there is no
interaction with the sample.
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The temperature is then changed, and when a critical temperature is reached, hydrogen atoms in
the gas flow react with the sample, forming H2Omolecules. The H2Omolecules are removed from
the gas stream using a cold trap. As a result, the amount of hydrogen in the argon / hydrogen gas
blend inside the analyzer decreases, and the proportion between the two gases shifts in the direction
of argon, as does themixture’s thermal conductivity.

Since argon has a lower thermal conductivity than hydrogen, themixture’s thermal conductivity
consequently decreases. The flowing gas removes heat from the filament more slowly, requiring less
electricity to maintain a constant filament temperature. The analyzer records the electrical demand
as it changes (this is called the detector signal). The detector signal is recorded continuously over a
range of temperatures.When these readings are graphed, the data form one or more peaks. Peaks
can be positive or negative; negative peaks are show in this example.

GTemperature Programmed Analyses
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GTemperature Programmed Analyses

Item Description
1 Baseline readings. The gas(es) is (are) not reacting with the sample, so there is no

change in the signal from reading to reading.
2 As the temperature changes, the sample begins to react with one of the gases. Therefore

the gasmix is thenmade up of a larger proportion of the other gas. This causes a shift in
themixture’s thermal conductivity. The detector measures this change by recording the
change in the amount of electricity required tomaintain constant filament temperature.

3 As temperature continues to increase, the interaction reaches amaximum, then begins to
diminish.

4 As fewer and fewer sample atoms are available to bond with the analysis gas, there is
less and less change in themix of gases flowing into the analyzer and past the detector,
so the thermal conductivity shifts back toward the baseline value.

Negative Peaks Legend

This example illustrates the fundamental concept upon which the analyzer operates. Of course, the
various types of analyses the analyzer can perform result in different types of traces. For example, a
pulse chemical adsorption analysis results in a series of peaks that gradually increases in size as the
sample is dosed with separate increments of gas. Initially, the gas uptake by the sample results in
smaller peaks. But when all the active sites are saturated, nomore gas can be taken up and the
peaks become equal.

PEAK AREA
The area beneath each peak is calculated to provide information about the volume of gas reacted
during the analysis. Log in to your customer portal to access the Calculations document.

AUTOMATIC OPERATION

The analyzer application provides a simple format to specify all the analysis conditions for the
experiment; create a sample file which contains sample information and a list of specific steps the
analyzer will follow to perform the experiment(s). Then, the analyzer automatically performs the
analysis, from controlling the gasmixture and flow rate tomonitoring the temperature and pressure.
After analysis, use the Peak Editor to adjust the peaks to create reports that contain the data
needed, without baseline noise or other undesirable effects.

Because up to 99 experiments can be specified and each experiment can contain up to 99 steps, the
analyzer can perform awide variety of preparation and analysis functions automatically.
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COLD TRAP
In some cases, it is preferred to trap substances resulting from the reaction. In the previous example,
H2O is produced during the analysis. If the gas flow is passed through the cold trap at an appropriate
temperature, the water can be removed before the gas flows past the detector.

INJECTION LOOP
Injection loops are provided for injecting carefullymeasured doses of gases for analyses such as
Pulse Chemical Adsorption. The analyzer is shipped with a 0.5 cm3 loop installed. A 1ml loop is also
available. If the sample file is set so that a loop is used for introducing gas into the analyzer, the
analyzer will automatically dose the sample as specified in the sample file.

SAMPLE PREPARATION AND CALIBRATION
Depending on the type of experiment(s) to be performed, sample preparation and/or calibrationmay
be required. Specific instructions are contained in the appropriate sections of thismanual.

A sample is prepared for analysis by removing unwanted adsorbates from the surface of the sample.
This is usually accomplished by flowing gas over the sample andmay include heating the sample.
The flowing gasmay be inert or chemically active gasesmay be used to activate the surface.

Calibration routines provide the analyzer and application with the appropriate information to convert
electrical signals to physicallymeaningful data such as volume adsorbed, loop volume, and gas
concentration.

Cold Trap
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H WORKSHEETS

Worksheets in this sectionmay be copied as needed.

See also:

l Gas Connections on the next page
l Gas Flow Constant Calibration Worksheet on page H - 3
l Manual Injections on page H - 5
l Sample Data Worksheet on page H - 6

HWorksheets
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HWorksheets

GAS CONNECTIONS
Use this form to record the connected gases. Use this form as a checklist against the gases identified
in the analyzer application.

Unit number (S/N):

Date:

Operator:

Preparation Gas Carrier Gas Loop Gas
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GAS FLOW CONSTANT CALIBRATION WORKSHEET

Follow the instructions for calibrating the analyzer’sMass Flow Controllers for a given gas. Use
worksheet to recordmeasured values and perform calculations included in this process.

SINGLE GASES

MFC being used (optional)

__________ Preparation

__________ Carrier

__________ Analysis (Loop)

Gas: __________________________________________________________________________

1. MFC flow rate (as set on instrument schematic): __________________________________
2. Measured flow rate (using an external flow meter): _________________________________
3. Convert the flow rate to Standard Temperature and Pressure (STP) using the following for-

mula:

Measured rate at STP: _________________________

4. Enter the value from line 3 in theActual flow field of the Gas Flow Constant Calibration win-
dow (Unit [n] > Gas Flow Calibration).

5. The new Mass flow constant displays. Enter theMass flow constant value: __________
6. ClickAccept.
7. Enter the new Conversion Constant for this gas (from line 5) into the Adsorptive Properties

(.ADP) file.

Gas Flow Constant CalibrationWorksheet
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GAS MIXTURES

A conversion constant for amixture of gases can be determined using the conversion constants for
each gas in themixture. Use the following formula to calculate the conversion constant for the gas
mixture:

where

M = mixture conversion constant
P = percentage of gas n in themixture, expressed as a whole number (example: for

15%, use 15, not .15)
F = conversion constant (factor) for gas n

Gas Name (n) Conversion Constant (F)
1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.

13.

14.

15.

Mixture name: _______________________ Constant (M): _______________________
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MANUAL INJECTIONS
Use this worksheet to list the planned injection volumes, then check indicate if completed.

Injection
Volume Comments Completed

1. o

2. o

3. o

4. o

5. o

6 o

7. o

8. o

9. o

10. o

11. o

12. o

13. o

14. o

15. o

16. o

17. o

18. o

19. o

20. o

Manual Injections
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SAMPLE DATA WORKSHEET

Sample Tube Identification:_________________________________

Sample Data (g)
Record all values in grams

Before Analysis After Analysis

A. Mass for empty sample tube
set:
B. Sample tube set plus sample
mass:
C. Sample mass (B - A):

Notes:
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